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Chapter 1: Introduction

This chapter provides an overview of the HP Universal CMDB (UCMDB) - HP Service Manager
(SM) integration (also referred to as the Universal CMDB (UCMDB) integration or UCMDB-SM
integration throughout this document).

This chapter includes:

e "Who Should Read this Guide" below
e "Purpose of the Integration" below

e "How Cl information is Synchronized Between UCMDB and Service Manager" on page 15

Who Should Read this Guide

This guide is intended for a system implementer or system administrator who will be establishing
and maintaining a connection between the UCMDB and Service Manager systems. This guide
assumes that you have administrative access to both systems. The procedures in this guide may

duplicate information available in your UCMDB and Service Manager help systems, but is provided
here for convenience.

Note: This document replaces the following documents that have been published before this
release:

e HP Universal CMDB Integration Guide (for Service Manager 9.30, dated July 2011)

e UCMDB-SM Integration Standards and Best Practices Guide (dated 31 May 2010)

Purpose of the Integration

An integration between HP Universal CMDB (UCMDB) and HP Service Manager enables you to
share information about the actual state of a configuration item (Cl) between your UCMDB system
and a Service Manager system. Cls commonly include IT services, hardware and software. Any
organization that wants to implement the best practices Configuration Management and Change

Management ITIL processes can use this integration to verify that Cls actually have the attribute
values the organization has agreed to support.

You can use this integration to automate the creation of Service Manager change or incident
records to update or rollback Cls that have unexpected attribute values. Service Manager allows
you to programmatically define what actions you want to take whenever a Cl’s actual state does
not match the expected state as defined in the Cl record.

The integration offers several different ways for users to view Cl actual state information:
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o By default, the integration automatically updates the managed fields of Service Manager Cl
records as part of the regular UCMDB synchronization schedule. You can choose the option to
configure the integration to automatically create change or incident records instead.

e A Service Manager user can view the current actual state of a Cl by looking at the Actual State
section in the Cl record. When you open the Actual State section, Service Manager makes a
web services request to UCMDB and displays all Cl attributes the request returns. Service
Manager only makes the web service call when you open this section.

e A Service Manager user can use the View in UCMDB option to log in to the UCMDB system
and view the current Cl attributes from UCMDB. The Service Manager user must have a valid
UCMDB user name and password to log in to the UCMDB system.

Supported Use Cases

This section describes use cases that are supported by the UCMDB-SM integration. The supported
use cases provide the core business processes that are enabled by the UCMDB-SM integration.

There are four main business use cases supported by the UCMDB-SM integration. They are as
follows:

¢ Planned Change: A change created in SM through the formal SM change process.

e Unplanned Change: A change or incident that occurred in SM and does not conform to the formal
SM change process.

o Retrieving SM Ticket Information: The ability to view SM ticket information in UCMDB.
e Actual State: The ability to view the UCMDB CI information in SM.

All of the use cases provide important functionalities that enable the user to perform ITIL (IT
Infrastructure Library) processes. The ITIL processes refer to a set of best practices that define and
outline how organizations should manage their IT.

Enabling ITIL Processes

By activating Cl push from UCMDB to SM the user facilitates ITIL processes such as Incident,
Problem and Change Management in SM.

SM utilizes the data pushed from UCMDB in the following modules:

¢ Incident Management: the Service Desk operator (SD Agent) selects the “Service” and the
“Affected CI” for the specific Incident record.

¢ Problem Management: the SD agent selects the “Service” and the “Primary CI” for the specific
Problem record.

¢ Change Management: the SD agent selects the “Service” and the “Affected Cl(s)” for the
specific Change record.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 12 of 248



In each of the previously mentioned ITIL processes, SM utilizes Cl information for Service,
Affected Cls and Primary Cls that all originate in UCMDB.

Managing Planned Changes

The purpose of the “Planned Change” use case is to provide IT organizations a formal process by
which changes to the IT infrastructure are introduced after thorough review and analysis. This is
performed according to the “Change Management” process defined in ITIL v3.

A “Planned Change” is initiated by the SM user via the formal “Change Management” process
module in SM. This is followed by the actual change implementation.

The actual changes are discovered by a discovery tool such as HP DDMA, and then updated in
UCMDB and the relevant modifications are pushed to SM. Once the user has validated the change,
the user closes the relevant planned change in SM.

Managing Unplanned Changes

The purpose of the “Unplanned Change” use case is to provide IT organizations a formal process by
which all changes that occur to the IT infrastructure are both logged and conventionalized through
the organizations formal approval process.

An “Unplanned Change” is a change that is recognized by a Discovery tool such as DDMA. The
change is first updated and visible in UCMDB and then the data is pushed to SM. SM recognizes
the change and as aresult an “Incident” or “Change” record is generated.

These Changes are seen also in the SM “Pending Changes” section in the Configuration Item form,
once approved they are moved to the SM “Historic Changes” section.

Retrieving Service Manager Ticket Information

Retrieving SM ticket information from within UCMDB provides all HP Software applications users
with access to this information by using UCMDB's federation capabilities and supporting APIs.
These applications include Business Service Management (BSM), Asset Manager (AM),
Operations Orchestration (OO), etc.

SM ticket data is accessed from within UCMDB using UCMDB federation capabilities. SM ticket
dataincludes Incident, Problem and Change records as well as a key set of their attributes.

UCMDB enables users to create reports/views that combine the federated ticket data from SM with
Cl information from UCMDB.

Retrieving Actual State of UCMDB Cls

The purpose of “Actual State” is to enable SM users insight into Cls’ current state as detected by
“Discovery Tools” and populated in UCMDB. This state provides up-to-date information that may
vary from the information displayed in SM both in content and in scope.

The “Actual State” of the Cl is displayed in SM in order to enable the user to validate the current
state of the ClI that resides in UCMDB or in another data repository.
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SM users retrieve the Actual State of Cls from UCMDB or additional data sources by viewing the
Cl's Actual State section in the SM Configuration Item form.

Accessing UCMDB CIs from Service Manager

SM users can open the UCMDB User Interface in the context of a specific Cl, by clicking the View
in UCMDB button in the SM CI record. When the user clicks the View in UCMDB button, a
UCMDB login screen displays; After the user enters a UCMDB username and password, UCMDB
displays a topological view of the specific Cl together with all related Cls that are linked to it.

Tip: You can configure Lightweight Single Sign-On (LW-SSO) for the integration, so that
Service Manager web client users can bypass the UCMDB login screen after clicking the View
in UCMDB button. For more information, see "How to Enable Lightweight Single Sign-On
(LW-SSO) Configuration" on page 88.

If the UCMDB Browser URL is specified in the SM System Information Record, this button is
replaced by the View in UCMDB Browser button. When you click the View in UCMDB Browser
button, a UCMDB Browser login screen displays; After you entera UCMDB Browser username
and password, the Cl is displayed in the UCMDB Browser Ul.

Core Features

This section explains the rudimentary concepts behind the Federation, Push, and Population
features as they pertain to the integration.

This section includes:

e "Push" below
e "Federation" on the next page

o " Population" on the next page

Push

UCMDB can automatically discover most types of Cls available in Service Manager. This
integration enables you to push these types of Cls from UCMDB to Service Manager.

The following figure shows how data is pushed from UCMDB to Service Manager (SM). The data is
physically pushed (copied) from UCMDB to SM. Once the data is physically located in SM, the
data is utilized by the SM user that consumes this information in various SM processes.

UCMDB
@ Push> __ Node
CPUAﬂrl
(_CPU ) ( Disk ) ( Disk Attributes )
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Note: Cl Type and Attribute Push
Only information that is physically present in UCMDB can be pushed to SM.

Federation

With the federation feature, UCMDB pulls various ticket information (for example, Incident,
Problem, and Change ticket information) from SM. This enables users to see Ticket information in
UCMDB as Ticket Cls that are connected to the relevant Nodes.

When data is federated (reflected or mirrored) from SM to UCMDB, the data is not physically
present in UCMDB, instead it is passed over to UCMDB via Web Services.

Population

You can also use this integration to populate those types of Cls that UCMDB cannot automatically
discover or Cls that have been created in Service Manager before you have a UCMDB system
deployed. For more information, see "When do | Need the Population Feature" on page 91.

Population is the reverse of Push. The following figure shows how data is populated from SM to
UCMDB. One SM CI record with multiple attributes is transferred to UCMDB as multiple Cl

records.
UCMDB SM
(Node)
Population
(cpu ) ( Disk ) Disk Attributes

How Cl information is Synchronized Between
UCMDB and Service Manager

This section explains how CI information is transferred between the UCMDB and Service Manager
systems.

This section includes:

e "Cl Information Usage" on the next page
e "High-Level Components of the Integration" on the next page

¢ "Relationships Between Integration Components" on page 17
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e "What Information is Stored in UCMDB" on the next page

e "What Information is Stored in Service Manager" on page 18

Cl Information Usage

When referring to the concept of Cl information it is important to make the distinction between a
UCMDB CI and a Service Manager (SM) Cl. The UCMDB model represents a topology that
contains a number of Cl types and relationships.

The UCMDB topology can be represented in Service Manager as a single entity. Multiple Cls from
UCMDB and their attributes are merged into a single record in SM and the relevant UCMDB

attributes are mapped to their appropriate counterparts in the SM record.
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The above figure shows the correlation between the UCMDB topological model and its
representation of the Computer Instance together with its parallel representation in SM. The SM
computer Cl contains all of the UCMDB information that is passed through the integration.

In the push flow, in the UCMDB topological view several Cls such as Node, IP, Interface, Location,
File System, CPU, Disk Device and their Relationships are converted into a single SM computer
record with the IP, MAC Address and Location, File System, CPU and Disk Device attributes.

In the population flow, the conversion is reversed.

High-Level Components of the Integration

The following diagram shows the high-level components of the UCMDB integration, and illustrates
the interactions between UCMDB and Service Manager.
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Relationships Between Integration Components

The following figure illustrates the relationships between the Service Manager Adapter components
in UCMDB and the associated components in Service Manager.

The Service Manager Adapter includes configuration files, which are used to map UCMDB entities

to their counterparts in Service Manager during data push, as well as map Service Manager Cls to
UCMDB entities during population.

The configuration files utilize UCMDB TQL queries that define a superset of data relevant for the

integration.
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What Information is Stored in UCMDB

Your UCMDB system stores the actual state of Cls and Cl relationships as Cl attributes. Typically,
UCMDB uses one or more integrations and discovery mechanisms (feeders) to automatically

detect Cl attribute values. The UCMDB-SM integration only uses a subset of the CI attributes
available ina UCMDB system.

For more information, see "Tailoring the Integration" on page 105.
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What Information is Stored in Service Manager

Your Service Manager system stores the managed or expected state of Cls and CI relationships as
attribute values in a Cl record. To be part of the integration, a Cl attribute in your UCMDB system
must map to a managed field in the Service Manager CI record. You can add, remove, or update the
managed fields that are part of the integration by tailoring the Service Manager web services that
manage the integration.

Service Manager runs according to a set of rules that define what actions you want the system to
take whenever a Cl’s actual state does not match the expected state as defined in the Cl record.
You define these rules from the Discovery Event Manager (DEM) in Service Manager where you

can do the following:

o Automatically update a Cl record to match the attribute values listed in the actual state. (This is
the default behavior.)

o Automatically create a change record to review the differences between the actual state and the
managed state.

o Automatically create an incident record to review the differences between the actual state and
the managed state.
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Chapter 2: Integration Setup

Before implementing the integration in your production environment, you can set up the integration
in a test environment using the out-of-the-box integration configurations. This chapter describes the
basic integration setup tasks without any tailoring or multi-tenancy configurations. It covers the
following topics:

¢ "Integration Requirements" below

o "How to Upgrade Your Integration" on the next page

¢ "Integration Setup Overview" on page 26

e "HP Service Manager Setup" on page 26

e "HP Universal CMDB Setup" on page 29

¢ "Populating UCMDB with Service Manager Cl Data" on page 33
e "Pushing UCMDB CI Data to Service Manager" on page 37

¢ "Federating SM Ticket Data to UCMDB" on page 43
Tip: Before you proceed to implementing the integration in your production environment, you
can refer to the following chapters for further information:

e "Multi-Tenancy (Multi-Company) Setup" on page 58, which describes how you set up the
integration in multi-tenancy mode.

e "Standards and Best Practices" on page 77, which describes best practices for
implementing the integration and also provides Frequently-Asked-Questions information.

e "Tailoring the Integration" on page 105, which describes how you can tailor the integration to
better suit your business needs.

e "Troubleshooting" on page 202, which provides information on troubleshooting data push
and population issues.

Integration Requirements

The supported product versions of this integration are listed in the following table.
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Supported product versions

Service Manager UCMDB

9.30 + UCMDB Integration Content Pack 10.01 CP122, 10.10 CP13
9.30.0

9.31,9.32,9.33 10.01 CP12,10.10 CP13

You must set up the following required components to establish an integration between UCMDB
and Service Manager.

e HP Universal CMDB installation
Add a UCMDB Probe for the population feature if you do not already have one.

e HP Service Manager installation
Add the UCMDB URL to the System Information Record. See "How to Add the UCMDB
Connection Information" on page 27.

e Network connection between the HP Universal CMDB and HP Service Manager systems.

For instructions on installing and configuring your systems, see the UCMDB and Service Manager
documentation.

How to Upgrade Your Integration

The UCMDB Integration Enhancement Content Pack 9.30.0 for Service Manager 9.30 is already
included in the Service Manager 9.32 or 9.33 applications, except for several code changes, which
are not included in order for backward compatibility. This means, to take advantage of the
integration enhancement introduced since SM 9.32, extra steps are required to upgrade your
existing SM-UCMDB integration after you upgrade to Service Manager applications 9.32 or later for
the first time. This section describes these upgrade tasks.

Note: If you have already applied the UCMDB Integration Enhancement Content Pack 9.30.0
for Service Manager 9.30, the integration has been upgraded and you need to do nothing. If you
do not want to upgrade your existing integration, you need to do nothing and your integration
can continue to work as before.

This task includes the following steps:

1The UCMDB Integration Content Pack 9.30.0 is available from the HP Live Network at:
https://hpln.hp.com. For instructions on installing the content package, see the Service Manager
9.30 Applications Patch Manager Guide for Content Patches shipped with the content pack
release.

2C| data replication (push) from UCMDB to Service Manager is supported for certain versions of
UCMDB earlier than 9.x with less content and limited error handling; however Cl data population is
supported only for UCMDB 9.05 or later. For this reason, this document does not cover information
about integrating Service Manager with earlier versions of UCMDB. For such information, see the
HP Universal CMDB to HP Service Manager Integration Guide for Service Manager version 9.20,
which is available from http://h20230.www2.hp.com/selfsolve/manuals.
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¢ "Modify the definitions of certain Cl types in Service Manager." below

e "Copy data to the joinnode table" on page 24

o "Align the SM CI relationship data model with the UCMDB data model." on page 24
e "Update the cirelationship dbdict." on page 26

1. Modify the definitions of certain Cl types in Service Manager.

The SM-UCMDB integration enhancement uses the joinnode table for data mappings of the
following Cl types: mainframe, networkcomponents, storage, and computer. The new data
mappings require certain changes be made to these Cl types in Service Manager Service
Manager 9.33; Universal CMDB 10.01 or later, as described in the following tables.

Note: For backward compatibility, the definitions of all out-of-box CI types in Service
Manager Service Manager 9.33; Universal CMDB 10.01 or later are identical to those in
Service Manager 9.30.

Changes required for Mainframe CI types

Removed
Field Old Value New Value Subtypes
Format Name configurationltem configurationltemNode LPAR
Attr File mainframe node
Join Def joinmainframe joinnode
Bulk Update device.mainframe.bulkupdate = device.node.bulkupdate

Format Name
Added subtypes for Mainframe are:

= Logical Partition

= CPC
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Changes required for Network Components CI types

Removed
Field Old Value New Value Subtypes
Format configurationltem configurationltemNode LB
Name
Attr File networkcomponents node
Join Def joinnetworkcomponents joinnode
Bulk device.networkcomponents.bulkupdate = device.node.bulkupdate
Update
Format
Name

Added subtypes for Network Components are:

= |LoadBalancer

Bandwidth Manager

= CSU/DSU

= Ethernet

= FDDI

= KVM Switch

= Multicast Enabled Router
= Token Ring

= Voice Gateway

= Voice Switch

= VPN Gateway

= Wireless Access Point
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Changes required for Storage CI types

Field

Format Name
Attr File

Join Def

Bulk Update
Format Name

Old Value
configurationltem
storage
joinstorage

device.storage.bulkupdate

Added subtypes for Storage are:

SAN Gateway

SAN Router

SAN Switch

Storage Array

Changes required for Computer Cl types

Field

Format Name
Attr File

Join Def

Bulk Update
Format Name

Old Value
configurationltem
computer
joincomputer

device.computer.bulkupdate

Added subtypes for Computer is:

= Virtualized System

To use the integration enhancement, you must modify the following device type definitions in

Removed
New Value Subtypes
configurationltemNode = N/A
node
joinnode
device.node.bulkupdate

Removed
New Value Subtypes
configurationltemNode = N/A
node
joinnode

device.node.bulkupdate

Service Manager: computer, networkcomponents, mainframe, and storage:

a.

system administrator.

Search.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later)
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Navigate to Configuration Management > Resources > Device Types, and then click
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c. Select one of the Cl types (computer, networkcomponents, mainframe, and storage), and
update its definition as described in the above tables.

d. Repeat the steps above for the rest of the four Cl types.

2. Copy data to the joinnode table

This task in optional. It is required only if you want to use the joinnode-based data mappings. If
you want to use the original tables instead of joinnode (see the above tables), this task is not
needed; instead, you need to modify the data mappings of the Service Manager 9.xx adapter
in UCMDB.

To copy your data from relevant tables to the joinnode table:

a. Loginto Service Manager Service Manager 9.33; Universal CMDB 10.01 or later as a
system administrator.

b. InDatabase Manager, in the Table field type cidatacopy, and then click Search. The
Copy CI Type Data form opens.

c. Click Search. A list of records displays: joincomputer, joinmainframe,
joinnetworkcomponents, and joinstorage.

d. Select each record from the list, update or add source/target fields as needed, and click the
Copy Data button. One of the following messages occurs:
i. A message like “<XXX> records were successfully copied, and <YYY> records were
ignored within xxx ms”, where XXX and YYY represent the numbers of records copied
and ignored.

ii. An error message: “Configuration validation failed, and no records were copied.
Please check your Source Fields/Target Fields settings and run Copy Data again.”

e. If the error message occurs, correct your Source Fields/Target Fields settings, and click
Copy Data again until all of your records have been successfully processed.

3. Align the SM CI relationship data model with the UCMDB data model.

To use the integration enhancement, you need to manually update several records in Service
Manager to align the SM CI relationship data model (relationship types and subtypes) with that
of UCMDB, in order for easy data mapping between the two products.

a. Loginto Service Manager as a system administrator.
b. In Script Library, open the EnableUcmdblntegrationUl script.

c. Click Execute. Running this script will automatically rename each record in the table below
to <record_name>.bak.932, and replace them with new records with the original record
names.
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Records replaced and renamed
Record Type Record Name

Format CM.relationship
CM.relationship.gbe
CM.relationship.type
CM.relationship.type.gbe
dataModEventRel.relationship.detail
dataModEventRel.relationship.gbe
am.downstream.relationships.vj
am.upstream.relationships.vj

Extaccess Relationship
Format Control CM.relationship

CM.relationship.type

dataModEvent.relationship
d. Verify that the Cl relationship form looks like the following:

Configuration ltem Relationship

Upstream CI: * =i i,

Relationship Name: +

Relationship Type: * - D"

Downstream Cls: * I:Iu D\
Sl
g%
g%

Qutage Dependency

|:| Outage Dependency
This Configuration tem will be conzidered down if
or more of the supporting configuration tems are down
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If you tailored any of these records in the above table, open the <record_name>.bak.932 record
to identify the differences, and merge your customizations in the new record.

Update the cirelationship dbdict.

The data length of CI relationship name in Service Manager is 40 characters, which is not
sufficient for the integration. If a Cl relationship name exceeds this data length, either the
relationship name is truncated after push or the relationship cannot be pushed to Service
Manager due to a duplicate key error. You need to manually increase the data length in Service
Manager:

a. Open the cirelationship table in Database Dictionary.

b. Increase the data length of the relationship.name field from 40 to an appropriate value
(recommended value: 300).

c. Save the record.

Integration Setup Overview

The integration requires setup on both the UCMDB and Service Manager systems.

This task includes the following steps:

1.

Set up the Service Manager system.
See "HP Service Manager Setup" below.

Set up the UCMDB system.
See "HP Universal CMDB Setup" on page 29.

Run the UCMDB population jobs to synchronize Cls to UCMDB.
See "Populating UCMDB with Service Manager Cl Data" on page 33.

Run the UCMDB data push jobs to transfer Cls to Service Manager.
See "Populating UCMDB with Service Manager Cl Data" on page 33.

HP Service Manager Setup

You must complete the following tasks from your Service Manager system to support the
integration.

1.

Create a dedicated integration user account in Service Manager.
See "How to Create an Integration User Account" on the next page.

Add the UCMDB connection information to the system information record.
See "How to Add the UCMDB Connection Information” on the next page.
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How to Create an Integration User Account

This integration requires an administrator user account for UCMDB to connect to Service Manager.
This user account must already exist in both UCMDB and Service Manager.

To create a dedicated integration user account in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Type contacts inthe Service Manager command line, and press ENTER.

3. Create a new contact record for the integration user account.
a. Inthe Full Name field, type a full name. For example, UCMDB905x.

b. Inthe Contact Name field, type a name. For example, UCMDB905x.
c. Click Add, and then OK.

4. Type operator inthe Service Manager command line, and press ENTER.

5. Inthe Login Name field, type the username of an existing system administrator account, and
click Search.

The system administrator account displays.

6. Create a new user account based on the existing one.
a. Change the Login Name to the integration account name you want (for example, ucmdb).

b. Type aFull Name. For example, UCMDB.

c. Inthe Contact ID field, click the Fill button and select the contact record you have just
created.

d. Click Add.
e. Select the Security tab, and change the password.
f. Click OK.

The integration user account is created. Later you will need to add this user account
(username/password) in UCMDB, and then specify this user account in the Credentials 1D field
when creating an integration point in UCMDB. See "How to Create an Integration Point in UCMDB"
on page 29.

How to Add the UCMDB Connection Information

The integration requires the UCMDB connection information to obtain Cl attribute information from
the UCMDB system, and display it in the Actual State section in the Service Manager configuration
item form.

Caution: If you do not specify the correct connection information, an error, instead of UCMDB
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Cl information, will display in the Actual State section.

Note: The integration with UCMDB Browser is supported only for Service Manager 9.31 or
later.

This task includes the following steps:
1. Loginto Service Manager as a system administrator.

2. Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.

3. Click the Active Integrations tab.

4. Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.

5. Inthe UCMDB webservice URL field, type the URL to the HP Universal CMDB web service
API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

6. InUserld and Password, type the user credentials required to manage Cls on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

7. Optionally, if you want to enable an integration to the UCMDB Browser, in the UCMDB
Browser URL field, type your UCMDB Browser URL in the following format:
http://<UCMDB browser server name>:<port>/ucmdb-browser

For example: http://myucmdbbrowserserver:8081/ucmdb-browser

The UCMDB Browser has two themes. By default, it uses the dark color theme; if you want to
use the light color theme, use this format for the UCMDB Browser URL:

http://<UCMDB browser server name>:<port>/ucmdb-browser/?theme=LIGHT

Note: If you specify the UCMDB Browser URL here, the View in UCMDB Browser
button will replace the View in UCMDB button in Cl records synchronized from UCMDB;
only when you leave this field empty, the View in UCMDB button will appear.

8. Click Save. Service Manager displays the message: Information record updated.
9. Log out of the Service Manager system.

10. Log back into the Service Manager system with an administrator account.
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The Actual State section and the View in UCMDB Browser or View in UCMDB button will be
available in Cl records pushed from UCMDB.

HP Universal CMDB Setup

You must complete the following tasks from your UCMDB system to support the integration.

1. Create an integration point between UCMDB and Service Manager.
See "How to Create an Integration Point in UCMDB" below.

2. Update the configuration files of the adapter.
See "How to Update the Time Zone and Date Format for the Integration Adapter" on page 32.

How to Create an Integration Point in UCMDB

A default UCMDB installation already includes the ServiceManagerAdapter9-x package. To use the
integration package, you must create an integration point listing the connection properties for the
integration.

Caution: For data population, this integration supports the use of only one probe for your
Service Manager system. In other words, you should not run population jobs on different
probes by setting up multiple integration points with different probes for your Service Manager
system. Only one probe is allowed for one Service Manager system.

To create an integration point:
1. Loginto UCMDB as an administrator.

2. Add the integration user account that you created in Service Manager.
a. Click Administration > Users and Roles.

b. Click the Add New User button |I|.

c. ForUser Name and Password, type the user name and password you created in Service
Manager. See "How to Create an Integration User Account" on page 27.

d. Click Next, and then in the Role List select Admin.
e. Click Finish. The integration user account is added.

3. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

4. Click the New Integration Point button |Z|.
UCMDB displays a New Integration Point properties window.
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5. Complete the integration and adapter property fields as described in the following table.
Integration and adapter properties (UCMDB 10.01 or later)

Is
Field name required? Description

Integration Yes Type the name (unique key) of the integration point. For
Name example, Population_CI_From_S.

Integration No Type a description of current integration point.
Description

Adapter Yes For UCMDB 9.05:

Select HP BTO Products or HP Software Products >
Service Manager > Service Manager 9.xx.

For UCMDB 10:

Select HP Software Products > Service Manager > Service
Manager 9.xx.

Note: This adapter, which supports Cl/relationship Data
Push from UCMDB to Service Manager, and Population
and Federation from Service Manager to UCMDB, is
available out-of-the-box only in UCMDB version 9.05 or

later.
Is Integration = Yes Enable this option to indicate the integration point is active.
Activated
Hostname/IP ' Yes Type the hostname or IP address of the Service Manager
server.
For example, 1ocalhost.
Port Yes Type the communications port of the Service Manager server.

For example, 13080,
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Integration and adapter properties (UCMDB 10.01 or later), continued

Is
Field name required? Description

URL No This field value (if any) supersedes the Hostname/IP and Port
Override settings described above.

Use this field If you want UCMDB to connect to Service
Manager in any combinations of the following ways:

= Connect to Service Manager over HTTPS or over both HTTP
and HTTPS

= Connect to multiple Service Manager server nodes
(vertically scaled environment)

= Connect to one single Service Manager server node through
multiple ports (horizontally scaled environment)

For more information, see "Push in Clustered Environments" on
page 80.

Type one or more Service Manager web services URLs
(separated by a semicolon) in this field.

The following are two example values of this field (each URL
should use this format: http
(s)://<hostname>:<port>/sc62server/ws):

s https://localhost:13443/sc62server/ws

s http://localhost:13080/sc62server/ws;
https://localhost:13443/sc62server/ws;
http://smfpe@4:13080/sc62server/ws

Credentials Yes Click Generic Protocol, click the Add button to add the

ID integration user account you created, and then select it. This
account must exist in both Service Manager and UCMDB. See
"How to Create an Integration User Account” on page 27.

Data Flow Yes Select the name of the Data Flow Probe used to run population
Probe jobs. You should have already added the data flow probe for the

integration after installing UCMDB. See "Integration
Requirements" on page 19,

6. Click Test Connection to make sure that a successful connection is created.

7. Click OK.
The integration point is created and its details are displayed.
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8. Click the Federation tab, and complete the following configuration.
a. In Supported and Selected Cl Types, select the following Cl types as needed from
Managed Object > ItProcessRecord:
i. Incident

ii. Problem

iii. Request for Change

Supported and Selected Cl Types
B A

= [@]
= [@

R8] ncidert
] Problem
| 2| [RequestFor Change

b. Foreach Cl type you selected (Incident, Problem, or Request for Change), in Cl Type
Retrieval Mode select Retrieve Cls of selected Cl Type.

9. Click the Population and Data Push tabs, to view the default integration job details.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. If needed, you can create a new job for the integration point. For
information about creating integration jobs, see "How to Define Data Push Jobs in
UCMDB" on page 37 and "How to Define Population Jobs in UCMDB" on page 34.

10. Click the Save Integration Point button ||.

How to Update the Time Zone and Date Format for the
Integration Adapter

The integration uses an integration user account to connect UCMDB to Service Manager. You
specified this user account in the Credentials ID setting when creating an integration point. See
"How to Create an Integration Point in UCMDB" on page 29. You must make sure that this
integration user account uses the same time zone and date format in both Service Manager and
UCMDB. To do so, you define the same time zone and date format in the integration adapter
configuration file and in the integration user’s operator record in Service Manager.

To update the time zone and date format for the integration adapter:

1. Check or change the time zone and date format of the integration user in Service Manager.
a. Loginto Service Manager as a system administrator.

b. Navigate to System Administration > Ongoing Maintenance > Operators. The
Operators form opens.
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c. ForLogin Name, type the integration user name (for example, ucmdb) you set in the
integration point (the Credentials ID field).

d. Click Search. Service Manager displays the record of the operator.
e. Click the Login Profiles tab.

f. View or change the operator's Time Zone and Data Format field values.

Operator Record

& General | & Security | < Login Profiles | & Startup | & Motification | & Security Groups | & Self Service |

Login Profile owledge Groups
Language: English -

|US,|"Moun13in | = |
fmm/ddjyy Rd
Display Currency |u5 Dallar | - |Q |
Message Level: |Information | b |

Max Attachment Size: | |

Total Attachment Size:
Licensing Information Assignment Groups

Mamed User
Mamed Applications:

2. Set the time zone and date format for the adapter in UCMDB.
a. Loginto UCMDB as an administrator.

b. Navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > serviceDeskConfiguration.xml.

c. Atthe bottom of the file, locate the elements “<date_pattern>" and “<time_zone>", and
update the values according to the integration user’s time zone/date format setting in
Service Manager.

The date pattern and time zone are in java format pattern used by
java.text.SimpleDateFormat. Out-of-the-box, the date format and time zone values in
serviceDeskConfiguration.xml are: MM/dd/yy HH:mm:ss, and US/Mountain.

Populating UCMDB with Service Manager Cl Data

In addition to pushing CI data from UCMDB to Service Manager, this integration also supports the
population of Cl data (including Cls and CI relationships) from Service Manager to UCMDB. The
integration can then update the list of Cls in UCMDB if new Cls or new attribute values are found in
Service Manager. The population of data from Service Manager to UCMDB is defined in the
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Integration Studio in UCMDB. You can manually run the population jobs, however HP recommends
that you schedule these jobs to keep your Cls and Cl attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship population jobs in UCMDB.
See "How to Define Population Jobs in UCMDB" below.

2. View the transferred CI/Cl Relationship data in UCMDB.
See "View Service Manager Cl Datain UCMDB" on page 36.

3. Schedule CI population jobs to keep Cls and Cl attributes up to date.
See "How to Schedule CI Population Jobs" on page 36.

How to Define Population Jobs in UCMDB

A CI/ClI relationship population job copies certain types of Cls/Cl relationships from Service
Manager to UCMDB.

To define a Cl or Cl relationship population job:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

3. Open an integration point.

4. Click the Population tab, and add a new job as follows.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. The following table lists the default population jobs and their Topology
Query Language (TQL) queries. If needed, you can create, update or remove TQL queries
for each job. For information about tailoring population TQL queries, see "Create a TQL
Query to Populate the Cl Type" on page 174.
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TQL queries for Cl / Cl relationship population
Integration Job  TQL queries for Cl / Cl relationship population

SM Configuration = Out-of-the-box, the following TQL queries are available for this job,
Item Population which populates Cl records from Service Manager to UCMDB:

job
= SM Business Service Population: Populates Cls of the bizservice
type.

= SM RunningSoftware Population: Populates Cls of the
RunningSoftware type.

= SM Computer Population: Populates Cls of the computer type.

SM Relations Out-of-the-box, the following TQL queries are defined for this job, which
Population job populates Cl Relationship records from Service Manager to UCMDB:

= SM Biz To Biz With Containment: Populates Cl relationships in
which a bizservice Cl contains another.

= SM Biz To Biz With Usage: Populates Cl relationships in which a
bizservice Cl uses another.

= SM Biz To Computer With Containment: Populates Cl
relationships in which a bizservice Cl contains a computer CI.

= SM Biz To Computer With Usage: Populates ClI relationships in
which a bizservice Cl uses a computer CI.

= SM Computer To Computer With Connects: Populates ClI

relationships in which a computer Cl connects to another.

a. Click the New Integration Job button

b. Type a Name for the integration job. For example, ClI_Population_Job1.

c. Click the Add Query button * toadd existing TQL queries to the job (see the above
table).

d. Select the Allow Integration Job to delete removed data check box for the query.
e. Click OK to save the job.
5. Runthe job manually to see if the integration job works properly.

=

a. To populate all relevant data for the job, click the button.

b. To populate only Cl data changes since the job last ran, click the > button.
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8.

Wait for the job to complete, and click the Refresh button multiple times as needed until the job
is completed.

Note: When the job is completed, the job status becomes one of the following:
Succeeded, Passed with failures, or Failed.

Click the Statistics tab to view the results, and if the job failed, click the Query Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Population Issues" on
page 227.

Click OK.

If the job is completed successfully, you can view the transferred Cl datain UCMDB and schedule
the job so that it can run automatically.

View Service Manager Cl Data in UCMDB

After a population job is successfully completed, you can search for the Service Manager CI
records in UCMDB, and verify that their attributes are correctly populated.

The Service Manager CI Identifierfield is populated to the Name field on the Configuration Item
Properties pane in UCMDB.

Note: To see the entire attribute mappings of a Cl type, you can open the Cl type’s population
XSLT file (for example, business_service_population.xslt) and the root population xslt file
(cmdb_root_attributes_population.xslt), where the UCMDB attribute field names and the
mapped Service Manager web service field caption names are defined. For more information,
see "Tailoring the Integration" on page 105

How to Schedule Cl Population Jobs

You can schedule Cl population jobs to match the discovery/maintenance schedule of your Service
Manager feeders. For example, if your Service Manager feeders send Cl data updates on a daily
schedule, then the population jobs should also run on a daily schedule. By using a matching
schedule you can ensure that your UCMDB system always has the most current Cl data.

This task includes the following steps:

1.

2.

Log into UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.

Open an integration point.
Click the Population tab, and select a population job from the list.

Click the Edit Integration Job button.
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6. Select the Scheduler enabled option.

7. Select the scheduling options you want to use. For example, select Repeat every: Day and
Ends: Never.

8. Select a Time Zone.

9. Click OK.

Pushing UCMDB (I Data to Service Manager

The integration requires a one-time transfer of Cls from UCMDB to Service Manager to populate the
Service Manager system with Cls. The integration will then update the list of Cls in Service
Manager when UCMDB discovers new Cls or new attribute values. The integration accomplishes
the push of Cl data using data push jobs in the UCMDB system. HP recommends that you
schedule these jobs to keep your Cls and Cl attributes up to date.

This task includes the following steps:

1. Define CI/Cl Relationship data push jobs.
See "How to Define Data Push Jobs in UCMDB" below.

2. View the CI/CI Relationship data pushed from UCMDB.
See "How to View UCMDB CI Datain Service Manager" on page 40.

3. Schedule data push jobs to keep CI/CI Relationship data up to date.
See "How to Schedule Data Push Jobs" on page 41.

How to Define Data Push Jobs in UCMDB

Data push jobs copy Cl or Cl Relationship records from your UCMDB system to your Service
Manager system.

To define a Cl or Cl relationship push job:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

3. Select the Integration Point you created for Service Manager. For example, SM Integration.
4. Click the Data Push tab.

5. Add a new data push job as follows.

a. Click the New Integration Job button

Note: UCMDB creates a default data push job when creating an integration point. The
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following table lists the default data push job and its Topology Query Language (TQL)
queries. If needed, you can create, update or remove TQL queries for the push job. To
access these out-of-the-box TQL queries for push, go to Modeling > Modeling Studio >
Resources, select Queries for Resource Type, and then navigate to Root > Integration
> SM Sync > 9.xx. For information about tailoring data push TQL queries, see "How to
Create a TQL Query to Synchronize the Cl Type" on page 145.

TQL queries for Cl / Cl relationship push

Integration
job TQL queries

Integration =~ TQL queries
job
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TQL queries for Cl / Cl relationship push , continued

Integration
job TQL queries

SM Push Out-of-the-box, the following TQL queries are available for this job, which
job pushes CI/CI Relationship records from UCMDB to Service Manager:

= SM Mainframe Push: pushes Cls of the mainframe type.

= SM Network Component Push: pushes Cls of the network component
type.

= SM Running Software Push: pushes Cls of the running software type.
= SM Business Service Push: pushes Cls of the business service type.
= SM Computer Push: pushes Cls of the computer type.

= SM Storage Push: pushes Cls of the storage type.

= SM Switch Push: pushes Cls of the switch type.

= SM Net Printer Push: pushes Cls of the net printer type.

= SM Cluster Push: pushes Cls of the cluster type.

= SM Mobile Device Push: pushes Cls of the mobile device type.

= SM Local Printer Push: pushes Cls of the local printer type.

Out-of-the-box, the following TQL queries are available for this job, which
pushes Cl Relationship records from UCMDB to Service Manager:

= SM Layer2 Topology Relations Push: pushes compound Cl
relationships between nodes.

= SM Business Service Relations Push: pushes Cl relationships whose
upstream ClI type is business service.

= SM CRG Relations Push: pushes ClI relationships whose upstream ClI
type is cluster.

= SM Node Relations Push: pushes direct Cl relationships whose
upstream ClI type is node.
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b. InName, type a unique name for the job. For example, Cl_Push_Job1.

c. Click the Add Query button * toadd existing TQL queries to the job.

d. Select the Allow Integration Job to delete removed data option for each query.
e. Click OK to save the job.

6. Run the job manually to see if the integration job works properly.

Caution: If you have a huge amount of Cl data in your UCMDB system, and this is your
first time to push CI /Cl Relationship data to Service Manager, it is recommended to
select the “Add the record” option instead of “Open a change” or “Open an incident” for
“Action if matching record does not exist” in each Discovery Event Manager Rules
definition. Otherwise unnecessary performance problems might occur. For details, see
"Add Discovery Event Manager Rules" on page 125.

-
a. Topush all relevant data for the job, click the 2 button.

b. To push only changes in the data since the job last ran, click the = button.
Tip: You can stop a running push job by pressing the Stops the selected job button .

7. Wait for the job to complete, and click the Refresh button multiple times as needed until the job
is completed.

Note: When the job is completed, the job status becomes one of the following depending
on the results: Succeeded, Passed with failures, or Failed.

8. Click the Statistics tab to view the results; if any errors occur click the Query Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Data Push Issues" on
page 202.

9. Click OK.

If the job is completed successfully, you can view the UCMDB CI data in Service Manager, and
schedule the job so that it can run automatically.

How to View UCMDB Cl Data in Service Manager

After a push job is successfully completed, you can search for and verify the pushed CI/CI
relationship data in Service Manager.

Cl records pushed from UCMDB contains a View in UCMDB or View in UCMDB Browser
button, which enables you to access UCMDBor the UCMDB Browser to view the Cl information.

Note:
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Toview UCMDB ClI data in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Navigate to Configuration Management > Search Cls.
3. Open a Cl record pushed from UCMDB.

4. If the View in UCMDB button is available, view the Cl record in UCMDB.
a. Click the View in UCMDB button. The UCMDB login screen opens.

b. Type a UCMDB username and password to log in.

The Cl record opens in UCMDB. You can view its properties.

Note: You can enable Lightweight Single Sign-On (LW-SSO) for the integration so that
Service Manager web client users can bypass the UCMDB login screen. For details, see
"How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 88.

5. Ifthe View in UCMDB Browser button is available, view the CI record in the UCMDB
Browser.
a. Click the View in UCMDB Browser button. The UCMDB Browser login screen opens.

b. Type a UCMDB Browser username and password to log in. The Cl record opens in the
UCMDB Browser. You can view its properties and other information.

6. Open the Actual State section.
Service Manager makes a web services request to UCMDB and displays all Cl attributes the
request returns.

Note: The web services request uses the UCMDB webservice URL and account (for
example, admin/admin) defined in the System Information Record in Service Manager.
See "How to Add the UCMDB Connection Information” on page 27.

How to Schedule Data Push Jobs

It is a best practice to schedule the data push jobs to match the discovery schedule of your Service
Manager feeders. For example, if your Service Manager feeders send Cl data updates on a daily
schedule, the data push jobs should also run on a daily schedule. By using a matching schedule
you can ensure that your Service Manager system always has the most current Cl data.

UCMDB allows you to schedule updates directly from a data push job. This task includes the
following steps:
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1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.

3. Select the integration point you created for the UCMDB-SM integration. For example, SM
Integration.

4. Click the Data Push tab.

5. Select apush job. For example, SM Configuration Item Push Job.

6. Click the Edit Integration Job button & .

Tip: UCMDB allows you to define two different schedules for two types of data push:
Changes Sync, and All Data Sync. For recommendations on push scheduling, see "Push
Scheduling Recommendations" on page 79.

7. Define a schedule for Changes Sync.
a. Click the Changes Sync tab.

b. Select the Scheduler enabled option.

c. Select the scheduling options you want to use.

l Scheduler Definition

Changes Sync || Al Data Sync

Scheduler enabled

Repeat: Starts: Ends:
’ once .
Interval | 1iznz 'l | 16:37 'l ® Mever (O Until
Day of Morth Repest on:
Weelkly |
Marithly Clsun CIson [Jmue Clwes  Clmu [P Sat
Wearly
Cron

Time Zone: Data Flow Probe Time Zone |V| |§| Server Time: 172012 5:04 PM

8. Click All Data Sync tab, and select the scheduling options you want to use.
9. Click OK to save the data push job.

10. Repeat step 6 to step 9 for the rest of data push jobs of the integration point.
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11. Save the integration point.

Federating SM Ticket Data to UCMDB

Federation does not physically copy SM data to UCMDB; it only retrieves SM data for displaying in
UCMDB. Out-of-the-box, the UCMDB-SM integration supports federation for the following external
Cl types in UCMDB: Incident, Problem, and RequestForChange. If you have enabled these CI
types for federation when creating your integration point, in UCMDB you can retrieve the following
types of ticket data from Service Manager: Incident, Problem, and Change.

This section includes:

¢ "Federation TQL queries" below

o "Examples of Using Federation" below

Note: You can tailor the integration to federate more SM ticket attributes to UCMDB. For
details, see "How to Add an Attribute of a Supported Cl Type for Federation" on page 196.

Federation TQL queries
Federation uses TQL queries to determine what data to retrieve from Service Manager. To retrieve
specific ticket data from Service Manager, you need to create a TQL query first. Out-of-the-box,

sample federation TQL queries are available from UCMDB: Modeling > Modeling Studio >
Resources > View > Service Desk.

Examples of Using Federation

You can use the federation feature in many different ways. The following are only examples of using
the feature.

This section includes:

e "Example 1: Federate All SM Incident Tickets" below

e "Example 2: Federate SM Incident Tickets that Affect a UCMDB Business Service CI" on page
48

e "Example 3: Federate SM Incident, Change and Problem Ticket Data of UCMDB Cls" on page
53

e "Example 4: Get Related SM Ticket Data of a UCMDB CI" on page 55

Example 1: Federate All SM Incident Tickets

This example illustrates how you retrieve information of all Incident records that exist in Service
Manager.
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1. Loginto UCMDB as an administrator.

2. Navigate to Modeling > Modeling Studio > Resources.

3. ForResource Type, select Queries from the list.

4. Click New > Query.

5. Onthe Cl Types tab, go to ItProcessRecord > Incident, and drag it to the query pane on the

right side.

-:-New'E‘: =) =

Resources || Cl selector || Cl Types

5 Query 1* x

Cl Types

150 ActiityLog (U)
(@] Asset (1)

—{®] Attachment (0)

—(®] Budget ©)

(2] BudgetLine (0)

— Business Objective (0)
#—(Z) Corfigurationttem (1189)
#-(@)] Cortract ()

—[®] cost @)

— CostCategory (0)

(@] CostCenter (0

[}@ History Change (0)
[—]— tProcessRecord (0)
Change (0)

)
Interaction (0)
KnownErrar (0)

%] Problem (0)

I

e [ €

By B (E] Tree view v | 2 £

Query Definttion

NEIEEEIE

&
W Incident

| Legend: & Cortact Node /& External Y Has Condiions % Has Idertities B Hidden in Query Results % Model Output & Subgraph

AT

[ il ‘Cardinality || Element Type || Element Layout || Data Sources

® There are no items in this view.

6. Specify Service Manager as the data source for the Incident query node.
a. Select the Incident query node, click the Data Sources tab on the lower right pane, and

then click Edit.

b. Select the Select integration points option, and then select your integration point name
(for example, sm_integration). Click OK.
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4| Select Integration Points u

:a Select Integration Points
= Select the integration poirts to use for this query.

A integration poirts
() Local data source (UCMDE only)

® |Selec1 integration poirrts|

% o b

5 autotest
Ej sm_integration
&y ucmoe

7. Click the Save button =] , and then type a query name and select a location to save the query
(for example, select the Root > Integration > SM Query folder).

Save Query

Enter the gquery name and select a folder in which to save #.

Cluery Mame | =m_incidents

K | B BE
—= ca cMDE
—= Data In
—E Service-Mow
—=3
I}]—E SM Sync
9.
—=] sms sync

—E Sync_8

Temane

| Find: |
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8. Select the Incident query node, and then click the Calculate Query Result Count button .
UCMDB returns the query result count. For example, the following figure shows that there are

131 Incident records in total in Service Manager.

5 sm incidents <

Cuery Definition

h([EllE x|

[

(2

ol p

Incident (131}
| Legend: & Contact Mode [ External & Has Conditions @ Has Identities B Hidden in Query Results ¥ Model Output & Subgraph ® |
P

[®] incident Aftributes || Cardinality | * Element Type || Element Layout || % Data Sources || Selected Identities || % Details

sm_integration

[ Edt

9. Right-click the Incident query node, and select Show Element Instances. UCMDB displays a
list of all Incident records that exist in Service Manager.
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@J CIInstances

ﬁ Cl Instances

Here you can =ee all of the Tl instances found for the selected query node in the table

Show Clinstances of: | Incident (131) i | | ﬁ | ATl

Mt Q=& -

Display Label

1M1 0001
IN1 0002
1M1 0003
IN1 0004
1M1 0005
IN1 D008
IN1 0007
IN1 0008
1M1 0009
INM 0010
IM10011
IM10012
IM10014
IM10015
IM10016
IM10017
IM10018
IM10019
IM10020

[@] 110021
[N 1

|2

Total rows: 131 Rows per page:

50w 1073 |2 [
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10. Select an Incident ticket from the list, and click the Properties button =y to view its details.
| £ Configuration Item Properties

@l Configuration Item Properties

Marne: [M10001 1D =m_integration ¥%0Aincident %041 “0Alncidert|ID %30 STRING%3DIM10001 %04 Cl Type: Incidernt
F% i ‘:*‘T_LI Export ~ | Quick filker:
ActiveProcess 4
Actual Deletion Period 40
Allow Cl Update True
| Category failure
|| ClosedTime Sat Sep 1 2007 09:13 AM C5T

f Completion Code
Consumer Tenants

f Container
Create Time Sat Sep 1 2007 04:21 AM CST
Created By sm_integration
Deletion Candidate Period 20
Description
Display Label IM10001
Enable Aging Falze
Escalated False
ExternalProcess Reference
Global Id
Impact Scope user
Incident Status closed
Incidert Type
Iz Candidate For Deletion False

Last Access Time

Example 2: Federate SM Incident Tickets that Affect a
UCMDB Business Service CI

The following example illustrates how you federate a list of Service Manager Incident records
whose Affected Service or Affected Cl field contains a UCMDB Business Service ClI.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio > Resources.
3. ForResource Type, select Queries from the list.

4. Click New > Query.
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5. Onthe Cl Type tab, go to Configurationltem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

+new - B 2 5 =

Resources || Cl selector|[Cl Types [y sm incidents %[ Query 1= x|
C| Types Query Definition
AL [ Tree View v | ¥ O ﬂk@ﬁ@:‘
[l]—o Configurationftem (33) A]
[l]—o BusineszElement (20)
O Business Service View (0) @,
BusinessActivity (0) )
|§| BusinessApplication (1) B
Business Function (0) = - &:}
["] BusinessProcess (0) =
@ BusinessTransaction (0) o EusiFessTanice
() Datacerter () =
55 service (19) a
&
55 Infrastructure Service () |Legend: Z Cortact Node ¥ External Y

6. GotoltProcessRecord > Incident, and drag it to the query pane.
4 Mew - E} L] =

Resources | | Cl selector || Cl Types 5 sm incidents || 51 Query 1*

Cl Types CQuery Definition

Bed BE | (E] Tree View ~ | » O3 ﬁh@ﬁ@

2| cost () 3]
Eer\

— CostCategory (0)
BusinessSenice

—(®| costcenter @)

[EI—'@ Histary Change (0)
ncident

EH#®] kProcessRecord (0
Change (0)

)

Interaction (0)
KnownErrar ()

Ha| Problem (0)

'@ RequestFor Change (0)

“p = p

7. Click the Create Relationship button (I .

8. Select the Incident query node, and drag the arrow from this node to the BusinessService node

to create a regular relationship between the nodes.
a. Select Regular Relationship, and click OK.

b. Select Membership, and optionally enter a relationship name (for example, Membership_
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1). Click OK.

=)

ﬁ Add Relationship
ar

Define required relationship between guery nodes

EE: E“;\| Tree View v|
2] Managed Relationship
Aggregation

(@] Membership|

I— Time BoundMembership
. Connection I

|—. Dwnershlp

Relationship Mame: | Membership_1

[

(4

Relationship Direction: Incident = v Business Service

Relationzhip Restrictions: -

s |

s

)

9. Specify UCMDB as the data source for the BusinessService query node.

a. Select the BusinessService query node.

b. Onthe lower right pane, click the Data Sources tab and then click Edit.

c. Make sure that the Local data source (UCMDB only) option is selected.
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d. Click OK.

:Ei Select Integration Points
A Select the integration points to uze for thiz query.

()2 integration poirts
(®) Local data source (UCMDE only)
() select integration points

L—f_l % Iq‘_l

) ucMoE

10. Similarly, specify your integration point as the data source for the Incident query node (for
example, sm_integration).
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F _
|£:| Select Integration Points u

=;j Select Integration Points
A= Select the integration poirts to use for this query.

A integration poirts
() Local data source (UCMDE only)

® |Select integration poirrts|

B B &

[ 5 autotest
Eﬁ sm_integration
&5 ucmos

11. Click the Calculate Query Result Count button . The number of SM Incidents and the
number of their affected UCMDB Business Service Cls display.

[ fed incident bizservice x|

Cuery Definition

tiE B x|

'i[-a

&) [pcident {2
- embership_1 (2
B )

9

. BusihessSarice

i)

Legend: & Contact Node ™ External Y Has Conditions % Has ldertities @ Hidden in Query Resutts % Model Output & Subgraph

| 1]
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12. Click the Preview button to view the query result = .

%' fed_incident_bizservice - Result Preview
Pesult preview for fed_incident_bizservice

Cl Selector [Browse views|_| [iew Resutts || Related Cls
2 ETex | fi wao
B bs1327230487 @ Top Layer
(B bs1327232399
3] o004
%) 10005
@
. 5 5
: @ @
N 10005 IM10004
= Membership Membership
a
E
45 .y i
Y@ & &
bs1327232399 hs1327230487
¥
|Legend' #] Added fii Candidate for Deletion /4 Changed ¥ External + Impacted ¥ Impacted and Trigger [ Note + Trigger ®

13. Select each SM Incident record from either the Cl Selector pane or the query pane, and click

the Properties button to view its details =y .
14. Select each UCMDB CI record from either the Cl Selector pane or the query pane, and on the
Related Cls tab click Show Related Cls.

IEE fed_incident_bizservice - Result Preview

Result preview for fed_incident_bizservice

Cl Selector [Browse ‘ﬂews]_ View Resuits || Related Cls
g - [tmasl B 7t | 14 [E] x 2| % % || o,
@y bs1327230487 -;a Top Layer
[EIJ h=1327232399 Get Pelated Cls Ls
18] 110004
5 B
] 110005 Q Q L
&
- @ Select scope: (0 view (® CMDB
: 10005 “Sriow Reeted CFs”)
Mernbership . Fitter Related Cls by Cl Type
Q onnection : 0 By B 2] Tree View -
\ [1(#] Incident 1)
4| 5 =y
'@ £l
bel327i32389 Apply Perspectives to Cl
¥ [ cortent only

| Legend: 1 Added 7t Candidate for Deletion /. Changed ? ® | -
Description:

Example 3: Federate SM Incident, Change and Problem
Ticket Data of UCMDB Cls

The following example illustrates how you retrieve information of SM Incident, Change and Problem
tickets that affect a UCMDB Business Service Cl.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio > Resources.

3. ForResource Type, select Queries from the list.
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10.

1.

Click New > Query.

On the CI Type tab, go to Configurationltem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

Go to ItProcessRecord, and drag Incident, Problem, and RequestForChange to the query
pane.

Click the Create Relationship button Ix to create regular relationships between the
BusinessService node and the other nodes as shown in the following figure.

[ fed incident bizsenvice *|| 5 Query 1% %

CGuery Definition

MEIETIEIG

Membership Membershlp 2

e
,—

El

@
- BusinessService
é Membership_1
: @)

=Y

Inziderit Froblem
RequestForChang
2

For the BusinessService node, specify UCMDB as the data source.

For the Incident, Problem, and RequestForChange nodes, specify your integration point as the
data source.

Save the query.

Optionally, edit the BusinessService node properties as needed.
a. Select the BusinessServic node, and click Edit on the lower right pane.

b. Click the Cardinality tab. The default Cardinality setting displays.
(] Query Node Properties  WREG__—"— S M-l 0 e . — S

l—gl Query Node Properties

Enables you to add attributes, cardinality, gualifiers and Cl specific conditions

Elemert name: Elemert type:
| Business Service | | Business Service Vl Show element in query results
Aftribute || Cardinality || Element T
+ % o E
( Criteria | 3 Andror

Membership (Incident, BusinessService) : 1.
( Membership_1 (RequestFor Change, Business Service) :1.*
Membership_2 (Problem, Business Service) :1.* 1

AND
AND

c. If youwish, change either or both of the AND operators to OR.
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d. This will change the filter criteria and therefore the query result.

| £| Query Node Properties

lz(,_‘é__,l Query Node Properties

Enables you to add attributes, cardinality, qualifiers and Cl specific condtions

Element name: Element type:

| Business Sarvice | ‘ BusineszService 'l Show elemert in query results
|
Aftribute || Cardinality
+ ¥ v A
(4 Criteria |

Membership (Incidert, BusinessService) :1.*
[y Membership_1 (RequestFor Change, BusinessService) @ 1..*
Membership_2 (Problem, Business Service) :1..*

12. Click the Preview button = to view the query result.

|£| bizservice_incident_problem_ric - Result Preview ﬂ
|Ej bizservice_incident_problem_rfc - Result Preview
Result preview for bizservice_incidert_problem_rfc
Cl Selectar ‘Browse Views View Results || Related Cls
- (g 2 e e
@l_) b=s1327230487 :3 Top Layer
I@J bs1327232399 s 3
) c1o001 [#] = E_] [~p— [Ep—
%] wnooos Q z D z i
N
o] 141 o0 Im10004 10001 PM10001 IM10005
%] pr10001 - Mermbarshi
_ ernbership
N hWembership Mermberehip
- X =
a ~ &@
, & hs1327232399
4 bs1327230487

13. Select each SM Incident record from either the Cl Selector pane or the query pane, and click

the Properties button =y to view its details.

14. Select each UCMDB CI record from either the Cl Selector pane or the query pane, and on the
Related Cls tab click Show Related Cls to view its related Cls in both SM and UCMDB.

Example 4: Get Related SM Ticket Data of a UCMDB ClI

The following example illustrates how you retrieve SM ticket data related to a UCMDB CI by using
the Get Related Cls functionality.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > IT Universe Manager.

3. Onthe Search Cls tab, search fora UCMDB ClI that has associated ticket(s) in Service
Manager. For example, enterbs1327232399 in the Cl Name field, click Search, and double-

click the Cl to openiit.
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Cl Selector Browse Views || Search Cls
@8- R E R R R R E L =IE Y™
Searches: | x| @ Top Layer
Simnple Advanced
ClName: |bs1327232399 |E=Y f &{b
ClType:  Managed Object; E E hs1 327232389
Mame = Cl Type E
EE@ bs1327232399 Business Service -
5 oa

4. Click the Show Get Related Cls pane button @
The Get Related Cls pane displays.

Get Relsted Cls

o0 |@| 2

Select scope: View (8 CMDE

Fiter Pelated Clz by Cl Type

&

@l Tree View -

CETTT]

5. Click the Select target Integration Points for related Cls button @I

6. Select the Select integration points option, and then select both UCMDB and your
integration point. Click OK.
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() All integration points
() Local data source (LUCMDE only)
(®) Select integration poirts

% G

(5 autotest

[ HistoryDataSource
55 sm_integration

5 ucvoe

155 ucMDBEDiscovery

7. Click Show Related Cls. The CI’s related SM tickets and UCMDB Cls display.

Related Cls
Toaman| BB ext | 1y B 0 0|0 |9 B 0 | @] O [ 4e
3 Top Layer
. = <] Get Related Cls
@ CIg)cd <
- connection 4 pyigoos Tro0os -
: C10001 O view
B Membefship Select scope: Jiew ® CMDB
hip =
B Connection
- Membership Fitter Related Cls by Cl Type
a nection 0y By G Tree View =
¥ hs1327232399 ]
1) | il I o T YT |
8. Select each SM ticket record from the query pane, and click the Properties button | =y to view
its details.
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Chapter 3: Multi-Tenancy (Multi-Company)
Setup

The UCMDB-SM Integration supports a multi-tenancy configuration in which both the Service
Manager and UCMDB systems track Configuration Items (Cls) and Configuration Item
Relationships (CIRs) by company ID. In a multi-tenancy configuration, you can tailor the integration
so that each tenant only sees and works with the Cls and CIRs that match their company ID. Multi-
tenancy is intended for managed service providers (MSPs) who wish to offer Configuration
Management as a service to multiple tenants.

This chapter includes:

e "Multi-Tenancy (Multi-Company) Support" below
¢ "Multi-Tenancy Requirements" on page 65
e "Setting up the Multi-Tenancy Integration in UCMDB" on page 65

o "Setting up the Multi-Tenancy Integration in Service Manager" on page 69

Multi-Tenancy (Multi-Company) Support

Multi-tenancy is when a single instance of software runs on a server, serving multiple client
organizations (also referred to as tenants).

Multi-tenancy contrasted with a multi-instance architecture where separate software instances or
hardware systems are set up for different client organizations.

When implementing a multi-tenant architecture, a software application is designed to virtually
partition its data and configuration so that each client organization works with a customized virtual
application instance. The following figure illustrates an example multi-tenant integration
deployment.

UCMDB SM
Customer 1 |
Data Collector '
I
——— e
s (_Tenantz )
Data Collector | Tenant 2 | |
P Torants )
|
Customer 3 | ¥ )
Data Collector
Automatic Tenant
Synchronization
Manual Tenant
Synchronization
Explanation
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Every tenant configured in UCMDB works with the relevant tenant in SM. If UCMDB did not
configure tenants, the tenant configuration must be activated in order to transfer the configuration
from SM to UCMDB automatically. This function is performed once only by the system
administrator.

In the event that UCMDB tenant configuration already exists and the SM configuration does not
exist, SM tenant must be manually configured according to the UCMDB configuration.

Implementing Multi-Tenancy in the UCMDB-SM
Integration

SM stores the company records that describe each tenant in the multi-tenant configuration. The
Service Manager system is the definitive source for company records and pushes all new company
IDs to the UCMDB system creating the equivalent entity in UCMDB.

SM tracks the company ID of each Cl and relationship in a multi-tenant configuration. Cl records
inherit the company ID of the UCMDB feeder that discovered them. Relationship records inherit the
company ID of the parent Cl in the relationship.

Mandanten SM Security Layer

Mandanten is an SM software layer that is used to filter the customer ID from the Cl information.
SM uses the Mandanten to ensure that operators only see Cl and relationship records where the
Cl's company ID matches the operator's company ID. If the view is restricted with Mandanten,
then Service Manager also restricts the view to all other related records such as change requests
and incidents.

What Multi-Tenant Information is Stored in UCMDB

Your UCMDB system stores a company ID attribute for each Cl and CIR. The company 1D
determines what adapter and synchronization schedule your UCMDB system uses to update ClI
data. Each Cl and relationship record can only have one company ID. The UCMDB system obtains
a company ID from the Service Manager system.

If more than one tenant (company) shares the same Cl, each tenant has their own unique CI record
describing the ClI. In effect, the UCMDB system creates multiple Cl records to track one managed
asset. Each tenant’s Cl record is unique to that tenant and lists the company's unique company ID.

What Multi-Tenant Information is Stored in Service
Manager

Your Service Manager stores the company records that describe each tenant in the multi-tenant
configuration. The Service Manager system is the definitive source of company IDs and pushes
new and updated information to your UCMDB system.

Service Manager tracks the company ID of each Cl and relationship in a multi-tenant configuration.
Cl records inherit the company ID of the UCMDB feeder that discovered them. Relationship
records inherit the company ID of the parent Cl in the relationship.
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In a best practices implementation, Service Manager uses Mandanten to ensure that operators only
see Cl and relationship records where the CI’'s company ID matches the operator's company ID. If
you restrict the view with Mandanten, then Service Manager also restricts the view to all other

related records such as change requests and incidents.

Unique Logical Names

Service Manager requires that all Cls have unique logical names. If the logical name generation
process produces a duplicate logical name value, Service Manager appends an underscore and a
number to the end of logical name to make it unique. For example, if two Cls would have the logical
name mytesthost, then the second CI will instead have the name mytesthost_1. A second

duplicate Cl would have the name mytesthost_2.

Synchronization of Company Records

If your system meets all the conditions for multi-tenancy support, Service Manager creates a
schedule record to push the company ID of the company record to your UCMDB system. Service
Manager uses the following rules to determine whether to push the company ID to your UCMDB
system.

Conditions where Service Manager synchronizes company ID with UCMDB

Conditions

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later)

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You create a new company record in Service
Manager

UCMDB-SM integration enabled

You update an existing company record that
has not been synchronized with UCMDB

Multi-company mode enabled in Service
Manager

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You disable the option to show a company in
multi-company lists on a company
synchronized with UCMDB

Tenant
information
synchronized?

Yes

Yes

Yes

Schedule record created
and action taken in
UCMDB

Synch Company with
UCMDB - <UCMDB
Company ID>

e Add new company ID

Synch Company with
UCMDB - <UCMDB

Company ID>

e Add new company ID

Inactivate Company with
UCMDB - <UCMDB

Company ID>

¢ Inactivate existing
company ID
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Conditions where Service Manager synchronizes company ID with UCMDB, continued

Conditions

o UCMDB-SM integration enabled

e Multi-company mode enabled in Service
Manager

¢ You select the option to resynchronize with
UCMDB on an existing company record

¢ UCMDB-SM integration enabled

e Multi-company mode enabled in Service
Manager

e You enable the option to show a company in
multi-company lists for an inactivated
company

e UCMDB-SM integration disabled

e Multi-company mode enabled in Service
Manager

¢ You update an existing company record that

has already been synchronized with UCMDB

¢ UCMDB-SM integration disabled

e Multi-company mode enabled in Service
Manager

e You create a new company record in Service
Manager

¢ UCMDB-SM integration enabled

e Multi-company mode enabled in Service
Manager

¢ You disable the option to show a company in
multi-company lists on a company not
synchronized with UCMDB
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Tenant
information
synchronized?

Yes

Yes

No

No

No

Schedule record created
and action taken in
UCMDB

Synch Company with
UCMDB - <UCMDB

Company ID>

¢ Add new company ID

Synch Company with
UCMDB - <UCMDB
Company ID>

¢ Reactivate company
ID

None

None

None
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Conditions where Service Manager synchronizes company ID with UCMDB, continued

Tenant Schedule record created
information and action taken in
Conditions synchronized? UCMDB
o UCMDB-SM integration enabled No None

e Multi-company mode disabled in Service
Manager

¢ You create a new company record in Service
Manager

UCMDB Customer ID

When you enable the multi-tenancy integration, Service Manager displays a new field in each
company record called UCMDB Customer ID. In order to synchronize a company record with
UCMDB, you must first provide a value for this field. After you provide a UCMDB Customer ID
value this field becomes read-only. You cannot change a company's UCMDB Customer ID after
you set it.

This field only accepts numeric data up to ten characters long. Service Manager requires the field
value to be a unique positive whole number. You cannot enter duplicate values or use decimals,
negative numbers, or zero.

Your UCMDB system automatically uses the UCMDB customer ID of 1 when running in single
tenant mode. You can reuse this default value in your multi-tenant implementation by assigning a
Service Manager company to have this UCMDB customer ID value. Out-of-the-box, no Service
Manager company has the UCMDB customer ID of 1.

UCMDB User ID and Password

When you enable the multi-tenancy integration, Service Manager displays two new fields in each
company record called UCMDB Userld and UCMDB Password. These fields allow you to specify
the connection information you want Service Manager to use when requesting information for the
Actual State section. Any user name and password you enter in these fields must be valid for your
UCMDB system.

The user name and password you provide in the Company Information record takes precedence
over the user name and password you provide in the System Information record. This allows
managed service providers to control access to the UCMDB system on a tenant-by-tenant basis. If
you do not provide a company-specific UCMDB user name and password, Service Manager uses
the credentials you provided in the System Information record.

Company Code

The multi-tenancy integration requires that each company record has a unique Company Code
(company field) value. Since Company Code is a required field, your existing company records
should already have Company Code values. However you should ensure that each company record
has a unique Company Code value.
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Caution: You should not change the Company Code value after you have enabled the multi-
tenancy integration because this will cause your Service Manager data to become out of
synch.

Cl Reconciliation Rules

When multi-tenancy is enabled, Service Manager only reconciles the Cls whose company ID
matches the company ID in the data push job. For example, when pushing Cls from company 2, the
reconciliation rules only apply to the Service Manager Cl records that have the company code
corresponding to company number 2.

Company Information Pushed to Cl and Cl Relationship
Records

When you enable the multi-tenancy integration, Service Manager inserts the SM Company Code
value in Cl and relationship records during data push. Service Manager uses the UCMDB
Customer ID to look up the matching SM Company Code value.

Company Information Replicated to Incident Records

When you enable the multi-tenancy integration and select the option to create incidents when
UCMDB discovers new, updated, or deleted Cls, Service Manager inserts the SM Company Code
value in the incident record during replication. Service Manager uses the UCMDB Customer ID to
look up the matching SM Company Code value.

Schedule Records

Service Manager uses the problem schedule processor to manage the synchronization of company
IDs to your UCMDB system. You can manually enable the problem schedule processor from the
System Status form.

When the synchronization criteria are met as described in Table "Conditions where Service
Manager synchronizes company 1D with UCMDB" on page 60, Service Manager creates a “Synch
Company with UCMDB - <UCMDB Company ID>" schedule record (for example, “Synch
Company with UCMDB - 1234567890”). If you inactivate a company, Service Manager creates a
“Inactivate Company with UCMDB - <UCMDB Company ID>" schedule record (for example,
“Inactivate Company with UCMDB - 1234567890”). The problem schedule processor processes the
new schedule record on the next background process iteration.

If your Service Manager system cannot connect to your UCMDB system for some reason, it will
reschedule the company synchronization at the next scheduled interval (the out-box interval is 5
minutes). The problem schedule processor updates the schedule record with the status
rescheduled. If the Service Manager system receives any other error message while connecting to
the UCMDB system, it updates the schedule record with the status “application failed due to error -
check msglog for possible messages.”
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Tenant-Specific Discovery Event Manager (DEM) Rules

You can implement the condition field function in order to create SM DEM rules that are specific to a
particular tenant in a multi-tenancy UCMDB-SM integration.

Tenant rules vary according to SM tenant configuration requirements, for each record information
type pushed from UCMDB to SM different tenants can configure different DEM tenant rules.

Each tenant can have its own set of unique requirements and therefore may implement different
processes via the integration.

One tenant may require the addition of Cls directly to SM while another tenant may require opening
changes for each Cl.

The following table shows a sample set of DEM rules that illustrate how to accomplish this.

Tenant-specific DEM rules

DEM rule ID Action on new CI Condition
ucmdbNode_advantage Add ClI company in $L.file="advantage”
ucmdbNode_hp Create change company in $L.file="HP”

Note: DEM Rules

When creating DEM rules make sure to create separate DEM rules for each tenant.

Multi-Tenancy Functional Use Cases

The following table describes the necessary actions to perform in various deployment situations to
address multi-tenancy issues.

Multi-tenancy use cases

Deployment

Integration

Type Description

uCMDB When implementing a UCMDB-SM deployment that has existing multi-tenancy
with multi- rules in UCMDB and does not have multi-tenancy rules configured in SM, the
tenancy user creates multi-tenancy rules in SM manually and according to the rules in
rules UCMDB.

SM without

multi-

tenancy

rules
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Multi-tenancy use cases, continued

Deployment

Integration

Type Description

SMwith When implementing a UCMDB-SM deployment that has existing multi-tenancy
multi- rules in configured SM and does not have multi-tenancy rules configured in
tenancy UCMDB, the user creates multi-tenancy rules in UCMDB manually as well as
rules according to the rules previously configured in SM.

UCMDB

without

multi-

tenancy

rules

UCMDB When implementing a UCMDB-SM deployment that does not have multi-tenancy
without rules configured in UCMDB orin SM, the user configures the rules in SM.

multi-

t During the configuration process using the SM multi-tenancy wizard the user can
enancy . . L )

rules create corresponding tenancy configuration in UCMDB. By creating

corresponding tenancy configurations in SM the user also creates a
SMwithout | corresponding tenant in UCMDB.
multi-
tenancy
rules

Multi-Tenancy Requirements

Your system must meet the following requirements in order for the integration to support multi-
tenancy.

e HP Universal CMDB version 8.02 or later system

HP Service Manager version 9.20 or later system

Integration enabled between UCMDB and Service Manager

Multi-company mode enabled on the Service Manager system

Problem schedule process running on the Service Manager system

For additional information about the multi-tenancy integration, you can visit the HP Software
Support Online web site or refer to the Service Manager help.

Setting up the Multi-Tenancy Integration in UCMDB

You need to perform the following tasks in UCMDB to set up the multi-tenancy integration.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 65 of 248


http://support.openview.hp.com/

1. Install a separate data flow probe for each tenant the integration will support.
See "How to Install Separate Data Flow Probes for Each Tenant" below.

2. Start tenant-specific data flow probes.
See "How to Start Tenant-Specific Data Flow Probes" on the next page.

3. Configure IP address ranges for tenant-specific data flow probes.
See "How to Configure IP Ranges for Tenant-Specific Data Flow Probes" on page 68.

4. Configure multi-tenancy for population.
See "How to Configure Multi-Tenancy for Population" on page 68.

How to Install Separate Data Flow Probes for Each
Tenant

If you plan to support a multi-tenant configuration, you must install a separate data probe for each
tenant. Out-of-the-box, the UCMDB installer only installs one data flow probe and service.

To install additional data flow probes and start them from your operating system command prompt:

—_

Log in to the host of your UCMDB system as an administrator.

2. Insert the HP Universal CMDB Setup Windows DVD into the system disc drive.

3. Start the Data Flow Probe installer ( HPUCMDB_DataFlowProbe_x.xx.exe).

4. Follow the on-screen instructions to complete the wizard, but use the following values for each
data flow probe you wish to install.

a. Type a unique path for each installation folder.

b. Usethe same UCMDB application server address for each data flow probe.

c. Type avalid data flow probe address.

d. Type a unique name for each data flow probe identifier.

e. Create a unique customer Data Flow Probe domain for each probe (Clear the Use Default
CMDB Domain option).

f. Use the same probe gateway and probe manager settings for each probe (for example, use
combined or separate processes).

See the HP Universal CMDB Deployment Guide for complete installation instructions.
5. Repeat step 3 and step 4 for each data flow probe you wish to install.

6. Open the probe’s DiscoveryProbe.properties file in a text editor. By default, this file is
located in the following folder:
<UCMDB installation folder>\<data flow probe installation folder>\conf
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For example, C: \hp\UCMDB\DataFlowProbe\con+.

Note: The <data flow probe installation folder> must be unique for each tenant.

7. Edit the following properties in the configuration file.
Discovery Probe properties set for each tenant

Property Value

serverName Verify the name of the UCMDB server

customerld Type the customer ID for the tenant this data flow
probe supports

appilog.collectors.probe.name Verify the probe name is unique such as server +
tenant ID

applilog.collectors.domain Verify the domain name of the data flow probe

appilog.collectors.local.ip Verify the data flow probe gateway name

appilog.collectors.probe.ip Verify the data flow probe manager name

appilog.collectors.rmi.port Type a unique port for each probe

appilog.collectors.rmi.gw.port Type a unique port for each probe

appilog.collectors.probe.html.port Type a unique port for each probe

appilog.collectors.local.html.port Type a unique port for each probe

appilog.collectors.ProbeUseSpecific ' Type a unique port for each probe or type 0 to have

the system automatically select it
RMIPortFrom

appilog.collectors.bigBrother.port Type a unique port for each probe
8. Save the configuration file.

9. Repeat step 6 to step 8 for each tenant’s data flow probe.

How to Start Tenant-Specific Data Flow Probes
To start tenant-specific data flow probes:

1. Openthe OS command prompt and navigate to the probe’s bin folder. For example,
C:\hp\UCMDB\DataFlowProbel\bin.

2. Type gateway console.

3. Repeat step 1 to step 2 for each data flow probe you want to start.
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How to Configure IP Ranges for Tenant-Specific Data
Flow Probes

To configure IP ranges for tenant-specific data flow probes:

1.

Log in to UCMDB as an administrator using the company ID of the tenant whose data flow
probe you want to configure.

Navigate to Data Flow Management > Data Flow Probe Setup.

Expand the data flow probe domain containing the probe you want to start. For example,
Customer2.

Expand the Probe node and select the data flow probe you want to start. For example,
Probe2Customer2.

Comains and Probes Detailz
o A
S Data Flow Probes
. - Name IP Status Last Access time
2% |Domains and Probes
Probe2Customer2 156178178173 Connected 06/ 62010 01:25:34 PM

i2K Customer2

_ -5 Credentials
43 Probes

L Probe2Customer2

Click the Add IP range button * .

Type an IP range you want the Data Flow Probe to scan. Optionally, add any IP ranges you
want to exclude.

Click OK to save the IP range.

Repeat step 1 to step 7 for each data flow probe you want to configure.

How to Configure Multi-Tenancy for Population

To support multi-tenancy for population, you need to configure the basicQueryCondition setting for
each TQL defined in the population configuration file (smPopConfFile.xml).

To configure multi-tenancy for population:

1.

2.

Log into UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

Click the smPopConfFile.xml file.

For each TQL defined in this file, update the basicQueryCondition setting by adding the
following:
and company= &quot;{customerId}&quot;
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5.

For example:

basicQueryCondition="type=&quot;bizservice&quot;and company= &quot;
{customerId}&quot;"

Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Setting up the Multi-Tenancy Integration in
Service Manager

You need to perform the following tasks in Service Manager to set up the multi-tenancy integration.

Multi-tenancy support is an optional feature of the integration intended for Managed Service
Providers (MSPs) who want to offer Configuration Management as a service to their tenants. In a
multi-tenancy configuration, each Cl and CIR record has a corresponding company 1D. Out-of-the-
box, Service Manager allows all operators to view Cl data regardless of the company ID. If you
wish to restrict access to Cl data by company ID, you must enable Mandanten and use the
company ID field as a restricting query. See the Service Manager help for more information about
multi-company mode and Mandanten.

You must complete the following tasks from your Service Manager system to enable multi-tenancy
support for the integration.

1.

Start the process schedule.
See "How to Start the Process Schedule" on the next page.

Configure the Service Manager System Information Record.
See "How to Configure the Service Manager System Information Record" on the next page.

Add tenant-specific UCMDB ID and password values to company records (optional).
See "How to Add Tenant-Specific UCMDB User ID and Password Values" on page 71.

Add UCMDB Customer ID values to existing company records.
See "How to Add UCMDB Customer ID values to Existing Companies" on page 72.

Synchronize existing company records with UCMDB.
See "How to Synchronize Existing Companies from Service Manager to UCMDB" on page 73.

Verify that Service Manager synchronized company records with UCMDB (optional).
See "How to View Whether Company Information is in UCMDB" on page 73.

Resynchronize existing company records with UCMDB (as needed).
See "How to Resynchronize an Existing Company with UCMDB" on page 74.

Inactivate company records you do not want to be part of the integration (as needed).
See "How to Inactivate a Synchronized Company" on page 75.
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9. Reactivate inactive company records you want to be part of the integration (as needed).
See "How to Reactivate an Inactive Company" on page 75

10. Add tenant-specific DEM rules.
See "How to Add Tenant-Specific DEM Rules" on page 76.

How to Start the Process Schedule

This integration needs the process schedule to synchronize company records from Service
Manager to UCMDB. You need to make sure it is started before synchronizing company records.

To start the process schedule:
1. Loginto Service Manager as a system administrator.

2. From the System Navigator, click System Status.
A list of the currently started schedules displays.

3. Click the Refresh Display button to refresh the list.

4. |If the problem schedule is not in the list, do the following:
a. Click the Start Scheduler button.

b. Double-click the process schedule.

A message displays that indicates the process schedule is started.

How to Configure the Service Manager System
Information Record

To enable the integration to support multi-tenancy, you must provide additional information in the
Service Manager System Information Record.

Caution: In order to enable multi-tenancy support, you must use HP Universal CMDB version
8.02 or greater. Earlier versions of HP Universal CMDB will produce an error message if you
attempt to run them in multi-tenancy mode.

To provide additional information in the Service Manager System Information Record:
1. Loginto Service Manager as a system administrator.

2. Navigate to System Administration > Base System Configuration > Miscellaneous >
System Information Record.

3. Click the General tab.
4. Enable the Run in Multi-Company Mode option.

5. Click the Active Integrations tab.
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10.

11.

12.

13.

14.

15.

16.

Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.

Inthe UCMDB web service URL field, type the URL to the synchronize Cls web service API.
The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

In Userld and Password, type the user credentials required to manage Cls on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

In the Multi-tenant web service URL field, type the URL to the synchronize company IDs web
service API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/UcmdbManagementService

Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

Type the user name and password required to synchronize company IDs on the UCMDB
system. For example, the out-of-the-box system administrator credentials for UCMDB 9.x are
sysadmin/sysadmin.

Click Save. Service Manager displays the message: Information record updated.
Log out of the Service Manager system, and log in again with an administrator account.
Click System Status > Display Options > All Tasks.

Type k in the Command field next to the problem schedule process and click Execute
Commands. Wait a few minutes for the problem schedule process to close.

Click Start Scheduler.

Double-click the problem schedule process. The system now supports multi-tenancy for
UCMDB.

How to Add Tenant-Specific UCMDB User ID and
Password Values

You can provide a tenant-specific UCMDB user name and password for Service Manager to use
when requesting information for the Actual State section. If you provide no credentials, Service
Manager uses the credentials in the System Information Record for all tenants.

Note: Any credentials you provide in the company record take precedence over credentials
you provide in the System Information Record. The UCMDB Userld and UCMDB Password
fields are available only when you have enabled the multi-tenancy integration.

To add tenant-specific UCMDB user name and password:
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1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Type the user name you want this company to use to connect to UCMDB in the UCMDB
Userld field.

6. Type the password for the UCMDB user name in the UCMDB Password field.
7. Click Save.

8. Repeat step 3 through step 7 for each company you want to provide credentials for.

How to Add UCMDB Customer ID values to Existing
Companies

You can use the following steps to add a UCMDB Customer ID value to your existing Service
Manager company records.

1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.
5. Type a numeric value in the UCMDB Customer ID field for this company.
6. Click Save.

7. Service Manager prompts to confirm that you want to synchronize the record with UCMDB.
Click Yes if you want to synchronize the company now, or click No if you want synchronize
the company later.

8. Click Next to go to the next company in the record list.

9. Repeat step 5 through step 8 for each company in the record list.
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How to Synchronize Existing Companies from Service
Manager to UCMDB

Your Service Manager system may already contain company records that you want to use with the
multi-tenancy integration.

If you update any field in a company record that has not yet been synchronized to UCMDB, Service
Manager prompts whether you want to synchronize the company to UCMDB.

Note: Service Manager will not prompt you to synchronize the company record if you have
disabled the option to show the company in multi-company lists, or if there is a pending
schedule record associated with the company. See "How to Inactivate a Synchronized
Company" on page 75 for more information.

This task includes the following steps:
1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.
5. Select acompany record to update.
6. Update the company record.

7. Click Save. Service Manager prompts to confirm that you want to synchronize the record with
UCMDB.

Note: Service Manager saves the company record regardless of your synchronization
choice.

How to View Whether Company Information is in
UCMDB

When you enable the multi-tenancy integration, Service Manager displays a read-only field in each
company record that lists whether the UCMDB Customer ID has been synchronized with your
UCMDB system.

Note: The UCMDB Customer ID field is visible only when you enable the multi-tenant
UCMDB integration.

To view whether company information is in UCMDB:
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Log in to Service Manager as a system administrator.
Navigate to System Administration > Base System Configuration > Companies.

Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

Click Search.

Review the status of the Synched with UCMDB field.

If the check box is checked, then Service Manager has already synchronized the company ID
with your UCMDB system. If the check box is unchecked, then Service Manager has yet to
add this company to your UCMDB system.

Note: For more information about synchronization failures, see "Schedule Records" on
page 63.

How to Resynchronize an Existing Company with
UCMDB

Service Manager provides you a means to resynchronize company records with your UCMDB
system in case you lose UCMDB data for some reason. For example, you might intentionally
remove UCMDB data during integration testing, or you might need to recover data after a disaster.
You can force Service Manager to synchronize companies with your UCMDB system with the Re-
synch with UCMDB option.

To resynchronize an existing company with UCMDB:

1.

2.

Log in to Service Manager as a system administrator.
Navigate to System Administration > Base System Configuration > Companies.

Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

Click Search.
Select a company record to synchronize.

Click the Re-synch button next to the Synched with UCMDB? check box.

Note:

The Re-synch button is available only from company records that have already been
synchronized with UCMDB and have the Synched with UCMDB check box checked.

If your UCMDB system already has a company with this ID value, it will ignore the
resynchronization request. Service Manager will also ignore a resynchronization request if
there is an existing schedule record to resynchronize the company with UCMDB. In this
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case, it displays the message “A schedule record has already been added to re-
synch this company with UCMDB>.

How to Inactivate a Synchronized Company

After you have synchronized a company record with UCMDB you can no longer delete the record.
Instead, you can inactivate a company record, which causes the UCMDB system to cease all
further Cl updates for the company. Any existing Cl data for the company remains in the UCMDB
system associated with the inactive UCMDB Customer ID, but both the company and any
associated Cls will no longer be visible from the UCMDB system.

To inactivate a synchronized company:

1.

2.

Log in to Service Manager as a system administrator.
Navigate to System Administration > Base System Configuration > Companies.

Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

Click Search.

Select a company record to inactivate.

Select No from Show Company in Multi-Company Lists.
Click Save.

If this company was previously synchronized with UCMDB, Service Manager prompts you to
confirm the inactivation.

Click Yes to confirm the inactivation or No to cancel your changes.

How to Reactivate an Inactive Company

You can reactivate any inactive companies on your Service Manager system to include them in the
multi-tenancy integration. You must also synchronize the company with UCMDB for UCMDB to
process any Cl updates for this company.

To reactivate an inactive company:

1.

2.

Log in to Service Manager as a system administrator.
Navigate to System Administration > Base System Configuration > Companies.

Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

Click Search.
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5. Select a company record to reactivate.
6. Select Yes from Show Company in Multi-Company Lists.
7. Click Save. Service Manager prompts you to reactivate the company with UCMDB.

8. Click Yes. Service Manager creates a schedule record to reactivate the company.

How to Add Tenant-Specific DEM Rules

You can use the condition field to create DEM rules that are specific to a particular tenant in a multi-
tenancy UCMDB-SM integration. For example, one tenant may want to add Cls directly to Service
Manager while another tenant may want to open changes for each Cl. The following sample DEM
rules illustrate how to accomplish this.

Tenant-specific DEM rules

DEM rule Id Action on new ClI Condition
ucmdbNode_advantage Add ClI company in $L.file="advantage”
ucmdbNode_hp Create change company in $L.file="HP”

Tip: Itis a best practice to create a separate DEM rule for each tenant.
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Chapter 4: Standards and Best Practices

This chapter includes:
e "UCMDB-SM Configuration Best Practices" below

¢ "Frequently Asked Questions" on page 88

¢ "Known Issues and Limitations" on page 102

UCMDB-SM Configuration Best Practices

This section provides best practices and recommendations for successfully implementing this
integration in various environments. This section provides you with valuable understandings and
techniques that will enhance the UCMDB-SM integration as well as solve common problems by
providing solutions and workarounds to these issues. These practices and recommendations may
vary slightly according to each implementation, as the specific system requirements and settings
alter per system environment.

This section includes:

¢ "Cl Name Mapping Considerations" below

e "Bi-Directional Data Synchronization Recommendations" on the next page
e "Push Scheduling Recommendations" on page 79

e "Push in Clustered Environments" on page 80

¢ "Initial Load Configurations" on page 82

e "How to Configure Differential/Delta Load DEM Rules" on page 86

e "Fault Detection and Recovery for Push" on page 87

¢ "How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 88

Cl Name Mapping Considerations

UCMDB allows duplicate Cl names while Service Manager requires unique logical names. Before
pushing UCMDB Cls, you need to define a correct Cl name mapping for them. For example, many
UCMDB Cls (such as Cls of the Running Software, CRG, Switch, or Router type) have the same
display label.

To prevent duplicate Cl names from occurring in Service Manager when pushing UCMDB Cls, the
following mappings are provided out-of-the-box:
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CRG mapping
Out-of-the-box, UCMDB CRG records are mapped to Service Manager as follows:

o If aCluster exists fora CRG, the CRG is mapped to this Cl logical name: <Cluster display
label>_<CRG display label>;

¢ |fthe CRG does not have a Cluster, but has several IP addresses, the CRG is mapped to the
following (where the IP addresses are sorted alphabetically):
<IpAddress1>_... <IpAddressN>.<authoritativeDnsName>_<CRG display label> (when
IpAddress.authoritativeDnsName exists)

<IpAddress1>_..._<IpAddressN>_<CRG display label> (when
IpAddress.authoritativeDnsName does not exist)

o If neither a Cluster nor an IP address exists for the CRG, it is mapped directly to <CRG display
label>.

Running Software mapping

Running Software Cls are prefixed with their root container node display label when mapped to a
Service Manager Cl: <Node display label>_<Running Software display label>.

Switch & Router mapping

Switch or Router type Cl records in UCMDB are prefixed with their MAC adresses when mapped to
a Service Manager Cl: <MACAddress1>_... <MACAddressN>_<Switch or Router display label>,
where the MAC addresses are sorted alphabetically.

Bi-Directional Data Synchronization Recommendations

The UCMDB-SM integration supports bi-directional data synchronization between UCMDB and
Service Manager (SM). HP recommends that you follow the following best practices to avoid
unnecessary problems due to improper use of the data push and population features:

e For Cls/Cl Relationships that UCMDB can automatically discover, use UCMDB as the data
source. Do not make changes to them in Service Manager, instead always let UCMDB discover
their changes and push the changes to SM.

e For Cls/Cl Relationships that UCMDB cannot automatically discover, use SM as the data
source. Do not make changes to them in UCMDB, instead always make changes to them in SM
and populate the changes to UCMDB.

e For Cls/Cl Relationships that are already created in SM and UCMDB can automatically
discover, run a one-time population to synchronize them to UCMDB, and then use UCMDB as
their data source.

Caution: Problems like the following may occur if you do not follow these best practices:

Problem 1:
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[Population Adapter] After Cls/Cl Relationships are pushed from UCMDB, if you directly make
changes in SM to these records without ever populating them back to UCMDB first, the
changes cannot be populated to UCMDB.

Workaround:

Changing these UCMDB records in SM is not recommended; however if you need to do so you
can do the following to solve this issue: After the records are pushed to SM, populate them
back to UCMDB first before making any changes to them in SM. This way the changes can
then be populated to UCMDB.

Problem 2:

[Population Adapter] After a Composition relationship between a Node CI (node 1) and
Running Software Cl is pushed to SM, if you change the upstream CI of the relationship from
node 1 to node 2 and then run a change population to populate this change, the Running
Software CI will be removed in UCMDB.

Workaround:

It is recommended that you remove the running software in UCMDB and create a new one
instead of directly replacing the container of the running software in SM. If you cannot avoid
doing so, do the following:

After you change the upstream CI of the relationship from node 1 to node 2, do not directly run
the change population. Follow these steps to avoid this issue:

1. Update the Running Software Cl in SM (or simply save it to mark it as updated).

2. Run aRunning Software Cl change population. This will create node 2 (if it does not
already exist in UCMDB) and a new Composition relationship between node 2 and this
Running Software CI.

3. Run a change population to synchronize the relationship change to UCMDB. The
relationship between node 1 and the Running Software CI will be removed, and the new
relationship created in step 2 will remain.

If you have run the change population after changing the upstream ClI of the relationship from
node 1 to node 2, and as a result the Running Software Cl has been removed in UCMDB,
follow these steps to solve this issue:

1. Update the Running Software Cl in SM (or simply save it to mark it as updated).

2. RunaRunning Software Cl change population. This will create the Running Software Cl,

node 2 (if it does not already exist in UCMDB) and a new Composition relationship
between node 2 and this Running Software CI.

Push Scheduling Recommendations

Push jobs are run using two main methods, the first method is by manually executing the push job
and the second is by scheduling the push job.
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All push jobs can potentially produce a strain on the UCMDB and SM systems therefore; HP
recommends that you adhere to the following guidelines:

Scheduler time frames

It is important for you to understand the function of the Scheduler “time frame” concept. Running
push jobs creates an increase in system activity and may affect application responsiveness. In
order to enable users to effectively interact with applications HP recommends the following
guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at a minimum.

Scheduler frequency

It is important to be aware of the business requirements when configuring the schedule frequency.
The scheduler frequency depends on infrastructure environment changes that must be
synchronized between UCMDB and SM.

Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that
are prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies

UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is
considered a separate task and users cannot define job dependencies. For example, that one job is
dependent on another or upon completion before the next job is run.

It is important that both CI TQLs and their dependent Relationship TQLs exist in the same Job in
order to avoid relationships not being pushed to Service Manager. UCMDB always pushes the ClI
TQLs before their dependent Relationship TQLs.

Note: Suffix usage

The out-of-the-box job for Cl push uses queries that end with the “Push” suffix, for example,
“SM Computer Push”.

Queries that create relationships between the Cls uses an extra “Relations” suffix, for
example, “SM Node Relations Push”.

Push in Clustered Environments

A clustered SM environment is comprised of multiple servlets running in parallel with a load
balancer that dispatches user requests to any available servlet. You must configure the UCMDB-
SM integration to point to a specific servlet and not to the SM loadBalancer. In order to perform this,
you must first create a dedicated web service listener.

This section includes:

e "Dedicated Web Services" on the next page

e "Step-by-Step Cluster Configuration Process" on the next page
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e "Connecting to Multiple SM Processes" on the next page

Dedicated Web Services

A Service Manager system configured for vertical or horizontal scaling uses a load balancer to
redirect client connection requests to an available SM process. However, most Web Services
clients cannot handle a redirect request and will fail if they use the SM load balancer as the endpoint
URL.

HP recommends creating one or more SM processes dedicated to Web Services requests. The
user must configure the relevant external web service clients to connect directly to the dedicated
Service Manager processes.

Step-by-Step Cluster Configuration Process

How to Configure Web Clients

To configure the relevant external web clients:
1. Stop the Service Manager service.

2. Openthe sm.cfgfile, and create a dedicated SM process to listen for Web Services requests
using the -debugnode parameter.
The following entries create a dedicated process listening on ports 13085 and 13445.
01 sm -httpPort:13080 -loadbalancer
02 sm -httpPort:13081 -httpsPort:13443
03 sm -httpPort:13083 -httpsPort:13444
04 sm -httpPort:13085 -httpsPort:13445 -debugnode

Explanation

The code excerpt illustrates the various settings for each of the SM process listeners (web
services) that enable SM clients to connect to the SM service.

Line 01 defines the load balancer port (13080).

Lines 02 and 03 define the SM ports to which non-dedicated SM clients are redirected by the
SM load balancer.

Line 04 defines the debugnode port that is utilized by the dedicated SM clients.

Note: Debugnode parameter

The debugnode parameter tells the SM load balancer not to forward any client connection
requests to this Service Manager process. Only clients that directly connect to the process can
access this port.
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How to Configure the Debugnode

To configure the debugnode:

1. Start the SM service.

2. Configure any external web service clients to connect directly to the SM processes running in
debugnode. When performing an integration using UCMDB, the UCMDBService Manager
Adapter for SM should be configured to connect to the debugnode port.

For example, for normal connections set the endpoint URL to:

http://<fully qualified host name>:13085/SM/7/<Service Name>

and for SSL-encrypted connections set the URL to:
https://<fully qualified host name>:13445/SM/7/<Service Name>.

These clients may include UCMDB (for push purposes), Connect-It and additional
applications.

Connecting to Multiple SM Processes

If you want to have better performance, you can connect to multiple Service Manager processes.
The integration supports in both Service Manager vertical or horizontal load balancer environment.

You can create more than one SM processes dedicated to Web Services requests, and configure
the field URL Override of integration point with the dedicated SM processes. This field value (if any)
overrides the Hostname/IP and Port settings.

The following is an example value of this field, which connects two SM processes:

http://<fully qualified host namel>:13080/SM/7/ws;http://<fully qualified host
name2>:13082/SM/7/ws

Initial Load Configurations

Before the configuration process can begin, you must first assess the amount of Cl and
relationships data is to be transferred from UCMDB to SM and ascertain the iteration process that
is required based on the volume.

You must first assess whether all of the data can be pushed in a single iteration. This is ascertained

by the amount of data that is included in the push queries and the amount of time you have to push
this data.

This section includes:

e "Push Performance in a Single-Threaded Environment" on the next page
¢ "Implementing Multi-Threading" on the next page

e "Push Performance in Multi-Threaded Environments" on page 84
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e "Push Performance in Multiple SM Processes Environments" on page 85

e "How to set up SM DEM Rules for Initial Loads" on page 85

Note: The performance data presented in this document is based on tests that were performed
at HP and is provided for reference only. The integration performance may significantly differ in
your environment depending on your hardware configuration.

Push Performance in a Single-Threaded Environment

The Push of 22,500 UCMDB root Cls (roots in TQLs) and/or Relationships in a single-threaded
environment takes about an hour and is performed in a linear fashion. See the following table:

Performance data in a single-threaded environment

Number of root Cls/CIl Relationships pushed
per hour Multi-threading settings in sm.properties

22,500 number.of.concurent.sending.threads=1
min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

To view or edit the sm.properties file in UCMDB, navigate to Data Flow Management > Adapter
Management > ServiceManagerAdapter9-x > Configuration Files > sm.properties.
Number of Root Cls and Relationships/22,500

The push time (in hours) in any given environment is calculated as follows:

If the push of a single planned query has the potential of breaching the permitted time frame the data
must be divided into several queries. Each query must be pushed individually.

This query division is performed by creating several queries, each with different node conditions
that enable data filtering. Once all queries are pushed for the first time, the Initial Load process is
complete.

Note: Applying node conditions

When applying node conditions to the various SM Sync Queries, you must make sure that all
of the information is included in the queries, so that all relevant data is copied to SM.

Implementing Multi-Threading

In order to improve performance, the Service Manager Adapter utilizes multiple threads for the push
of Cl and Relationship data to SM. The following section explains these settings and how to
configure them for maximum performance.

The multi-threading configuration is defined in the sm.properties file on the UCMDB server. To view
or edit the file in UCMDB, navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > sm.properties.
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The following are example multi-threading definitions in the sm.properties file:

01 number.of.concurent.sending.threads=6
02 min.objects.for.concurent.sending=50

03 number.of.chunks.per.thread=3

Explanation
The code excerpt illustrates the relevant multi threading settings on the UCMDB server.

e Line 01 defines the number of parallel threads UCMDB will open to SM for Cl push. Setting this
parameter to 1 disables multi-threading, while a values of 2 or higher enables multi-threading.

e Line 02 defines the minimum number of SM objects needed to use multiple threads as opposed
to a single thread.

e Line 03 defines the number of chunks per thread. This number multiplied by the number of
threads gives you the total number of Cl data chunks.

e The total number of chunks = number.of.chunks.per.thread *
number.of.concurent.sending.threads

The integration implements a queue mechanism as follows:

The data passed from UCMDB to SM is divided into equal chunks, and these chunks are placed in
aqueue.

Each available thread pulls the next chunk from the queue until all threads are available. Once this
process has completed, the push is complete.

The mechanism is designed to minimize idle time of each thread. As each thread processes its
chunk in parallel, some threads may finish before others and it is inefficient for them to wait for each
other.

Caution: Defining too many threads

It is ineffective to over-increase the number of threads as this causes the SM server to
overload. In enterprise environments where the SM server processing the push data is very
robust the number of threads can be increased to 10 and in some cases even 20; however, you
must take into account that increasing the number of threads raises CPU usage on the SM
server during push, which may reduce application performance.

Push Performance in Multi-Threaded Environments
The push of 60,000 UCMDB root Cls (roots in TQLs) and/or Relationships in an out-of-the-box

multi-threaded environment takes about an hour and is performed in a linear fashion. See the
following table:
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Performance data in an out-of-the-box multi-threaded environment

Number of root Cls/Relationships pushed Multi-threading settings in sm.properties
per hour (default)

60,000 number.of.concurent.sending.threads=6
min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

The push time (in hours) in any given environment is calculated as follows:

Number of Root Cls and Relationships/60,000

Push Performance in Multiple SM Processes
Environments

The Push of 190,000 UCMDB root Cls (roots in TQLs) and/or Relationships in a multi-threaded
environment with multiple SM processes takes about an hour and is performed in a linear fashion.
See the following table:

Performance data in a multiple SM processes environment

Number of root

Cls/Relationships Multi-threading settings in sm.properties

pushed per hour SM processes (default)

190,000 2 server hosts, with  number.of.concurent.sending.threads=90
each host running 3

processes min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

For more information about defining multiple SM processes for the integration, see "How to Create
an Integration Point in UCMDB" on page 29.

The push time (in hours) in any given environment is calculated as follows:

Number of Root Cls and Relationships/190,000

How to set up SM DEM Rules for Initial Loads

SM Discovered Event Manager Rules (DEM Rules) enable the user to define the appropriate action
to take for each event type that is reported to SM.

Each CI and relationship record pushed from UCMDB to SM is analyzed against the existing SM
records and open Change requests. SM rules define the appropriate action to be taken for each type
of Cl data update sent to SM.

To view or update the SM Discovered Event Manager Rules:
1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.
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3. Press ENTER or click the Search button.
A list of all the Discovered Event Manager Rules displays. Each rule is usually linked to a CI
Type or a subset of Cls of the same type.

4. Click onthe individual Cl Discovered Event Manager Rule to view its details.

To set up DEM Rules for initial loads:

Tip: When performing “Initial Loads”, HP recommends setting the SM Discovered Event
Manager Rules to add newly reported Cls as described below. This minimizes the “noise” of an
Initial Load, that could potentially create tens of thousands of Changes/Incidents.

For each of the Discovered Event Manager Rules, perform the following steps:
1. Select the relevant Discovered Event Manager Rule.
2. Gotothe “Action if matching record does not exist” section, select the Add the record option.

3. Inthe “Action if record does not exist but unexpected data discovered” section, select the Log
Results and Update Record option.

4. Inthe “Action if record is to be deleted” section, select the Delete Record option.

5. Save the Discovered Event Manager Rule record.

How to Configure Differential/Delta Load DEM Rules

Tip: Once the “Initial Load” or “Data Load” of the Cl| data is completed, HP recommends

applying Differential/Delta Load settings. These settings apply to all data loaded from UCMDB
to SM.

These loads send only updates regarding modifications discovered in the IT infrastructure from
UCMDB to SM.

To set up the SM DEM Rules for Differential/Delta Loads:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

3. Press Enter or click the Search button.
A list of all the Discovered Event Manager Rules in SM displays.

4. Foreach of the Discovered Event Manager Rules, perform the following steps:
a. Select the relevant Discovered Event Manager Rule.

b. Inthe “Action if matching record does not exist” section, select the appropriate action
required for each newly detected CI. If uncertain, select the Add the record option.
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c. Inthe “Action if record does exist but unexpected data discovered” section, select the
appropriate action for each Cl that was modified, resulting in an unexpected or incorrect
result. The recommended best practice is to select the Open a Change option.

d. Inthe “Action if record is to be deleted” section, select the appropriate action required for
each CI that was removed/deleted. The recommended best practice is to select the Delete
Record option for Cl Relationship, and select the Update record to the selected status
option for ClI.

e. Save the Discovered Event Manager Rule record.

Fault Detection and Recovery for Push

Universal CMDB provides a fault detection and recovery mechanism since version 9.05: individual
Cl failures no longer cause the entire push to fail, and you can review all failed Cls in the Universal
CMDB studio and then re-push them.

Duplicated logical.name issue

A typical fault you may encounter is the duplicated logical name issue because of the different
unique key fields used in Universal CMDB and Service Manager: Cl logical.name in Service
Manager is unique, and it usually maps to Cl display label in Universal CMDB (which is not unique).
HP recommends that you follow the following guidelines (listed from highest to lowest priority) to
resolve this issue:

e Make sure that each display label field value in UCMDB is unique;

o If uncertain of the above, in the adapter mapping configuration (XSLT file) avoid direct mapping
between Universal CMDB display label and SM logical name.

¢ Map SM logical name to another Universal CMDB field that is unique;

e Add a prefix or suffix to UCMDB display label value;

Note: Out-of-the-box, the SM logical name of Running Software is mapped with a prefix of
DNS name:

<xsl:variable name="fullDNSName" select="nodes/node/@primary_dns_name"/>

<xsl:for-each select="@display_label">
<CIIdentifier><xsl:value-of select="$fullDNSName"/>_

<xsl:value-of select="."/>

</CIIdentifier>

</xsl:for-each>

¢ If you cannot do any of the above, you can use the UCMDB Fault Detection and Recovery
mechanism together with the “Duplication Rule” setting of DEM rules (see the following).

To set up DEM Rules for duplicated logical names:

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 87 of 248



1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules > Duplication
Rule tab.

3. Foreach of the Discovered Event Manager Rules, perform the following steps:
a. Gotothe “Action if logical name is duplicated” section, and select the Return Error option.

b. Save the Discovered Event Manager Rule record.

Note: After you run a push job, Cls with a duplicated logical name are reported as failed
Cls with a duplicated name exception. You can review the failed Cls in the Universal
CMBDB studio, fix the errors by either changing the data in Universal CMDB or in the
adapter mapping configuration file (XSLT), and then re-push the failed Cls.

How to Enable Lightweight Single Sign-On (LW-SSO0)
Configuration
You can enable LW-SSO for the integration so that users can directly view UCMDB CI records

from the Service Manager web client by clicking the View in UCMDB button, without providing a
UCMDB usemame and password.

Note: LW-SSO is not supported for the Service Manager Windows client.

To enable LW-SSO for the integration:

1. Foreach Service Manager user account that needs LW-SSO, create a user account in
UCMDB with the same username. The passwords in the two systems can be different.

2. Enable LW-SSO in the Service Manager Web tier. For details, see the Configure LW-SSO in
the Service Manager Web tier topic in the Service Manager help.

3. Enable LW-SSO in UCMDB. For details, see the HP Universal CMDB Deployment Guide.

Frequently Asked Questions

This section provides answers to frequently asked questions about the UCMDB-SM integration.

This section includes:

e "Whenis aNew Cl Created in HP Service Manager " on the next page
e "Can|l Analyze the Reason for a Cl Deletion in SM" on the next page
e "How do | Monitor Relationship Changes Between UCMDB and SM" on page 90

e "What Kinds of Relationships are Pushed from UCMDB to SM" on page 90
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e "Whatis a Root Cl Node" on page 91
¢ "What is a Root Relationship" on page 91
e "What is the “friendly Type” Specified in an XSLT File" on page 91

e "What is the “Virtual-Compound” Relationship Type Used ina UCMDB-SM Integration Query"
on page 91

¢ "When do | Need the Population Feature" on page 91

¢ "Can | Populate Physically Deleted Cls from SM to UCMDB" on page 92

e "How do | Keep the Outage Dependency Setting of a Cl Relationship in SM" on page 92
e "How do | Create an XSL Transformation File" on page 94

e "How do | Use the Load Fields Button to Add Multiple Managed Fields" on page 100

e "What is the Purpose of the <container> Element in a Population XSLT File" on page 100
e "Can | Populate Sub-ltem Deletions" on page 101

¢ "What will Happen if a Population Job Fails or Succeeds with Warnings" on page 101

When is a New Cl Created in HP Service Manager
Cls are created in SM under the following circumstances:

e A Clis manually added to SM via the “Configuration Management” module.

o UCMBDB reports a newly discovered Cl according to the following:
= When a new Cl is reported and the “Discovered Event Manager Rules” are set to “Add the
Record”.

= When a new Cl is reported, the “Discovered Event Manager Rules” are set to “Open an
Incident” and the Incident has been closed.

= When a new Cl is reported, the “Discovered Event Manager Rules” are set to “Open a
Change” and the Change has been verified.

Can | Analyze the Reason for a Cl Deletion in SM

No.
SM opens a change request on the deleted CI and includes the following information:

“Delete event for Cl “Cl Name” triggered by discovery”.

Workaround
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An SM change request does not contain a description of the reason for deletion, however it is
possible to extract specific information about CI deletions from the UCMDB “History Database”.
UCMDB data provides information about the user or the discovery pattern that initiated the CI
deletion.

How do | Monitor Relationship Changes Between
UCMDB and SM

To understand the relationship change in SM, a distinction must be made between the various
types of Relationship Changes:

e The second endpoint of the relationship has Changed, so instead of Cl X being linked to C1 Y via
a relationship, now Cl X is related to Cl Z.

¢ An attribute of a relationship has changed.

The first type of Relationship change is supported by the UCMDB-SM integration, therefore, such
“Relationship Changes” can either invoke ClI relationship updates, or perform the creation of
Incidents or Changes, which are then reviewed and monitored.

The second is also supported, but it is not covered out-of-the-box; you can configure the Universal
CMDB TQL to expose such attributes of relationship, and configure the Service Manager WSDL to
expose the mapped field, and then configure the adapter mapping configuration in the XSLT.
However such “Relationship Attribute Changes” cannot perform the creation of Incidents or
Changes, and only supports invoking Cl relationship updates directly.

What Kinds of Relationships are Pushed from UCMDB to
SM

Any kinds of “Relationships” are pushed from UCMDB to SM under the following conditions:

o The relationship appears in a “Push TQL” located in the “SM Sync” folder in the UCMDB Query
Manager.

e The relationship is named “Root” in the Push TQL.

¢ The relationship is mapped to an appropriate target in SM in the UCMDB configuration files
(XML and XSLT files).

The out-of-the-box relationships that are pushed from UCMDB to SM are relationships between two
Cls such as:

o Between Business Services and Applications;

¢ Between Business Service and Host;
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e Between an Application and a Network Component; or

o Between Host, Network Components and Printers.

What is a Root Cl Node

A “Root” Node is a TQL Node that represents the Cl type that is created via push to SM from the
TQL structure. The rest of the TQL structure contains information that can be incorporated within
the “Root” Cl type and is used to enrich the record in SM with additional information and or
attributes.

What is a Root Relationship

A “Root” Relationship is a Relationship within a TQL and created in SM via push. It represents a
Relationship between two Root Cls. Only the relationships marked with “Root” are pushed to SM.

What is the “friendlyType” Specified in an XSLT File

friendly Type is another name for the UCMDB “Cl Type”. These “friendly-types” are usually pushed
into the SM Device subtype field/attribute.

What is the “Virtual-Compound” Relationship Type
Used in a UCMDB-SM Integration Query

When more than two UCMDB CI entities are connected in series, the “Virtual-Compound”
represents the relationship between the first and last entities. This is a virtual relationship, as no
physical representation exists.

The “Virtual-Compound” relationship type is a relationship that links two CI type entities that have a
logical relationship. See the following figure:

Host ) Application ) | Business Service

Virtual-Compound

Explanation

The illustration shows an example of a Virtual-Compound relationship. The relationship in SM is
created directly between the “Host” and the “Business Service”.

When do | Need the Population Feature

You need the population feature under any of the following circumstances:
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¢ You have done modeling in SM, especially when you are in the planning and design phases, and
you want your models to be reflected in UCMDB;

¢ You want to implement the UCMDB-SM integration, however you have already invested in your
SM CMDB and do not want to lose that investment;

¢ You want to continue to maintain some parts of the SM CMDB while maturing your
UCMDB/Discovery implementation.

Can | Populate Physically Deleted Cls from SM to
UCMDB

No.

Physical deletions of Cls are allowed in SM, but SM cannot get such “deletion changes” and the
population feature will not synchronize such changes to UCMDB.

Physical deletions of Cls can be considered as exceptions, which only occur after you create Cls
by mistake. Normally, you delete a Cl by setting its status to something like “Disposed/Retired”. In
case such Cls have been populated to UCMDB, it is your responsibility to remove them manually
from UCMDB.

How do | Keep the Outage Dependency Setting of a Ci
Relationship in SM
Out-of-the-box, Cl relationships that are pushed from UCMDB to SM do not have outage
dependency information by default. If you need such information, you can set the DEM rule of the
Cl Relationship WSDL as follows:
1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

3. Open the ucmdbRelationship record.
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4. Onthe Rules tab, select Add the record, and set dependency as true.

Id: |uu'ndbReIationshi|:u |
Table Mame: |cirelah'onshi|:l |

Condition: |

& Rules | % Managed Fields | < Incdent Customization | & Change Customization

r Action if matching record does not exist

O Add the record

() iAdd the record, and set dependency as true
) Open a Change
O Open an Incident

This will set the Outage Dependency of each Cl Relationship to true, and set the number of
dependent downstream Cls to 1 (because UCMDB only supports one-to-one relationships).

If you want to set outage dependency only for some relationships, for example, if you want to
configure outage dependency for relationships that starts from Business Service, you can configure
the adapter configuration file (XSLT) and WSDL definition; you can also configure outage
dependency per relationship type (UCMDB TQL).

1. Inthe WSDL definition, expose fields outage.dependency and outage.threshold.

External Access Definition

Service Mame: Pmdblntegration | [ released
Mame: cirelationship | hd O peprecated
Object Name: Relationship

< Allowed Actions | < Expressions | & Fieglds |

Field I Caption I Type
relationship. name Relationshipiame
logical.name ParentClL
related. cis ChildCIs
relationship. type RelationshipType
Balat inSubtype

relah’onihin b
utage.dependency

COutageDependenc
OutageThreadhold

< outage, threshold
T

2. Inthe XSLT file, set the exposed outage fields. For example, if you want to set the outage
dependency to true and threshold to 1 for Business Service relationships, you simply need to
change the mapping of TQL and XSLT in the smSyncConfFile.xml file:

<tql name="applicationRelationsData" xslFile="bizservice_relations.xslt">
<request type="Create" name="CreateRelationship"/>

<request type="Update" name="UpdateRelationship"/>
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<request type="Delete" name="DeleteRelationship"/>

</tql>

3. Inthebizservice_relations.xslt file, use the following OutageDependency and
OutageThreadhold settings:

<xsl:stylesheet version='1.0"' xmlns:xsl='http://www.w3.0rg/1999/XSL/Transfor
m'>

<xsl:template match="/relation">
<model>
<keys/>
<instance>
<ParentCI><xsl:value-of select="@parentID"/></ParentCI>
<ChildCIs>
<ChildCIs><xsl:value-of select="@childID"/></ChildCIs>
</ChildCIs>
<RelationshipType>Logical</RelationshipType>

<RelationshipSubtype><xsl:value-of select="@friendlyType"/
></RelationshipSubtype>

<OutageDependency>true</OutageDependency>
<OutageThreadhold>1</OutageThreadhold>
</instance>
</model>
</xsl:template>

</xsl:stylesheet>

How do | Create an XSL Transformation File

You create an XSL transformation file in Adapter Management. You can copy the content of an
existing XSL transformation file to the new file and then make necessary edits.

To create an XSL transformation file:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management. ServiceManagerAdapter9-x
> Configuration Files.

3. Click the Create new resource button

4. Select New Configuration File.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 94 of 248



5. Enter a name for the file. The file name should use this format: <AdapterlD>/<filename>. For
example: ServiceManagerAdapter9-x/test_relation_population.xsit.

6. Inthe Package field, select the adapter name. For example, ServiceManagerAdapter9-x.
7. Click OK. A file extension waming dialog displays.

8. Click Yes to continue.
UCMDB creates the new XSL transformation file in the Configuration Files folder of the
adapter. For example, ServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/test_relation_population.xsit.

9. Copy the content of an existing XSL transformation file to the new file. For example, for
population you can copy the content of an out-of-the-box population XSL transformation file.

10. Make necessary edits to the new file.

Caution: Invalid XML

When removing XSL elements from an XSLT file, keep in mind that the remaining XML should
be a valid XML file, which will be used to translate the UCMDB Query Definition. See the
following for an example.

Out-of-the-box, the businessservice to computer_containment_population.xslt file is
as the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m">

<xsl:template match="/RetrievecirelationshipltollListResponse">
<topology>

<xsl:for-each select="instance">

<xsl:choose>
<xsl:when test="upstreamci.subtype='Infrastructure Servic
eIII>
<ci class="infrastructure_service">
<attribute name="name" type="String"><xsl:value-of s
elect=

"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>
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<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>

</attribute>
</ci>
</1link>
</ci>
</xsl:when>
<xsl:when test="upstreamci.subtype="'Application Service'">
<ci class="business_application">
<attribute name="name" type="String"><xsl:value-of s
elect=

"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>

</attribute>
</ci>
</1link>
</ci>
</xsl:when>
<xsl:otherwise>
<ci class="business_service">
<attribute name="name" type="String"><xsl:value-of s
elect=

"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">

<ci class="node">
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<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>
</1link>
</ci>

</xsl:otherwise>

</xsl:choose>

</xsl:for-each>

</topology>
</xsl:template>

</xsl:stylesheet>

The file becomes an invalid XML file if you change it to the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor

m">
<xsl:template match="/RetrievecirelationshipltolListResponse">
<topology>
<xsl:for-each select="instance">
<xsl:choose>
<xsl:when test="upstreamci.subtype="'Infrastructure Service'">
<ci class="infrastructure_service">
</xsl:when>
<xsl:when test="upstreamci.subtype="Application Service'">
<ci class="business_application">
</xsl:when>
<xsl:otherwise>
<ci class="business_service">
</xsl:otherwise>
</xsl:choose>
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<attribute name="name" type="String"><xsl:value-of sele
ct="upstreamci.logical.name"/>
</attribute>

<attribute name="sm_id" type="String"><xsl:value-of sel
ect="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select=
"downstreamci.id"/></attribute>

</ci>
</1link>
</ci>
</xsl:for-each>
</topology>
</xsl:template>

</xsl:stylesheet>

Sample usages of XSLT

For your reference, the following are some samples of using XSLT functionalities in this
integration.

Using choose to set Cl subtypes:
<Type>switch</Type>
<xsl:variable name="prefix" select="'Value&gt;'"/>
<xsl:variable name="suffix" select="'&1t;/Value'"/>
<Subtype>

<xsl:choose>

<xsl:when test="contains(@node_role,concat($prefix, 'atm_switch',$suffix))">A
TM Switch</xsl:when>

<xsl:when test="contains(@node_role,concat($prefix, 'frame_relay switch',$suf
fix))">Frame Relay Switch</xsl:when>
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<xsl:when test="contains(@node_role,concat($prefix, 'lan_switch',$suffix))">L
an Switch</xsl:when>

<xsl:otherwise><xsl:value-of select="@friendlyType"/></xsl:otherwise>

</xsl:choose>
</Subtype>
Getting the substrings from a string:
<xsl:variable name="calculatedLocation" select="@calculated_location"/>
<Building>

<xsl:value-of select="substring-after($calculatedLocation,’' Building:"')"/>
</Building>
<Floor>

<xsl:value-of select="substring-before(substring-after($calculatedLocation, 'F1l
oor:')," Building:"')"/>

</Floor>
<Room>

<xsl:value-of select="substring-before(substring-after($calculatedLocation, 'Ro
om:")," Floor:')"/>

</Room>
Reading the value mappings from an XML file:
The SM_CIT_Subtype_list.xml file defines the value mappings for subtypes:
<lists>
<list name="CIType_bizservice">
<entry ucmdb="BusinessApplication" sm="Application Service"/>
<entry ucmdb="BusinessService" sm="Business Service"/>
<entry ucmdb="InfrastructureService" sm="Infrastructure Service"/>
</list>
</lists>

The business_service_push.xslt file uses this mapping definition XML file:

<xsl:variable name="CIlists" select="document('SM_CIT_Subtype_ list.xml')/list
s"/>

<xsl:variable name="CIT" select="@bdmType"/>
<xsl:for-each select="$CIlists/list[@name="CIType_bizservice']">
<Subtype><xsl:value-of select="entry[@ucmdb=$CIT]/@sm"/></Subtype>

</xsl:for-each>
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Tip: For more information about XSL transformations, visit the following site:
http://www.w3schools.com/xsl/

How do | Use the Load Fields Button to Add Multiple
Managed Fields

Service Manager stores the list of managed fields in the ucmdblintegration web service, which
consists of a number of web services objects. You can add more managed fields to DEM Rules so
that Service Manager can monitor changes in more Cl attributes in UCMDB and trigger the actions
defined in relevant DEM Rules.

You can manually add managed fields that are exposed in associated WSDL definitions to DEM
Rules; however, you can use the Load Fields button to automatically (and therefore correctly) add
managed fields to DEM Rules.

1. Click the Managed Fields tab of the DEM Rule.
2. Click the Load Fields button.

3. If the table (in the Table Name field) of the DEM rule record has only one WSDL definition
associated to it, all fields exposed in the WSDL definition are immediately added to the
Managed Fields list.

A message displays: <XX> new fields loaded.

4. |f the table has more than one WSDL definition associated to it, the Managed Fields Importing
wizard opens, and a list of WSDL definitions (ucmdblntegration web service objects) displays.
a. Select one or more objects, and click Next.

b. All new fields that can be added from the selected web service objects display.

c. If youwant to add all of the fields, click Finish; if you want to ignore some of them, change
their Action value from Add to Ignore, and then click Finish.
A message displays: <XX> new fields loaded.

5. Save the DEM Rule record.

What is the Purpose of the <container> Element in a
Population XSLT File

Out-of-the-box, in the runningsoftware_population.xslt file, there is a container element:
<link direction="incomming" linkType="composition">
<ci class="node">
<container tql="SM Computer Population" keyFields="CIIdentifier">

<1inkTql>SM Computer To Software With Composition</linkTql>

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 100 of 248


http://www.w3schools.com/xsl/

<linkRetrieveCondition>downstreamci.logical.name=&quot;<xsl:value-o
f select="CIIdentifier"/>
&quot;</linkRetrieveCondition>

<linkValueFields>upstreamci.logical.name</linkValueFields>
</container>
</ci>

</link>

¢ In UCMDB, RunningSoftware Cls must exist together with a Root Container (Node), however
Service Manager allows RunningSoftware Cls without a Node.

e The current integration adapter synchronizes Cls and Relationships separately; when populating
a RunningSoftware Cl, the integration has no chance to check if a relationship exists between
the Cl and a Node.

With the <container> element, the integration populates RunningSoftware Cls together with a
container.

Can | Populate Sub-Item Deletions

Yes.

Service Manager and UCMDB store Cl information in different data structures, and therefore one
SM CI may be synchronized to UCMDB as several Cls. For example, during population, an SM
computer Cl record is synchronized to a Node Cl in UCMDB, and the computer CI’s attributes to
Cls such as IP, Interface, Location, etc (which are referred to as sub-items of the Node Cl.). In this
case, the Node Cl is the root Cl.

The integration allows you to populate sub-item deletions to UCMDB (for example, if you delete the
IP Address attribute value of a computer, the corresponding IP Cl record in UCMDB will be deleted
too). To do so, you need to specify a root in the Cl type’s population xslt file, using parameter
isRoot="true". For example, for Computer Cls, the “node” should be specifed as the root.

Out-of-the-box, only the computer_population.xslt file requires the “node” Cl be specified as the
root, as shown below:

<ci class="node" isRoot="true">

What will Happen if a Population Job Fails or Succeeds
with Warnings

When a population job fails:

The failure prevents the remaining population tasks from running. The next job run will start from the
last Success time. If pagination occurs (that is, the tasks are divided into multiple pages), the tasks
will run again and again within the first page from the last “Success” time (once the end of the first
page is reached, no new tasks will be executed).

When a population job succeeds with warnings:
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A warning does not prevent the remaining population tasks from running. The next job run will run all
tasks again starting from the last Success time. If pagination occurs (the tasks are divided into
multiple pages), the tasks on all pages will be re-run (including those that were successfully
completed last time).

Known Issues and Limitations

The following table lists the known issues and limitations of this integration.

Known Issues and Limitations

Global ID

QCCR1E7224
6

QCCR1ET7222
2

Known Issue/Limitation

[Population Adapter] Cannot
populate deleted Cls in a full
population.

While you run a full population, if
there are Cls that have been
deleted since the last job runin
Service Manager, the deleted Cls in
Service Manager will not be
populated to UCMDB.

However, the data push feature first
pushes deleted Cls while running a
full push.

NodeRole is case-sensitive when
mapping Node's NodeRole in
UCMDB to Node's Subtype in SM.

Steps to reproduce this issue:
1. Create aNode in UCMDB.

2. Set the Node's NodeRole
property to "Printer".

3. Runadatapushin UCMDB to
push Node Cls.

4. Check the Cl's attributes in
SM.

Result: The Cl's subtype is
"Node", which should be "Net
Printer".

When the NodeRole is "printer", the
result is correct.

Workaround

In UCMDB, manually delete all Cls that
were populated from SM by using
appropriate filter criteria and then run a
full population.

Warning: You must be very careful
when using this workaround.

Use lower-case names for NodeRole
(printer).
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Known Issues and Limitations, continued

Global ID

QCCR1E7232
7

QCCR1E8436
4

Known Issue/Limitation

When you run a full population for
the first time to synchronize a large
amount of Cls, if some of the Cls
have an invalid attribute value (for
example, IP address), the
population job will ignore such Cls
and run to completion with a Failed
status and with errors logged on the
Job Errors tab; In addition, the last
job execution time will not be
logged because the job is run for the
first time but fails.

As aresult, after fixing the invalid
attribute values in Service
Manager, you will not have a
chance to re-populate the failed Cls
through a change (delta) population.
This is because when you run a
change population, a full population
will be executed instead (because
the last job execution time is null).

When “Run in Multi-Company
Mode” is enabled in the System
Information Record in Service
Manager (SM), the UCMDB
integration fails to create changes
orincidents in SM because the
configuration item data modification
event fails. The following error
occurs:

ERROR TypeError:
lib.uCMDBConfiguration.isEnab
le is not a function at char
1

Workaround

Not available at this time.

To solve this issue, manually update a
JavaScript:

1.

2.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later)

Login to Service Manager as a
system administrator.

Go to Tailoring > Script Library,
and open the discoveryEvent
script.

In this file, replace all instances of
string

lib.uCMDBConfiguration.isEnab
le with

lib.uCMDBConfiguration.isEnab
led.

Note: You can find the string in lines
43, 86 and 405.

Click Compile to make sure the
code is correct, and then click Save.

Log off and log back in.
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Known Issues and Limitations, continued

Global ID Known Issue/Limitation

QCCR1E7251 | If you set the use.global.id

1 parameter in the adapter's
sm.properties file to True, the
federation feature does not work.

QCCR1E7257 The data length of Cl relationship

8 name in Service Manager is 40
characters, which is not sufficient
for the integration. Installing this
content pack does not
automatically increase this data
length in Service Manager.

If a Cl relationship name exceeds
the data length, either the
relationship name is truncated after
push or the relationship cannot be
pushed to Service Manager due to a
duplicate key error.

QCCR1E7300 Double quotes in UCMDB ClI

4 names (for example: "laptop - 003")
are removed when the Cls are
synchronized to SM.

Workaround

Set the parameter to False to solve this
issue.

¢ When you deploy the adapter on the
UCMDB standalone server (which is
defined as a global-id generator by
default), globalld and ucmdbld are the
same thing. For this reason, setting
this parameter to false can meet all of
your needs satisfied by setting the
parameter to true.

¢ When you deploy the adapteron a
non-standalone UCMDB (for
example, BSM's RTSM), setting this
parameter to true is not supported. In
addition, HP does not recommend
integrating the non-standalone CMDB
(for example, BSM's RTSM) with
Service Manager.

Manually increase the data length in
Service Manager:

Open the cirelationship table in Database
Dictionary, and increase the data length
of the relationship.name field from 40 to
an appropriate value (recommended
value: 300).

Not available at this time.
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Chapter 5: Tailoring the Integration

You can tailor the HP Universal CMDB integration to meet your business needs by adding or
removing managed ClI types, attributes, and relationship types. This chapter describes the
integration architecture and tailoring options for data push, population, and federation.

This section includes:

¢ "Integration Architecture" below

¢ "Integration Tailoring Options" on page 118

Integration Architecture

Before you tailor the integration, you should understand how the following components of the out-of-
the-box integration work.

o "Integration Class Model" below

¢ "Integration TQL Queries" below

e "Service Manager Web Services" on page 110

¢ "Service Manager Reconciliation Rules" on page 114

e "Service Manager Discovery Event Manager Rules" on page 116

Integration Class Model

UCMDB 9.x or later no longer uses a private class model of Cl types to manage integration Cls, as
was required in prior versions. Instead, the integration uses the standard UCMDB managed objects
and maps them to Service Manager Cl types and attributes with queries and transformation files.

Integration TQL Queries

This section describes out-of-the-box Topology Query Language (TQL) queries used for data push,
Actual State, and population.

This section includes:

e "TQL Queries for Push" on the next page

e "TQL Queries for Actual State" on page 108
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o "TQL Queries for Population" on page 108

e "TQL Query Requirements" on page 109

TQL Queries for Push

For the push feature, the integration uses a collection of TQL queries to gather Cl attribute
information from Universal CMDB and send it to the Service Manager system.

To access the out-of-the-box data push queries, navigate to Modeling > Modeling Studio, select
Queries for Resource Type, and then navigate to the Root > Integration > SM Sync > 9.xx folder.

If you want to change what Cl/Relationship types or attributes are part of the integration, you must
also edit the integration queries to support your updated C1/Cl Relationship types and attributes.

Out-of-the-box TQL queries for data push

Query
name Description
SM This query gathers Cl attributes from Running Software Cls.
Running
Software
Push
SM This query gathers Cl attributes from business service Cls.
Business
Service
Push
SM This query gathers relationships between the following components:
Business
Service o Business service and Running Software Cls
Relations
Push e Business service and node Cls
e Two or more business services
The query includes compound relationships because the relationships can extend
through a group.
SM This query gathers Cl attributes from the node CI type with NodeRole containing
Computer  ‘desktop”, “server”, “virtualized_system” or not set.
Push

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Switch = This query gathers ClI attributes from the node CI type with NodeRole containing
Push “atm_switch”, “frame_relay_switch”, or “lan_switch”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.
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Out-of-the-box TQL queries for data push, continued

Query
name

SM
Storage
Push

SM Net
Printer
Push

SM
Mainframe
Push

SM Mobile
Device
Push

SM
Network
Component
Push

SM Cluster
Push

SM Node
Relations
Push

Description

This query gathers ClI attributes from the node CI type with NodeRole containing
“san_switch”, “san_gateway”, “san_router” or exact Cl type equal to “storage

Array”.

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers Cl attributes from the node CI type with NodeRole containing
“printer”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers ClI attributes from the node CI type with exact Cl type equal to
“Mainframe Logical Partition”, or “Mainframe CPC”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers ClI attributes from the node CI type with NodeRole containing
“pda_handheld”.

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers Cl attributes from the node CI type with NodeRole containing

o LLIT] HT o

“router”, “adsl_modem”, “appletalk_gateway”, “bandwith_manager”, “cable_model”,

LY

“csu_dsu”, “ethernet”, “fddi”, “firewall”, “hub”, “kvm_switch”, “load_balancer”,

“multicast_enabled_router”, “nat_router”, “token_ring”, “undefined_network_

component”,

voice_gateway”, “voice_switch”’, or “vpn_gateway”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers ClI attributes from the node CI type with exact Cl type equal to
“ClusterResourceGroup”.

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, Location, and
Cluster.

This query gathers relationships between the following components:

e Node and Printer Cls
¢ Node and RunningSoftware Cls

The root class of the relationship is composition.
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Out-of-the-box TQL queries for data push, continued

Query
name

SM CRG
Relations
Push

SM Layer2
Topology
Relations
Push

SM Local
Printer
Push

Description

This query gathers relationships between the following components: Node and
Cluster Resource Group Cls.

The query includes compound relationships because the relationships can extend
through a group.

This query gathers relationships between the following components: Two or more
nodes.

The query includes compound relationships because the relationships can extend
through a group.

This query gathers Cl attributes from printer Cls.
It also gathers related Cl attributes from the Node Cl type.

TQL Queries for Actual State

Out-of-the-box, the following TQL queries (see the table below) are used for retrieving Cl
information from UCMDB to the Actual State section of the Service Manager Configuration Item
(CI) form. Service Manager retrieves Cl Actual State information by callinga UCMDB web service
that retrieves Cl data according to these queries.

The queries are located in the Integration > SM Query folder in the UCMDB Modeling Studio.

Out-of-the-box TQL queries for Actual State

Query name Description

localPrinterExtendedData This query gathers real-time extended information from Printer
Clsin UCMDB.

applicationExtendedData This query gathers real-time extended information from

RunningSoftware Cls in UCMDB.

businessServiceExtendedData = This query gathers real-time extended information from

business service Cls in UCMDB.

hostExtendedData This query gathers real-time extended information (such as

Asset, Party, Location, LogicalVolume, WindowsService,
Printer, InstalledSoftware, FileSystem, IPAddress, Interface,
DiskDevice, and Cpu) from the node Cl type in UCMDB.

TQL Queries for Population

For CI/CI Relationship population, the integration does not need TQL queries to save CI/CI

Relationship attribute information to Universal CMDB; however in the population configuration file
the following TQL query names are mapped to relevant population XSL transformation files (see the
following table).
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TQL queries for population

Query name

SM Business Service
Population

SM Computer To
Computer With
ConnectM Running
Software Population

SM Computer Population

SM Biz To Biz With
Containment

SM Biz To Biz With
Usage

SM Biz To Computer
With Containment

SM Biz To Computer
With Usage

SM Biz To Software With
Containment

SM Biz To Software With
Usage

SM Computer To
Computer With Connects

SM Computer To
Software With
Composition

CLIP Down Time
Population

Cl ToDown Time Cl With
Connection

Description

This query defines the Cl store structure of business service Cls.

This query defines the Cl store structure of running software Cls.

This query defines the Cl store structure of computer Cls.

This query defines the Cl store structure of Cl relationships in which
a bizservice Cl contains another.

This query defines the Cl store structure of Cl relationships in which
abizservice Cl uses another.

This query defines the Cl store structure of Cl relationships in which
a bizservice Cl contains a computer CI.

This query defines the Cl store structure of Cl relationships in which
abizservice Cl uses a computer Cl.

This query defines Cl store structure of Cl relationships in which a
bizservice Cl contains a RunningSoftware ClI.

This query defines Cl store structure of Cl relationships in which a
bizservice Cl uses a RunningSoftware ClI.

This query defines the Cl store structure of Cl relationships in which
a computer Cl connects to another.

This query defines the Cl store structure of Cl relationships in which
a RunningSoftware Cl is contained within a computer Cl and the
RunningSoftware Cl cannot exist without the container.

This query defines the Cl store structure of ScheduledDowntime
Cls.

This query defines the Cl store structure of Cl relationships in which
a ScheduledDowntime CI connects to an affected CI.

TQL Query Requirements

The integration requires that any custom TQL queries you create meet certain formatting
conditions. Any TQL queries that you want to include in the integration must meet these conditions:

e Toquery Cls, a query must contain one Cl type labeled Root. The Root node is the main Cl that
the UCMDB synchronizes. All other Cls are contained Cls of the Root ClI.

e Toquery relations, a query must contain one or more relationships labeled Root.
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¢ A query must contain only the Root Cl and Cls that are directly connected to it. The Root Cl is
always the top node of the TQL hierarchy.

e A TQL graph cannot have cycles.

e If aquery synchronizing relationships has cardinality, it must be cardinality 1...*. Additional
cardinality entries must have an OR condition between them.

¢ If you only want the integration to synchronize specific Cls, you must configure the condition on
the TQL query to filter such Cls.

Service Manager Web Services

Service Manager uses web services messages to get and receive Cl information from your
UCMDB system. Out-of-the-box, UCMDB sends more CI attribute information than the Service
Manager system actually manages. Service Manager users can view all of the Cl attribute
information the UCMDB system sends from the Actual State section of the Cl record.

Service Manager publishes several web services for use by the UCMDB-SM integration. The
UCMDB system uses the web services to map UCMDB CI types and Cl attributes to web services
objects the Service Manager system recognizes. If you add UCMDB ClI types or Cl attributes that
you want Service Manager to manage, then you must update one or more of these web services to
define them as web services objects. See the Service Manager Web Services Guide for more
information about publishing web services.

Managed Fields

Note: Managed fields are used only for the data push feature.

A Service Manager managed field is a field where the system compares the Cl attribute value in the
incoming UCMDB web services message to the value in a Service Manager Cl record. If the values
in the web services message do not match those in the Cl record, Service Manager runs a
Discovery Event Manager (DEM) rule to determine what action to take. The DEM rule determines
which of the fields that are published as web services objects are fields managed by the integration.
Only value changes in managed fields trigger the DEM rule.

Service Manager stores the list of managed fields in the ucmdblintegration web service. The
ucmdblntegration web service consists of a set of web services objects. Out-of-the-box, the
integration uses only part of them (see the Mappings between Service Manager web service
objects, tables, and DEM rules table), some of them (along with their relevant DEM Rules) have
been deprecated (see the Deprecated ucmdblintegration web service objects for data push table),
and some are used for population or federation (see the ucmdblintegration web service objects used
for population or federation table).

Mappings between Service Manager web service objects, tables, and DEM rules

This web service object Publishes fields from this table = And uses this DEM rule ID

Relationship cirelationship ucmdbRelationship
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Mappings between Service Manager web service objects, tables, and DEM rules, continued

This web service object Publishes fields from this table = And uses this DEM rule ID

ucmdbRunningSoftware device ucmdbRunningSoftware
ucmdbBusinessService joinbizservice ucmdbBusinessService
ucmdbNode joinnode ucmdbNode

Deprecated ucmdblintegration web service objects for data push

This web service Publishes fields from this Recommended replacement
object table (object)

ucmdbApplication device ucmdbRunningSoftware
ucmdbComputer ucmdbComputer ucmdbNode

UcmdbDevice device ucmdbRunningSoftware
ucmdbNetwork joinnetworkcomponents ucmdbNode

ucmdbPrinter joinofficeelectronics ucmdbNode

ucmdblintegration web service objects used for population or federation

This web service Publishes fields from this  And is used Requires a DEM
object table for Rule?
cirelationship1to1 cirelationship1to1 Population No
ucmdblDPushBack device Population No
UcmdbChange cm3r Federation No
UcmdbChangeTask cm3t Federation No
Ucmdblincident probsummary Federation No
UcmdbProblem rootcause Federation No

The following sections list the fields published as web services objects used for data push (see the
Mappings between Service Manager web service objects, tables, and DEM rules table) and
indicate whether they are managed fields in an out-of-the-box Service Manager system. You can
use this reference to determine if you need to publish a field as a web service object, and also if you
need to create a DEM rule for the object.

Object Name: Relationship

Service Manager publishes the following fields from the cirelationship table:
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Web service and managed fields of the Relationship object

Field published as web Caption used in web service Is the field a managed
service object messages field?
relationship.name RelationshipName

logical.name ParentCl

related.cis ChildCls Yes
relationship.subtype RelationshipSubtype

Object Name: ucmdbRunningSoftware

Service Manager publishes the following fields from the device table:

Web service and managed fields of the ucmdbRunningSoftware object

Field published as web Caption used in web service Is the field a managed
service object messages field?
ucmdb.id UCMDBId

ci.name ApplicationName Yes
type Type

subtype Subtype

company Companyld

logical.name Clldentifier Yes
product.version ProductVersion

vendor Vendor

version Version

id’ CIName

Object Name: ucmdbBusinessService

Service Manager publishes the following fields from the joinbizservice table:

Web service and managed fields of the ucmdbBusinessService object

Field published as web Caption used in web service Is the field a managed
service object messages field?

ucmdb.id UCMDBId

ci.name ServiceName Yes

1This attribute is used only for the population feature.
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Web service and managed fields of the ucmdbBusinessService object, continued

Field published as web Caption used in web service Is the field a managed
service object messages field?

type Type

subtype Subtype

company Customerld

logical.name Clldentifier Yes

vendor ServiceProvider

id’ CIName

Object Name: ucmdbNode

Service Manager publishes the following fields from the joinnode table:

Web service and managed fields of the ucmdbNode object

Field published as web Caption used in web service Is the field a managed
service object messages field?
ucmdb.id UCMDBId

type Type

subtype Subtype

company Customerld

logical.name Clldentifier Yes
default.gateway DefaultGateway Yes
network.name DNSName Yes
building Building Yes
room Room Yes
floor Floor Yes
location Location

addlIPAddr{addIIPAddress] AddlIPAddress Yes
addlIPAddr[addISubnet] AddISubnet Yes
addIMacAddress AddIMacAddress Yes
bios.id BIOSId Yes

1This attribute is used only for the population feature.
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Web service and managed fields of the ucmdbNode object, continued

Field published as web Caption used in web service Is the field a managed
service object messages field?
operating.system oS Yes
os.version OSVersion Yes
physical.mem.total PhysicalMemory

serial.no. SerialNo

vendor Vendor

cpulcpu.id] CpulD

cpu[cpu.name] CpuName

cpu[cpu.clock.speed] CpuClockSpeed

file.system[mount.point] MountPoint

file.system[disk.type] DiskType

file.system([file.system.type]
file.system[disk.size]
asset.tag

machine.name
disk.device[model.name]
disk.device[disk.vendor]
disk.device[disk.name]

id’

isVisualization

istatus

Service Manager Reconciliation Rules

FilesystemType
DiskSize
AssetTag
HostName
ModelName
DiskVendor
DiskName
CIName
IsVisualization

AssetStatus

Service Manager reconciliation rules allow the integration to identify Cl records in your Service
Manager system that match Cls in your UCMDB system. Service Manager attempts to reconcile
Cl records with every push of Cl attributes from your UCMDB system. The integration uses the

following workflow to match UCMDB Cls with Service Manager Cls.

1This attribute is used only for the population feature.
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1. The UCMDB system sends a web service message to Service Manager containing the latest
Cl attribute data.

2. Service Manager scans the web service message for the Cl ucmdb.id value.

Note: Out-of-the-box, Service Manager does not display the ucmdb.id field on CI record
forms to prevent users from changing the value. If you want to add this value to your
forms, you can find the ucmdb.id field defined in the device table. HP recommends that
you make this a read-only field.

3. Service Manager searches for an existing Cl record that has the same ucmdb.id value.

4. If Service Manager finds a Cl with a matching ucmdb.id value, no reconciliation is needed.
Service Manager compares the UCMDB Cl attributes to the Service Manager managed fields
and runs the appropriate Discovery Event Manager (DEM) rules as needed.

5. If Service Manager cannot find a Cl with a matching ucmdb.id value, it runs the reconciliation
rules.

6. Service Manager searches for an existing Cl record with the same reconciliation field values.

7. If Service Manager finds a Cl with a matching reconciliation field value, it updates the CI record
with the ucmdb.id value of matching UCMDB CI. Service Manager compares the UCMDB ClI
attributes to the Service Manager managed fields and runs the appropriate DEM rule as
needed.

8. If Service Manager cannot find a Cl with a matching reconciliation field value, it runs the DEM
rule for “Action if matching record does not exist.” Out-of-the-box, the DEM rule has Service
Manager create a new Cl record. Service Manager creates the Cl record using the ucmdb.id
value of incoming UCMDB CI.

Performance Implications

Because Service Manager attempts to reconcile Cls with every push, the number of reconciliation
fields you have will affect the integration’s performance. The more reconciliation rules you have, the
more searches Service Manager must perform to match Cls. To improve the performance of
reconciliation searches, you should choose reconciliation fields that are unique keys of the
underlying Service Manager table. For example, if you want to reconcile Cl records in the device
table, use the logical.name field as a reconciliation field because it is a unique key. See "How to
Add DEM Reconciliation Rules" on page 123 to create a reconciliation rule.

Dependence on DEM Rules

Service Manager uses the “Action if matching record does not exist” DEM rule whenever it cannot
reconcile Cls. You should review the DEM settings and decide if they meet your business
standards prior to the initial push of Cls from UCMDB to Service Manager. For example, you can
have Service Manager create a change request for every Cl in the initial Cl push by selecting the
“Open a change” option.
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Service Manager Discovery Event Manager Rules

You only need to create Discovery Event Manager (DEM) rules if you want to accomplish any of the
following custom actions:

¢ "Change the Conditions Under Which a DEM Rule Runs" below
e "Change the Action the DEM Rule Takes" below
e "Update the List of Managed Fields for a Cl Type" on the next page

e "Create Custom JavaScript to Open Change or Incident Records" on the next page

Change the Conditions Under Which a DEM Rule Runs

Service Manager will run a DEM rule only if the condition field evaluates to true. Out-of-the-box, no
DEM rule has a condition statement that restricts when the rule runs, and all the integration DEM
rules will always run by default.

You can update a DEM rule's condition statements if you want to restrict when Service Manager
runs your DEM rules. For example, adding the following condition to the ucmdbNode DEM rule
restricts the rule to desktop Cls.

subtype in $L.file="Desktop”

You can also use the condition field to create multiple DEM rules that apply to the same table name.
For example, the following DEM rules both apply to the joinnode table.

DEM rules using different conditions to affect the same table

DEM rule Id Table Name Condition
ucmdbNode joinnode subtype in $L.file!="Desktop”
ucmdbDesktop joinnode subtype in $L.file="Desktop”

Typically, you will only need to add conditions if your business processes require the integration to
take different actions with certain Cl types or SLAs.

Change the Action the DEM Rule Takes
Out-of-the-box, the integration DEM rules take the following actions:

e Add a Cl record when the UCMDB data does not match an existing Service Manager Cl record

e Open a Change or log results and update a Cl record when the UCMDB CI attribute data does
not match the Cl attribute data in the Service Manager Cl record

e Delete a Cl record when the UCMDB data specifies that the Cl has been deleted
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You can change the integration DEM rules to meet your business processes. For example, you
could use the ucmdbNode DEM rule to open a change when the integration finds a non-desktop Cl
with unexpected data, and use the ucmdbDesktop DEM rule to log results and update the record
when the integration finds a desktop CI with unexpected data.

Caution: If you want to use the Change Management verification and Change Management
validation features of the integration, your DEM rules must use the Open a Change option for
the “Action if record exists but unexpected data discovered” event.

Update the List of Managed Fields for a Cl Type

If you add CI attributes to your UCMDB system that you want to include in the integration, you
must also create matching managed fields in Service Manager. Each managed field must have a
corresponding web services object definition in order to receive Cl attribute updates from your
UCMDB system. See "How to Add a CI Attribute to the Integration for Data Push" on page 129 and
"How to Add a CI Type to the Integration for Data Push" on page 142 for information on how to add
managed fields.

Create Custom JavaScript to Open Change or Incident
Records

Service Manager uses the discoveryEvent JavaScript to create Cl names and to set the values of
required fields when opening change or incident records. Out-of-the-box, the script uses the
following default values.

Default values to create a new ClI

You can update the createCIName and populateNewClI functions to set the following Cl values.

Default values used to create a new ClI

Cl attribute Default value defined in discoveryEvent
record.logical_name System generated ID number
record.assignment AUTO

record.istatus Installed

record.os_name Value in record.operating_system

Default values to create a new change

You can update the populateChange function to set the following change values.
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Default values used to create a new change

Cl attribute Default value defined in discoveryEvent
change.category Unplanned Change

change.reason Value in reason

change.initial_impact 3

change.severity 3

change.coordinator Change.Coordinator

change.requested by discovery

change.status initial

Default values to create a new incident

You can update the populatelncident function to set the following incident values.

Default values used to create a new incident

Cl attribute Default value defined in discoveryEvent
incident.category incident
incident.subcategory hardware
incident.product_type missing or stolen
incident.assignment Hardware
incident.initial_impact 3

incident.severity 3

incident.logical.name Value of id
incident.site_cateogry C
incident.contact_name ANALYST, INCIDENT
incident.affected item MyDevices

Integration Tailoring Options

The integration offers the following tailoring options:

e "How to Update the Integration Adapter Configuration File (sm.properties)" on the next page

¢ "How to Add DEM Reconciliation Rules" on page 123
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e "Add Discovery Event Manager Rules" on page 125

e "How to Add a Cl Attribute to the Integration for Data Push" on page 129

e "How to Add a Cl Type to the Integration for Data Push" on page 142

e "How to Add a Cl Type’s Relationship Types to the Integration for Data Push" on page 164
¢ "How to Add Custom TQL Queries to Data Push Jobs" on page 170

e "How to Add a CI Attribute to the Integration for Population™ on page 170

e "How to Add a Cl Type to the Integration for Population" on page 174

e "How to Add a Cl Type’s Relationship Types to the Integration for Population™ on page 189
e "How to Customize UCMDB ID Pushback fora Cl Type" on page 193

e "How to Add Custom TQL Queries to Integration Population Jobs" on page 195

e "How to Add an Attribute of a Supported CI Type for Federation" on page 196

How to Update the Integration Adapter Configuration
File (sm.properties)

The integration uses a properties file (sm.properties) as a configuration file of the adapter. Out-of-
the-box, this file has been set up based on best practices, so usually you can keep the default
parameter values. Optionally, you can update the parameter values to better suit your needs.

To update the sm.properties file:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the properties configuration file: sm.properties.

4. Update the parameter values as needed. For a list of the parameters, see the following table.
Parameters in the sm.properties file

Parameter Default value Comment

timeout.minutes 10 The integration connection
timeout value (in minutes).
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Parameters in the sm.properties file, continued

Parameter Default value Comment
number.of.concurent.sending.threads = 6 The number of concurrent
threads used for the data push
feature.
= 1: Disabled

= 2 or higher: Enabled

Note: If you are
connecting to multiple
Service Manager
instances to improve the
CI data push performance
(see the URL Override
configuration in "How to
Create an Integration
Pointin UCMDB" on page
29), you are
recommended to increase
this value for optimized
performance. For
example, set it to 12 if you
are connecting to two
Service Manager
instances.

min.objects.for.concurent.sending 50 The minimum number of
Service Manager objects that
is required to use concurrent
sending instead of single
thread sending.

Note: It is used for the
push feature.

number.of.chunks.per.thread 3 The number of chunks per
thread used for the push
feature.

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 120 of 248



Parameters in the sm.properties file, continued

Parameter Default value
number.of.cis.per.request 1000
use.global.id false
type.of.expand.enum 2

Comment

The maximum number of
objects retrieved from Service
Manager by ID.

Note: It is used for the
population and federation
features. Do not set it to
a number greater than
1000 in case the request
has a 64K limit.

If set to true, globalld instead
of ucmdbld is used in the
integration. For more
information about the
differences between UcmdbID
and GloballD, see the
UCMDB documentation.

It configures the value
mapping rule for the UCMDB
enum type.

m 0: The feature will be
disabled

= 1: The enum type will
expand to “{value}”’

= 2: The enum type will
expand to “{index}-{value}”

Note: It is used for the
push feature.
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Parameters in the sm.properties file, continued

Parameter

use.type.label

op.pagination.switch

pop.pagination.recordcount

pop.createci.key

Default value

true

on

1000

sm_id

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later)

Comment

It configures whether the
generated source XML uses
the real Cl/Relationship type
directly or uses the label that
is defined in the TQL.

If set to false, the real type is
used directly instead of the
label.

It indicates if pagination (client
driven) is enabled.

= on: Enabled.

= off: Disabled.

Note: It is used for the
population feature.

The maximum number of
records displayed on each
page when pagination is
enabled.

Note: It is used for the
population feature.

The UCMDB field of a Cl
record that stores the Service
Manager CI ID.

Note: It is used for the
population feature.
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Parameters in the sm.properties file, continued

Parameter Default value Comment

ucmdbid.pushback.request UpdateucmdblID The web service request for
PushBackRequest = pushing the UCMDB ID back
to Service Manager.

Note: It is used for the
population feature.

ucmdbid.pushback.xslt ucmdbid_ The xslt configuration file for
pushback.xslt pushing the UCMDB ID back
to Service Manager.

Note: It is used for the
population feature.

check.sm.connections false It indicates whehter to check
the SOAP connections to
Service Manager instances
before running a job.

You can enable it under any of
the following circumstances:

= Your Service Manager is
running in High Availability
mode (with load balancing),
and you want to connect
UCMDB to multiple Service
Manager instances.

= Youwant UCMDB to not
run a job when no
integration connections are
available, rather than run
the job and then report a
failure.

How to Add DEM Reconciliation Rules

It is possible that your Service Manager system already contains Cl records that match Cls in your
UCMDB system. Rather than add duplicate CI records to your Service Manager system, you can
configure Service Manager to reconcile Cl records between the two systems based on the values
of specific fields.

Service Manager always attempts to reconcile Cl records based on the unique key field of the
Service Manager table and the ucmdb.id field. You can specify additional fields to reconcile on
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from the DEM Reconciliation Rules form. If Service Manager finds a matching value in any one of
these fields, it updates the Service Manager Cl record with the attributes from the incoming
UCMDB record.

When multi-tenancy is enabled, Service Manager only reconciles the Cls whose company ID
matches the company ID in the data push job. For example, when pushing Cls from company 2, the
reconciliation rules only apply to the Service Manager Cl records that have the company code
corresponding to company number 2.

In order to specify reconciliation fields, you will need to be familiar with the table and field names in
both your Service Manager and UCMDB systems. If you want to reconcile on a particular attribute
from the UCMDB system, you should verify that there is a corresponding Service Manager
managed field for the attribute. Without such a mapping, Service Manager will not know to search
for matching values in the ClI record.

Note: Not all UCMDB attributes have a corresponding field in Service Manager. You may need
to tailor your Service Manager system to add a matching field if one does not already exist.

Using join tables for reconciliation

When setting reconciliation rules, if the device type you are reconciling has a joindef definition (as
defined in the devtype table), use the join table name instead of the device table. For example, if
you want to reconcile computer Cls, use the joincomputer table instead of the device table.

Sequence of reconciliation

A reconciliation rule specifies what Service Manager table and field you want to search for matching
Cl values. It also specifies the sequence in which you want Service Manager to process
reconciliation rules. By default, Service Manager processes rules in alphabetical order by field
name. For example, Service Manager will reconcile Cls against the asset.tag field before
reconciling Cls on the ci.name field.

To change the order in which Service Manager reconciles Cls, you can add a numeric value to the
sequence field. For example, the following reconciliation rules ensure that Service Manager
processes Cls by the ci.name field prior to reconciling them against the asset.tag field.

Sample reconciliation rules ordered by sequence

Table Name Field Name Sequence
joincomputer ci.name 1
joincomputer asset.tag 2

A Discovery Event Manager (DEM) reconciliation rule allows you to specify which Service Manager
fields you want to use to determine if an existing Cl record matches a Cl ina UCMDB system. An
administrator typically specifies reconciliation rules prior to starting UCMDB data push jobs so that
Service Manager will not create duplicate Cl records.

To create a DEM reconciliation rule:
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1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > DEM Reconciliation Rules. Service Manager
displays the DEM Reconcile Record form.

3. InTable Name, type the name of the Service Manager table containing the field you want to
reconcile on.

4. InField Name, type the name of the Service Manager field containing the values you want to
reconcile on.

5. In Sequence, type a number to specify what order you want Service Manager to run this rule.

Note: If you do not specify a sequence value, Service Manager will process field names
alphabetically.

6. Click New. Service Manager creates the reconciliation rule.

Add Discovery Event Manager Rules

Service Manager uses the Discovery Event Manager (DEM) to define which actions the system
should perform when the actual state of an incoming configuration item (CI) record differs from the
managed state of a Cl record in HP Service Manager. The DEM rules allow you to define whether

the Service Manager system adds, updates, or deletes Cl records based on incoming UCMDB
data.

For Cl records only, the DEM rules also allow you to define how Service Manager should handle
duplicated logical names.

This section includes:

e "DEM Rules" below
e "Duplication Rules" on page 128
e "CI Attributes Displayed in Change and Incident Records" on page 129

e "Searching for Change and Incident Records Opened by the Integration" on page 129

DEM Rules

Service Manager offers the following rules options:

Action if matching record does not exist

This is the action you want Service Manager to take if it cannot find a matching ClI record.
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e Add the record:(Default) Service Manager will add a Cl record when it cannot find a matching
record. See "How to Add DEM Reconciliation Rules" on page 123 to define what fields Service
Manager uses to match Cl records.

e Add the record, and set dependency as true: This option is available only for synchronization
of Cl relationship data. Service Manager adds the CI relationship record and enables outage
dependency for the record by doing the following:
= Checks the Outage Dependency check box;

= Sets the number of dependent downstream Cls to 1. This is because UCMDB only supports
one-to-one Cl relationships.

Configuration Item Relationship

Upstrearm CI: |'E—mai| /wwebmail (Europe) | i |Q |
Relationship Name: E-mail / Wabrmail (Europe’ Service
Relationship Type: Contains |v | =
Dowmnstrearn Cls: adv-eur-server-rmail

Microsoft Outlook

Outage Dependency

Outage Dependency

This Configuration Item will be considered down if

= or more of the supporting configuration items are down

e Open an Incident:Service Manager opens an incident for someone to review the new ClI record.
The incident enables someone to investigate whether the new CI record is compliant with your
business practices.

¢ Open a Change:Service Manager opens an unplanned change for someone to review the new
Cl record. The change allows you to investigate whether the new CI record is compliant with
your business practices. If the Cl record is compliant, the change can be approved. If the Cl

record is not compliant, then the change can be denied and the CI record removed. The change
record lists both the current and proposed attribute values.

Action if record exists but unexpected data discovered

This is the action you want Service Manager to perform if it does not find a matching Cl attribute
value.

¢ Open a Change: (Default) Service Manager opens an unplanned change to review the actual
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state of the Cl record. The change allows someone to investigate whether the new attribute
value is compliant with your business practices. If the value is compliant, the change can be
approved. If the value is not compliant, then the change can be denied and the CI attribute value
reverted to its managed state.

¢ Log Results and update record:Service Manager logs the results of the actual state of the Cl
record, and then updates the ClI record.

e Open an Incident:Service Manager opens an Incident to investigate the actual state of a Cl
record and determines what actions must be performed or initiated to bring the record into
compliance with Service Manager.

Action if record is to be deleted

This is the action you want Service Manager to perform if an external event specifies that the record
needs to be deleted.

o Delete record: (Default for Cl Relationship records) This option is available for synchronization
of both Cl and CI Relationship records. Service Manager automatically deletes the CI/ClI
Relationship record.

¢ Open an Incident: This option is available only for synchronization of Cl Relationship records.
Service Manager opens an incident to investigate the deleted record and determines which
actions must be performed or initiated to bring the record into compliance with Service Manager.

e Open a Change: This option is available only for synchronization of Cl Relationship records.
Service Manager opens an unplanned change to review the deleted record. The change allows
someone to investigate whether the deleted record is compliant with your business practices. If
the record is compliant, the change can be approved. If the record is not compliant, then the
change can be denied and the record added back to the system.

o Update record to the selected status: (Default for Cl records) This option is available only for
synchronization of Cl records. Service Manager updates the status of the Cl record to a value
selected from the drop-down list (for example, Retired/Consumed), rather than delete the
record permanently.

Note: Values available from the drop-down list are defined in the ICM Status global list.

e Open a Change to update record to the selected status: This option is available only for
synchronization of Cl records. Service Manager opens an unplanned change to update the ClI
record’s status to a value selected from the drop-down list (for example, Retired/Consumed).
The change allows someone to investigate whether the requested status change is compliant
with your business practices. Once the change has been approved and closed, Service Manager
automatically changes the Cl record to the selected status. If the change has been denied,
Service Manager makes no changes to the Cl record.

e Open an Incident to update record to the selected status: This option is available only for

synchronization of Cl records. Service Manager opens an incident to update the record’s status
to a value selected from the drop-down list (for example, Retired/Consumed). Once the
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incident has been closed, Service Manager automatically updates the ClI record to the selected
status.

Duplication Rules

UCMDB may create two completely separate yet legit Cl records that happen to have the same
“name”. The UCMDB name field is mapped to the logical.name field (which must be unique) in
Service Manager. Pushing the two Cl records to Service Manager would cause a duplicate logical
name problem. You have several ways to avoid this problem. See the following table.

Solutions to the duplicate logical name problem

Product
side Solution

UCMDB @ Change the names directly in UCMDB or change the UCMDB reconciliation rule to
make sure the names are not the same.

This is highly recommended.

In the integration adapter mapping configuration (xslt) file, avoid mapping the UCMDB
name field to the SM logical name field directly in either of these ways:

¢ Map another UCMDB unique attribute to the SM logical.name field, and map the
UCMDB name field to another SM field;

¢ Add a prefix to the name. The following are examples.
= UCMDB switches or routers are simply named as “Router” or “Switch” and
identified by their underlying MACs. You can configure their “SM logical name”
to be “<MAC> + <name>".

= UCMDB databases often have the same name (due to the implementation of
clusters and Oracle RACs). You can configure their “SM logic name” to be “<full
DNS name> + <name>".

Service = Use the duplication rule options in DEM Rules in Service Manager.
Manager

Service Manager offers the following duplication rule options on the Duplication Rule tab in each
DEM rule with a Table Name other than “cirelationship”:

o Action if logical name is duplicated (Cl with different uCMDB ID): This is the action you
want Service Manager to perform if the logical name is already used by another Cl record when a
Cl record is added or updated.
= Rename to <name>_[RENAMED]_1/2/3: (Default) Service Manager changes the logical

name by adding a suffix.

= Return Error: Service Manager returns a duplicate key error to UCMDB.
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Cl Attributes Displayed in Change and Incident Records

Service Manager displays a Change Details section on the corresponding change ora CMDB
Changes section on the corresponding incident when you configure DEM to open either change
records or incident records when it discovers ClI attribute changes through the UCMDB-SM
integration. Service Manager only displays a tab for Cl attributes when the UCMDB-SM integration
is enabled and you have defined a rule in the Discovery Event Manager to create a change or
incident record when a Cl is added, updated, or deleted.

Both the Change Details and CMDB Changes sections display the current CI attribute values
alongside the actual attribute values discovered by UCMDB. You can use this information to
approve or deny a change or escalate an incident to the proper assignment group.

Searching for Change and Incident Records Opened by
the Integration

You can use the following search criteria to find change and incident records opened by the
UCMDB-SM integration.

Search options available for change and incident records

Record type Search option available
Change Search for records with the category unplanned change,

Incident Search for records using the generated by the UCMDB integration option.

How to Add a Cl Attribute to the Integration for Data
Push

You can use the following steps to add a Cl attribute to the integration.

1. Does the ClI attribute already exist in the UCMDB class model?
Yes. Goto Step 3.

No. Go to Step 2.

2. Addthe ClI attribute to the UCMDB class model.
See "How to Add the CI Attribute to the UCMDB Class Model" on the next page.

3. Add the ClI attribute to the TQL layout.
See "How to Add the CI Attribute to the TQL Layout" on page 131.

4. Add the Cl attribute to the Service Manager table.
See "How to Add the CI Attribute to the Service Manager Table" on page 132.

5. Create aweb service field to support the Cl attribute.
See "How to Create a Web Service Field to Support the Cl Attribute" on page 134.
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6. Add a managed field to monitor changes in the Cl attribute.

See "How to Add a Managed Field to Support the CI Attribute" on page 135.

7. Map the ClI attribute to a web service field.
See "How to Map the CI Attribute to a Web Service Field" on page 137.

How to Add the CI Attribute to the UCMDB Class Model

The integration only uses a subset of the Cl attributes available from your UCMDB system. Out-of-

the-box, the integration consists of Cl attributes that are typically managed from a Service Manager
system such as host name and host DNS name. Before creating a new UCMDB ClI attribute, you
should determine if there are any existing Cl attributes in your UCMDB system that provide the

data you want. In most cases, there is an existing attribute tracking the data you want to add to the

integration. For example, if you review the attributes of the Node ClI type, you see that there are

many attributes available to be added to the integration.

Cl Types Dependencies | Details || Attributes | Qualifiers
@ Ej ¢'_j = Thiz page enables you to edit the attributes of the Cltype.
£ Managed Chject (818) -
—[®@] ActivityLog (0) + & (D RNIY
(@] asset (@)
_ sitachment (0) = Display Name | Mame Type Description | Default Walue Visible Editable
_ Budget (0) ack_cleared_time ack_cleared_time lorig W
— BudgetLine (0) ack_id ack_id string L4
— Busziness Ohjective (0) = Actual Delete Time root_actualdelstetime | date When willt...
B-E Configurationftem (318) Actusl Deletion Period  root_sctusldeletionp...  integer What isthe... 40 v v
) BHSi”eSS_EIBmem 103y Admin State data_adminstate adminstate...  Admin State | Managed
E?:!teritgzrfélemem 13) g Allow Cl Update data_allow_auto_dis...  boolean true v v
Application Resource (0 BiosAssetTag bios_aszet_tag string Azzettagn... W v
ApplicationSystem (0) EBiosSerialMumber bios_serial_number string A manufact... v v
Communication Endpoint (0) Bios Uuid bios_uwid string A System ... v v
': Datacenter Resource (0) BODY_ICON BODY_ICON string host v
Metwork Ertity (16) Calculated 1D calculated_id bytes Calculated ... v
& Mode (595) Calculated Location calculated _location string v v
Made Element (1) Candidate For Deleti... | root_candidatefordel... | date When willt..
ELE::::I;|IIE:;;:?;’E)@ Change Corr State data_changecorrstate  changestat...  Change 5t..  No Change
_'C:' Location (0} ) Change Iz New data_changeiznew boolean Change St... false
[]_ Monitor (0} Change State data_changestate changestat...  Change 5t..  No Change
B Party @) - 4 i

The following steps illustrate how to add a new ClI attribute to an existing Cl type. This scenario is
not the expected typical case. Typically, you would add an existing Cl attribute to the integration.

Note: The integration does not require any special steps to add a Cl attribute to the UCMDB
class model. You can use the standard ClI attribute creation procedures to add a Cl attribute.
For more information on Cl attribute creation, see the HP Universal CMDB CI Attribute

Customization Guide.

To add a ClI attribute to the UCMDB class model:
1. Loginto UCMDB as an administrator.

2. Navigate to Modeling > Cl Type Manager.
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10.

1.

12.

13.

Select the Cl type to which you want to add a new ClI attribute from the CI Types navigation
tree. For example, Configurationltem > InfrastructureElement > RunningSoftware >
Database.

Click the Attributes tab.

Click the Add button. ¥
The Add Attribute window opens.

In Attribute Name, type the unique name you want to use for the new Cl attribute. For example,
database owner.

Caution: The name cannot include any of the following characters: * / \ [ ] : | <
> 9 =p8 , P %

In Display Name, type the name you want UCMDB to display in the interface. For example,

Database Owner.

In Description, type a description of the new CI attribute. This is an optional field. For example,
System user who owns the database.

In Attribute Type, select either Primitive or Enumeration/List. For example, select Primitive
and select string.

In Value Size, type the maximum character length the attribute can have. For example, 300.

In Default Value, type the value to be used when no other value is available. For example,
leave the default value blank.

Click OK to save the attribute.

Click the Save button to save attribute changes to the Cl type.

How to Add the CI Attribute to the TQL Layout

To add a Cl attribute to the integration, you must add this attribute to the layout setting from the TQL
query that synchronizes the Cl type. You must know what Cl type contains the Cl attributes you
want to add to the integration.

Keep a list of the attributes that you enable, because you will need to create a matching XSL
transformation for each attribute you enable.

To add a Cl attribute to the TQL layout:

1.

2.

Loginto UCMDB as an administrator.
Navigate to Modeling > Modeling Studio.
For Resource Type, select Queries.

From the Queries navigation tree, click Integration > SM Sync > 9.xx.
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5. Select the query that manages the Cl type whose attributes you want to add to the integration.
For example, SM Computer Push. UCMDB displays the TQL for the integration query.

6. Select the node from the TQL layout that contains the CI attribute you want to add to the
integration. For example, Root.

7. Right-click the node and select Query Node Properties. The Query Node Properties window
opens.

8. Click Element layout tab. The Layout Settings tab opens.

9. Select the Cl attribute you want to include in the integration from the Available Attributes list,
and click the Add button to add it to Specific Attributes list. For example, OsVendor.

Attribute || Cardinality | | Element Type || Element Lavout || Identt
Here you can define which attributes will be returned in the query result for this query node.
You can choose to keep the default behavior, where attributes are not returned in the gquery results or you can define the layout t
(0 Mo attributes
(®) Select attributes for layout
Cl Types Conditions
H & <
B | (2] Tree View @ Aftributes conddition | Specific Atributes |v| =
EI—% Node &% A
& ClusterResource Group Attributes with the following qualifiers:
= % Computer
—% HP Comple:x
—% HP MonStop - - - -
_E IBM Frame Available Atributes Specific Atributes
—H iseries 3 MNodeModel - > Dizcoverediendor | =
—& LD_OM Server Note DizcoveredOsName A
_% Ma!m'rame CP(_: o Operation Corr Stat Dizplay Label 3 i
_é Ma|r1f.rame Logical Partition Operation Is New Global Id
@ Eermlnal Server Operation State PrimaryCnsName
— nix . )
D o 3] | e
_% WMware ESX Server =Description = aul eway [p -
_@ Windows Os\Vendor = 4 il (3
_% 05 Owner Tenart
I'_—'l—% Met Device Reference to the cre Excluded Attributes
& ATM Switch root_jconproperties
l—% Marconi ATM Switch Snmp Sys Mame >
[0 chassis State |
L& Fretnsire o Store KPI History Fo = =
|Legend: @ oA G Specific Atributes 1]

10. Click OK to save the node properties.

11. Click the Save button to save the TQL query.

How to Add the CI Attribute to the Service Manager Table

The integration uses only a subset of the CI attributes available from your Service Manager system.
Before creating a new Service Manager Cl attribute, you should determine if there are any existing
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Cl attributes in your Service Manager system that provide the data you want. In most cases, there
is an existing attribute tracking the data you want to add to the integration. For example, if you
review the attributes of the Computer Cl type, you see that there are many attributes available to be
added to the integration.

Join Table Mame:

Common Mame:

|j|:uinn|:|de

joinnode

| Edit Common Name

The following steps illustrate how to add a new ClI attribute to an existing Cl type.

& File Mames | < Field Mames and Captions
Table Name | Field Mames | Field Captions | -
node node, addIPAddr Addl I P Addr
node node,addMacAddress Addl Mac Address
node node, bios.id Bios Id
node node,cpu Cpu
node node, disk.device Disk Device i
node node, file.system File System
node node, logical.name Logical Name
node node, machine. name Machine Mame
node node, os.manufacturer Os Manufacturer
node node, os. version Os Version
node node,physical. mem. total Phrysical Mem Total
device device,ac.category Ac Category
device device,add| Addl
device device,admin.id Admin Id
device device,admin.password Admin Password
device device,admin.urlport Admin Urlpart
device device, allow.subscription Allow Subscription
device device,asset. tag Asset Tag
device device,assignment Assignment
device device,auditDate Audit Date
device device,auditDescrepency Audit Discrepancy
device device, auditPolicy Audit Policy
device device,auditStatus Audit Status
device device,auditedBy Audited by

The integration does not require any special steps to add a Cl attribute to the Service Manager
table. You can use the standard table attribute creation procedures to add a Cl attribute. For more
information on table attribute creation, see the Service Manager help and Service Manager Tailoring
Best Practices Guide.

To add a Cl attribute to the Service Manager table:
1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Database Dictionary.

3. InFile Name, type the name of the table where you want to add the new ClI attribute. For

example, node.
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4. Click the Search button @
The node dbdict record opens.

5. Click the Fields tab.

6. Click the New Field/Key button.
The Add Attribute window opens.

7. InName, type the name you want to use for the new ClI attribute. For example,
os.manufacturer.

Caution: The name cannot include any of the following characters: ' / \ [ ] : | <
>+ =; , ? *

8. InType, select a type from the list. For example, select character.

9. Click the Add Field button to save the attribute.

10. Click the OK button to save attribute changes to the table.

How to Create a Web Service Field to Support the CI
Attribute

UCMDB uses the Service Manager ucmdblntegration web service to send Cl data. This web
service publishes the objects that match the out-of-the-box Cl types and ClI attributes provided by
the UCMDB-SM integration. For a list of the out-of-the-box web service fields and their mappings to
Service Manager tables, see "Managed Fields" on page 110.

If you add a CI attribute to the integration on your UCMDB system, you must create a
corresponding web service field on your Service Manager system to receive the incoming Cl data
from UCMDB. Each web service field must map to a valid Service Manager table and column.

To create a web service field for the OSVendor attribute described in previous sections:
1. Loginto Service Manager with an administrator account.

2. Navigate to Tailoring > Web Services > WSDL Configuration. The External Access
Definition form opens.

3. For Service Name, type ucmdblintegration.

4. Click Search. Service Manager displays a record list of the objects that make up the
ucmdblintegration web service.

5. Select an existing web service object to which you want to add the CI attribute. For example,
select uemdbNode.

6. Click the Fields tab. Service Manager displays the fields published as web service fields.

7. Select an empty row in the Fields list.
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8. ForField, select the Service Manager column name where you want to store the incoming Cl
attribute values. For example, os.manufacturer.

Note: Service Manager displays the fields from all join tables associated with the table
listed in the Name field. For example, for joinnode Service Manager displays the fields
from the device and node tables.

9. For Caption, type the name you want Service Manager to use when publishing the field as a
web service field. For example, OSVendor.

Caution: The Caption name must match the object name you listed in the XSL
transformation file in Universal CMDB, or Service Manager will not receive any Cl updates
from your Universal CMDB system.

10. Click Save.
The new web service field is available immediately; you do not need to restart the Service
Manager system.

Service Name: Pmdblntegration | [ released

Name: ﬁninnnde |v| [ peprecated

Object Mame: |u|:mdeode |

& Allowed Actions | & Expressions | & Fields |

Field | Caption | Type | ﬂ
physical.mem. total PhysicalMemory
serial.no. SerialMo
wendor Vendor
cpu[cpu.id] CpulD
cpu[cpu.name] CpulName
cpu[cpu. dodk.speed] CpuClockSpeed
file.system[mount. point] MountPoint
file.system[disk. type] DiskType
file.system[file.system. type] FilesystemType
file.system[disk. size] DiskSize
asset.tag AssetTag
machine.name HostMName
id CIName
disk. device [model.name] ModelName
disk. device [disk. vendor] DiskVendor
disk. device [disk.name] DiskMName
E-:us.rnanufﬁu:turer OSVendor

How to Add a Managed Field to Support the CI Attribute

In order for a Cl attribute you add to the integration to trigger the automated Change Management
validation and verification processes, you must add a managed field for the CI attribute. Service
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Manager managed fields are part of the Discovery Event Manager Rules. For a list of fields that
trigger Change Management validation and verification, see "Service Manager Discovery Event
Manager Rules" on page 116.

To add a managed field to the integration:
1. Loginto Service Manager with an administrator account.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules. Service
Manager displays a record search/creation form.

3. Click Search to display a list of all Discovery Event Manager rules.

4. Select the rule ID that matches the web services object where you mapped the
incoming Cl attribute. For example, uecmdbNode. See "How to Create a Web Service Field

to Support the Cl Attribute" on page 134.
Service Manager displays the rules for this web service object.

5. Click the Managed Fields tab. Service Manager displays the list of fields that trigger Change
Management validation and verification.

6. Select an empty row in the Managed Fields list.

7. ForField Name, select the caption name of the Service Manager column that you previously
selected to store the incoming Cl attribute values. For example, Os Manufacturer.

Note: Service Manager displays the fields from all join tables associated with the table
listed in the Table Name field. For example, joinnode displays fields from the device and
computer tables.

Tip: If you want to add all fields that are exposed in the WSDL definition, you can click the
Load Fields button. For more information, see "How do | Use the Load Fields Button to
Add Multiple Managed Fields" on page 100.

8. If the field you use to store the incoming Cl attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Os Manufacturer is a primitive character field and therefore does not need to identify an array
of structure name.

9. If the field you use to store the incoming Cl attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example, Os
Manufacturer is a primitive character field and therefore does not need to identify an array of
structure index.

10. Click Save.
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Discovery Event Manager Rules

Id: [uemdbhode |
Table Mame: |joir1node |

Condition: |

& Rules | < Managed Ficlds | & Inddent Customization | & Change Customization | % Duplication Rule
Field Mame | Structure | Index | Condition |:|
Serial Mo
Vendor
cpu.id cpu 1
cpu. name cpu 2
cpu.dock.speed cpu 3
mount.point file.system 4
disk. type file.system 2
file.system. type file.system 1
disk.size file.system 3
Asset Tag
Machine Mame
CI Mame
model.name disk.device 1
disk.vendor disk.device 2
disk.name disk.device 3
0Os Manufacturer

How to Map the CI Attribute to a Web Service Field

The integration uses an adapter to transform UCMDB CI attributes to web services objects
recognized by Service Manager. The adapter in turn specifies what XSL transformation files the
integration should use to convert UCMDB TQL queries into properly formatted Service Manager
web services messages.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular Cl type in UCMDB. In addition, each attribute for which you enabled calculation requires
its own entry in the XSL transformation file. Without an XSL transformation entry, Service Manager
cannot receive any Cl attribute updates from your UCMDB system.

If you want to add a new attribute to the integration, you must edit the XSL transformation file for the
parent Cl type and add an entry for the Cl attribute. For information about which Cl types each
query manages, see "TQL Queries for Push" on page 106. In order to create a proper XSL mapping,
you must be familiar with the service and object names Service Manager publishes as web
services. Forinformation on publishing tables and columns as web service objects, see the Service
Manager Web Services Guide available from the Service Manager help.

The following steps illustrate how to map a UCMDB CI attribute called host_vendor to a Service
Manager web service object called OSVendor.
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To map a Cl attribute to a web service field:

1.

2.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

Double-click the XSL transformation file that manages the parent Cl type of your Cl attribute.
For example, open computer_push.xslt to add an attribute to the SM Computer Push TQL

query.

Find the element that defines the Service Manager table name where the integration will store
Cl attribute values. For example, the element <file.device> will store Cl attributes in the
Service Manager device table.

Within the table naming element (<file.device>), you will see an element of the following format
that defines how to transform each UCMDB CI attribute into a web service object:

<xsl:for-each select="@CI_attribute_name">
<SMAttributeName><xsl:value-of select="."/></SMAttributeName>
</xsl:for-each>

@CI_attribute_name is the name of attribute in the UCMDB system.

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

Caution: The web service attribute name is case-sensitive.

Cl attributes in the computer_push.xs1lt XSL transformation file are illustrated in the following
screenshot:
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Q@R E| 2
1 <xsl:stylesheet versicn="1.0" xmlns:xsl="http://www.w3.o0rg/1999/X5L/Tranaform™> a
2 <xsgl:template match="/node"> 1l
3 <model>
4 <keys/>
3 <instance>
a <file.device>
7 <!--import:cmdb root attributes.xslt-->
8 <Typercomputer</Type:
9 <xsl:variable neme="prefix" select=""Valusszgt:;'"/>
10 <xsl:variable name="suffix" =zelectc=""szlt;/Value'"/>
11 <Subtype>
12 <xsl:choose>
13 <xsl:when test="contains{@node role,concat ($prefix, "deskt
14 «<xsl:when test="foa_family™>
15 <xsl:value-of select="@oz_family"/>
14 </x=l1when>
17 «xsl:otherwiserServer</xsl:otherwise> =
18 </xsl:choose’>
19
20 :sm device common attributes.xslt-->
21 :asset_m&ppi.r:g HE1E—->
22 t:location attribute mapping.xslt-->
23
24 </file.device>
23 <file.node>
26 i hitelel S slele A o e =T R e |
27 ] rticpu mapping.xslt--»
28 t:disk device mapping.xslt-->
29 1lesystem mapplng.Xslt--»
30 t:ips mapping push.xslt-->»
a1 <l--import:interfaces mapping push.xslt-->
32 </file.node> - - |
33 </instance>
34 </model>
35 </xsl:templates ':l
B I e
Cancel

Cl attributes in the sm_node_attributes.xslt XSL transformation file are illustrated in the
following screenshot:
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QAETE| 2

1 <xzl:for-each select="fname"> -
2 <HostName>

3 <xzl:value-of zelect="."/>

4 </HostHame>

S5 </xsl: for-each>

G <xsl:for-each select="(d1 i o9 ion™>

7 <O5Versiomn»

g <x=l:value-of zelect="."/>

9 </05Version>

10 </x=1l: for-each>

11 «xsl:for-each select="Fmemory aize™>
12 <PhysicalMemory>

13 <xzl:value-of zelect="."/>
14 </Physicallemory>

15 </xs]l: for-each>

l6<xsl:for-each select="(Fbios_serial number"»
17 <BIOSId>

18 <x=l:value-of zelect="."/>
149 </BIOSTd>

20 =</x=l: for-each>

Matching Cl attributes in the ucmdbNode web service are illustrated in the following screenshot:
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External Access Definition

Service Mame: |7_|mdb1ntegration | O released
Mame: ﬁginngde |v| [ ceprecated
Chject Mame: |l.u:ml:||:|N|:|c|e |
< Allowed Actions | < Expressions | & Fields |

Field | Caption | Type Iil

location Location

addlIPAddr [addIIPAddress] AddiIPAddress

addlIPAddr [addISubnet] Addisubnet

addiMacAddress AddMacAddress

bioz.id BIOSId

operating.system 05

0s.version OSVersion

physical . mem, total PhysicalMemory

serial.na. SerialMo

wendar Vendar

cpulcpu.id] CpulD

cpulcpu.name] CpuMame

cpulcpu.dodk. speed] CpuClockSpeed

file.system[mount. point] MountPoint | |

file.system[disk. type] DiskType

file.system[file.system. type] FilesystemType

file.system[disk.size] DiskSize

asset. tag AssetTag

6. Copy an existing XSL transformation element to use it as a template to create a new

transformation entry.

Paste the new XSL transformation element within the proper table naming element. For
example, <file.node>.

Update the CI attribute name and web service object name within the new element to match
the attribute you want to add to the integration. For example, create the following XSL
transformation element to add an attribute to the integration.

<xsl:for-each select="@os_vendor">
<0SVendor><xsl:value-of select="."/></0SVendor>

</xsl:for-each>

New attribute in the computer_push.xs1lt XSL transformation file is illustrated in the following
screenshot:

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 141 of 248



& <file.device> A]
7T <l--import:cmdb root attributes.xslt-->»
il <Typercomputer</Type>
9 <xsl:variable name="prefix™ select=""Valuezgt;'"/>
10 <xsl:variable namse="suffix™ select=""szlt;/Valus'"/>
11 <Subtype>
12 <xs3]1:choose>
13 <xsl:when test="contains(@fnode role, concat{$prefix,’
14 <xsl:when test="Fos_family">
15 <xsl:ivalue-of select="Fos_family"/>
1é </xs1 :when>
17 <xsl:otherwise>3erver</xsl:othervise>
18 </xsl:choose>
19 </Subtype>
20 <! —-1mport:
21 <l - art
22 <l --1mport:
23
24 </file.device>
25 <file.node> —
24 Bos_
27 ey 1 1 [ o=
28 i
29]
30
3
32
33
34
35
36 </instance>
37 </model>
38 </xs1l:tenplate>
39 </x=l:stylesheet>
-
L ] [k

9. Save the XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a Cl Type to the Integration for Data Push
You can use the following steps to add a Cl type to the integration.

1. Does the Cl type already exist in the UCMDB class model?
Yes. Goto Step 3.

No. Go to Step 2.

2. Addthe Cl type to the UCMDB class model.
See "How to Add the Cl Type to the UCMDB Class Model" on the next page.
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3. Add Cl attributes to the ClI type as needed.
See "How to Add a Cl Attribute to the Integration for Data Push" on page 129.

4. Create a TQL query to synchronize the Cl type.
See "How to Create a TQL Query to Synchronize the Cl Type" on page 145.

5. Addthe Cl type’s attributes to the TQL layout.
See "How to Add the CI Type’s Attributes to the TQL Layout" on page 149.

6. Addthe Cl type to Service ManagerService Manager.
See "How to Add the Cl Type in Service Manager" on page 151.

7. Create web service fields to support the Cl type.
See "How to Create Web Service Fields to Support the Cl Type" on page 154.

8. Add managed fields to support the Cl type.
See "How to Add Managed Fields to Support the Cl Type" on page 156.

9. Map the Cl type’s TQL query to an XSL transformation file.
See "How to Map the Cl Type’s TQL Query to an XSL Transformation File" on page 157.

10. Map the Cl type’s attributes to web service fields.
See "How to Map the Cl Type’s Attributes to Web Service Fields" on page 159.

11. Add custom TQL queries to integration data push jobs.
See "How to Add Custom TQL Queries to Data Push Jobs" on page 170.

How to Add the CI Type to the UCMDB Class Model

Before creating a new UCMDB Cl type, you should determine if there are any existing Cl types in
your UCMDB system that provide the Cl attributes you want. In most cases, you can create links
to one or more existing Cl types to create a new logical Cl type for use by the integration.

The following steps illustrate how to create a new Cl type called SM RDBMS based on an existing
Cl type called database.

Note: The integration does not require any special steps to add a Cl type to the UCMDB class
model. You can use the standard Cl type creation procedures to add a Cl type. For more
information on Cl type creation, see the HP Universal CMDB CI Attribute Customization
Guide.

To add a Cl type to the UCMDB class model:
1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Cl Type Manager.
3. Select the base Cl type you want to use for your new ClI type from the Cl Types navigation

tree: Managed Object > Configurationltem > Infrastructure Element > Running Software
> Database.
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10.

11.

12.

13.

14.

15.

16.

Click the New button .
The Create Configuration Item Type window opens.

In Name, type the unique name you want to use for the new Cl type. For example, sm rdbms.

Caution: The name cannot include any of the following characters: * / \ [ 1 : | <
>4 =p o, 7O,

In Display Name, type the name you want UCMDB to display in the interface. For example, sSM
RDBMS.

In Description, type a description of the new Cl type. This is an optional field. For example,
Hosts running relational databases.

In Base Cl Type, verify that the proper base Cl type is selected. Your new Cl type will inherit
the attributes of the base Cl type you select here. For example, Database.

Click Next. The wizard displays a list of Cl attributes from the base CI type.

Add, edit, or remove ClI attributes as needed for the new ClI type. For example, accept the
default attributes inherited from Database.

Click Next. The wizard displays a list of qualifiers from the base ClI type.

Add or remove qualifiers as needed for the new ClI type. For example, accept the default
qualifiers.

Click Next. The wizard displays a list of icons associated with the Cl type.

Select the icons associated with this Cl type. For example, accept the default abstract class
icon.

Click Next to add any menu item properties or label definitions as needed. For example, accept
the default settings from the base Cl type.

Click Finish to create the Cl type.
=43 PunningSoftware (0)

3 Agent (1)

\.,U.r ApplicationServer (0)

*.,,_,x Cluster Software (0)

\.,,; Cormmunication Server (0)
=) Databaze (0)

— pB2 ()

—& mysaL o)

—EJ MonStop SQLMX (0)
— Oracle (0}

—[&] saL server (@)
—Q Sybaze (0)
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17.

18.

19.

20.

21.

22.

Select your new ClI type from the tree. For example, SM RDBMS.

Browse to an existing Cl type you want to link to, and control-click it to add it to your selection.
For example, Node.

Note: Choose an existing Cl type that has the attributes that you want to be part of your
new logical Cl type.

Right-click one of the selected Cl types, and click Add/Remove Relationship. The
Relationships window opens.

Create an SM Link relationship from the existing Cl type to the new CI type. For example, from
Node to SM RDBMS.

Note: You need to create a new SM Link relationship if it does not exist.

A Add/Remove Relationship x|

Relaticnships

Relationship .| Node —= SM RDBMS | SM RDBMS —> ___
Rezponzibility
RFC Connecti...
Route

SM LIMK
Socket

System Links
System Monit...
Talk

TCP

-— =) e

4

100000KO000
1o0oooooond

|
i

Click OK to create the relationship.

Click the Save button to save the Cl type.

How to Create a TQL Query to Synchronize the Cl Type

The integration uses Topology Query Language (TQL) queries to gather Cl attribute values and
pass them to your Service Manager system. You must create a TQL query for any ClI type you add
to the integration. Any TQL query you create must conform to the "TQL Query Requirements" on
page 109.

The following steps illustrate how to create a new TQL query called rdbmsData for the SM RDBMS
Cl type described in previous sections.
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1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.
3. From the Queries navigation tree, click Integration > SM Sync.

4. Right-click SM Sync, and select the New > Query.
The Query Definition window opens.

5. Find the Cl type that will be the root node of your query from the Cl Type Selector. This Cl type
is typically the one that provides the most attributes for the Cl. For example, Managed Object
> Configurationltem > InfrastructureElement > RunningSoftware > Database > SM

RDBMS.

6. Drag the root Cl type from the Cl Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the Cl type.

Query Definition

NSRS

S

=h RDEM=

N P R I

Py
&=

o
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7. Select the Cl type, and click Edit from the Information Pane. The Node properties window
opens.

8. Change the Element name to Root.
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9. Click OK to save the node properties.

Query Definition

N ERERE

Foot

El@lle Tl e ®
(@

E-"I e E

10. Find any additional CI types you want to add to the query from the Cl Type Selector. These Cl
types typically provide additional Cl attributes. For example, Managed Object >
Configurationltem > Infrastructure Element > Node.

11. Drag the additional CI type from the CI Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the additional CI type.

Query Definttion

NENERIR

Foot

FleFle 0 e
@|

Mode

E ke 1]
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12. Create relationships between the Root Cl type and the additional Cl types as needed. For

example, create an SM Link between Root and Node.
a. Select Root and control-click the additional Cl type. For example, Node.

b. Right-click one of the selected items, and click Add Relationship. The Add Relationship
window opens.

c. Select SM Link.
d. Type aRelationship Name. For example sM Link.
e. Click OK to add the relationship.

13. Repeat step 10 to step 12 for each additional Cl type you want to add to the TQL. For example,
SM RDBMS does not need any additional Cl types.

Query Definition

N EENEE
[2]
Q Pt

Foot T‘

g LS Link
. .
Mode
&
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14. Click the Save button to save the TQL query.

15. In Query Name, type the unique name you want to use for the new query. For example,
rdbmsData.

16. In Description, type a description of the new query. This is an optional field. For example,
Query for hosts running relational databases.

17. Inthe folder tree, select the folder in which you want to save the TQL. For example, Root >
Integration > SM Sync.

18. Click OK. UCMDB adds your new query to the Queries list.
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How to Add the CI Type’s Attributes to the TQL Layout

To add a Cl attribute to the integration, you must enable the calculation layout setting from the TQL
query that synchronizes the Cl type. Because you must enable calculation for each attribute you
want to add to the integration, you should be familiar with the integration CI types and the CI
attributes they contain.

Tip: Keep a list of the attributes you enable, because you will need to create a matching XSL
transformation for each one.

The following steps illustrate how to enable calculation for attributes of the SM RDBMS Cl type
described in previous sections.

To add a Cl type’s attributes to the TQL layout:
1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.
3. From the Queries navigation tree, click Integration > SM Sync.

4. Select the query that manages the Cl type whose attributes you want to add to the integration.
For example, rdbmsData. UCMDB displays the TQL for the integration query.

5. Select the Root node from the TQL layout, and then click the Edit button from the Information
Pane. The Node properties window opens.

Caution: Your integration query must contain a node called Root. See "TQL Query
Requirements" on page 109 for more information.

6. Click the Element Layout tab, and select the option Select attributes for layout.

7. Select Specific Attributes from the Attributes condition list, and from the Available
Attributes list select each ClI attribute you want to add to the Specific Attributes list. For
example, select the Product Name, Application Version Description, Vendor, Version,
Description, The Database Instance Name, and Port attributes.
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10.

11.

12.

13.

14.

15.

gQuer\f Node Properties x|
Query Mode FProperties
A= Enables you to add sttributes, cardinalty, qualifiers and Cl specific conditions
Element name: Element type:
| Root | | SM RODBEMS v| Show element in query results Y& Query Pesutt |

Here you can defing which attributes will be returnad in the guery result for this guery node.

O Mo sttributes

®) Select attributes for lay out

Attribute || Element Type || Element Layvout || |dentity

‘ou can choose to keep the default behavior, where attributes are not returned in the query results or you can define the layout to include or exclude attributes int

Aftributes with the following qualifiers:

Cl Types Conditions

u 2 - 3
By B[] Tree view =} Atributes condition | Specific Attributes [=]
—( sm ROBMS Y%

Available Atributes Specific Attributes
ack_cleared_time = Display Label
ack_jd IEI Product Mame
Actual Delete Time = E‘ ersion
Actual Deletion Period Vendor
Admin State Part
Allow Cl Update IE’ The Database instance name
lication Categor —
|Legend: @ &l §% Specific Attributes “op gory = v]

Click OK to save the query node properties.

Select any additional nodes that contain ClI attributes you want to add to the integration. For
example, Node.

Click the Edit button from the Information Pane. The Node properties window opens.
Click Element Layout tab, and select the option Select attributes for layout.

Select Specific Attributes in Attributes condition, and from the Available Attributes list select
each ClI attribute you want to add to the Specific Attributes list. For example, select attributes
for the OS Vendor, and name attributes.

Click OK to save the query node properties.

Repeat step 9 to step 13 for each additional node that contains CI attributes that you want to
add to the integration.

Click the Save button to save the TQL query .

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 150 of 248




How to Add the CI Type in Service Manager

Before creating a new Service Manager Cl type, you should determine if there are any existing ClI
types in your Service Manager system that provide the CI attributes you want. In most cases, you
can reuse the existing Cl types for the integration.

The integration does not require any special steps to add a Cl type to Service Manager. You can
use the standard CI type creation procedures to add a Cl type. For more information on Cl type
creation, see the HP Service Manager online help.

To add a new ClI type in Service Manager:
1. Create atable for storing the specific attributes of this new CI type.
2. Create ajoin definition to join the device table.
3. Create an erddef definition that defines a relationship between the two tables.
4. Create aview form and a bulk update form for the new CI type.
5. Addthe Cl type.

The following steps illustrate how to create a new ClI type called RDBMS.

Note: This example is provided only as an illustration of the steps. The best practice is to
reuse the existing Service Manager Cl type RunningSoftware to map with UCMDB ClI type
SM RDBMS.

To create a table in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Database Dictionary.
3. InFile Name, type the table name you want to add. For example, rdbms.

g L

4. Click the New button I= .
5. Click the Fields tab.

6. Click the New Field/Key button. The Add Field window opens.

7. InName, type a field name you want to add. For example, 1ogical .name, which is
mandatory for joining the device table.

Caution: The name cannot include any of the following characters: ' / \ [ 1 : | <

>+ =9 , 7%

8. InType, select a type from the list. For example, select character.
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10.

11.

12.

13.

14.

15.
16.

wd
Click the Add Field button to save the attribute.

Repeat step 7 to step 9 for each attribute you wish to add. For example, dbinstance and
port.

Click the Keys tab.

Place the cursor on the first line of the structure, and click the New Field/Key button. The Add
Key window opens.

In Type, select unique from the list.

In Fields list, type the name of a field that you want to use as the unique key. For example,
logical.name.

(T
Click Add Key button to save the key.

Click the OKbutton to save attribute changes to the table.

To create ajoin definition in Service Manager:

1.

2.

~

Login to Service Manager as a system administrator.
Navigate to Tailoring > Database Manager.

In Table, type the table name joindefs.

Click the Search button @

In Join Table Name, type a name for the join definition. For example, joinRDBMS.

In File Names, select the names of the tables to join. For example, device and rdbms.

. Click Add to save the join definition.

To create an ERD definition in Service Manager:

1.

2.

Login to Service Manager as a system administrator.
Navigate to Tailoring > Database Manager.

In Table, type the table name erddef.

Click the Search button @

In First Filename, type the name of the first table of the join definition. For example, device.

In Second Filename, type the name of the second table of the join definition. For example,
rdbms.
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7. InRelationship type, select a value from the list. For example, One to One.

8. InField Names from First Filename, add the unique field name of first table. For example,
logical.name.

9. InField Names from Second Filename, add the unique field name of the second table. For
example, logical.name.

10. Click the Add button to save the ERD definition.

To create forms for view and bulk update in Service Manager:

Create a view form named configurationltemRDBMS, and a bulk update form named
device.rdbms.bulkupdate.

You can create them in Forms Designer based on existing view forms and bulk update forms. To
view the form names of an existing Cl type in Service Manager, click Configuration Management
> Resources > Device Types > Search, and then open the Cl type record.

To access Forms Designer in Service Manager, type £d in the command line or go to Tailoring >
Forms Designer.

For more information about creating forms in Service Manager, see the Service Manager 9.33 online
help and the Tailoring Best Practices Guide.

To add a Cl type to Service Manager:
1. Loginto Service Manager as a system administrator.

2. Navigate to Configuration Management > Administration > Add New Device Type, and
click Next.

3. InDevice Type Name, type a descriptive name for the new CI type. For example, RDBMS.
4. InDevice Type, type a name for the new ClI type. For example, rdbms.
5. Click Next.

6. InView Form, type the name of the view form you created for the new ClI type. For example,
configurationItemRDBMS.

7. InBulk Update Form, type the name of the bulk update form you created for the new ClI type.
For example, device.rdbms.bulkupdate.

8. Click Next.
9. In Attribute File, select the table you created for the Cl type. For example, rdbms.
10. Click Next.

11. Click Next to keep the default setting for Fields Specific to the Attribute File.
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12.

13.

14.

15.

16.

17.

In Join Def Record, select the join definition you created for this Cl type. For example,
joinRDBMS.

Click Next.

In Subtypes, add necessary subtypes for the Cl type. For example, Oracle and SQL
Server.

Click Next.
Check the Activate Device Type check box.

Click Next to save the new ClI type.

How to Create Web Service Fields to Support the CI Type

In order to add a Cl type to the integration, you must create a Service Manager web service object
for each CI attribute for which you created an XSL transformation on the UCMDB system. Service
Manager uses the web service object to determine which Service Manager table and column to
store the incoming CI attribute values.

The following steps illustrate how to create a web service object necessary to support the SM
RDBMS CI type described in previous sections.

Note: This example of creating a new web service object (ucmdbRDBMS) is provided only as
an illustration of the steps. The best practice is to reuse the existing Service Manager web
service object ucmdbRunningSoftware to map with Universal CMDB CI type SM RDBMS.

To create web service fields to support your new Cl type:

1.

2.

o

Log in to Service Manager with an administrator account.
Navigate to Tailoring > Web Services > WSDL Configuration.
In Service Name, type ucmdbIntegration.

In Name, select the name of the join file you have created for the new ClI type. For example,
joinRDBMS.

In Object Name, type a name. For example, ucmdbRDBMS.
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6. Click the Allowed Actions tab, and specify the actions as shown in the following figure.

Service Name: uemdblntegration [T Released

Name: ioinRDEMS | i [l Deprecated

Object Name: uemdbRDBMS |

% Allowed Actions | % Expressions | % Fields

Allowed Actions Action Names Action Type Custom Action To Perform
save Update Create only Discovery Event Manager
delete Delete Application Pass Through Discavery Event Manager
add Create Create only Discovery Event Manager

Caution: For UCMDB integration WSDL configurations, be sure to use the “Create only”
action type for the “add” and “save” actions, and “Application Pass Through” for the “delete”
action. For more information about the action types, see the Service Manager 9.33 Web

Services Guide.

7. Click Add to create the WSDL configuration.

8. Click the Fields tab, select fields from the list and type a caption for each of them, as shown in

the following figure.

External Access Definition

Service Mame:
MName:

Object Mame:

F.lu‘ndb.idua'ndblntegraﬁnn | O released
ﬁuinRDBMS | - | [ peprecated
|un:mdbRDBM5 |

& Allowed Actions | & Expressions | & Fields |

EI:IESD'iFItiEII'I

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later)

Field | Caption | Type
ucrndb.id UCMDEBId
d.name ApplicationMName
type Type

subtype SubType
company CustomerId
logical.name Clldentifier
product. version | ProductVersion
wendor Vendor

wersion Version

id CIMame
dbinstance DEInstance
port Part

Description

Page 155 of 248



9. Click Save to save WSDL configuration changes.
The new web service fields are now available to the integration.

How to Add Managed Fields to Support the CI Type

In order for your custom CI type to trigger the automated Change Management validation and
verification processes, you must add a managed field for each CI attribute within your CI type.
Service Manager managed fields are part of the Discovery Event Manager Rules. For alist of fields
that trigger Change Management validation and verification, see "Service Manager Discovery
Event Manager Rules" on page 116.

The following steps illustrate how to add the managed fields for the SM RDBMS CI type described
in the previous sections.

To add managed field to support your Cl type:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

3. InID, type the ID you want to create for the new Discovered Event Manager Rule. For
example, ucmdbRDBMS.

4. |n Table Name, select the table or join definition you want to associate to the new Discovered
Event Manager Rule. For example, joinRDBMS.

5. Click New.
6. Click Next.

7. Click the Managed Fields tab.

Note: The list of fields you will add here will trigger Change Management validation and
verification.

8. Select an empty row in the Managed Fields list.

9. ForField Name, select the caption names of the Service Manager fields that you previously
selected to store the incoming ClI attribute values. See "How to Create Web Service Fields to
Support the Cl Type" on page 154.

Note: Service Manager displays the fields from all join tables associated with the table
specified in the Table Name field. For example, for the joinRDBMS table, the fields from
the device and rdbms tables are available from the Field Name list.

Tip: If you want to add all fields that are exposed in the WSDL definition, you can click the
Load Fields button. For more information, see "How do | Use the Load Fields Button to
Add Multiple Managed Fields" on page 100.
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10. If thefield you use to store the incoming Cl attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure
name.

11. If the field you use to store the incoming Cl attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure

index.
12. Click Save.
Discovery Event Manager Rules
Id: |uu‘ndbRDBMS |
Table Mame: |j-::ir1RDEIMS |

Condition: |

% Rules | < Managed Fields | i« Inddent Customization | i@ Change Customization | < Duplication F

Load fields

Field Mame | Structure | Index | Candition
CI Identifier
Service Mame

Product Version
Vendor

Version
Dhinstance
Part

How to Map the CI Type’s TQL Query to an XSL
Transformation File

The integration uses a configuration file called smSyncConfFile.xml to map each Universal CMDB
TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, you must add a mapping entry for each TQL query in the configuration file.

The following steps illustrate mapping the TQL query rdbmsData described in previous sections to
the Service ManagerucmdbRDBMS web service.

Tip: Wildcard support for TQL names in smSyncConfFile.xml

When adding a TQL name in the smSyncConfFile.xml file, you can use a wildcard (an
asterisk) in the TQL name. This is helpful in the debugging phase when you may have updated
an out-of-the-box TQL query and saved it as several TQL names. For example, if you have
saved the <TQL_name> query to <TQL_name>_1, and <TQL_name>_2, you can specify the
TQL name as <TQL name>* in the configuration file, and the integration will automatically use
this mapping entry on all of the three TQLs.
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Note: Out-of-the-box, all TQL names in the smSyncConfFile.xml file are suffixed with a
wildcard (an asterisk).

To map a TQL query to an XSL transformation file:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the smSyncConfFile.xml file.

4. Add a TQL mapping element to the file by copying an existing one. A TQL mapping element
uses the following format:

<tql name="TQL_query" xslFile="XSL File">

<!-- Description of mapping -->

<request type="Create" name="Create_web_service"/>
<request type="Update" name="Update web_service"/>
<request type="Delete" name="Delete web_service"/>
</tql>

TQL_query is the name of the UCMDB TQL query you created.

XSL_Fileis the name of the XSL transformation file the integration will use to map Universal
CMDB attributes to Service Manager web service fields.

Create_web_service is the name of the Service Manager web service you want to the
integration to use to create Cls from this TQL query.

Update_web_service is the name of the Service Manager web service you want to the
integration to use to update Cls in this TQL query.

Delete_web_service is the name of the Service Manager web service you want to the
integration to use to delete Cls from this TQL query.

See the following screenshot for an excerpt of smSynchConfFile.xml:
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Rezourcedizcovery ConfigFiles/Service Manager Adapter8-x/zmSync ConfFile.xml
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5. Add or update TQL mapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates a mapping between the rdbmsData TQL query and the
rdbms_push.xs1t file.

<tql name="rdbmsData" xslFile="rdbms_push.xslt">

<!-- this is database tql -->

<request type="Create" name="CreateucmdbRDBMSRequest"/>
<request type="Update" name="UpdateucmdbRDBMSRequest"/>
<request type="Delete" name="DeleteucmdbRDBMSRequest"/>
</tql>

6. Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the Cl Type’s Attributes to Web Service
Fields

The integration uses the Service Manager Adapter to transform UCMDB ClI attributes to web
services objects recognized by Service Manager. The Service Manager Adapter Service Manager
Adapter uses XSL transformation files to convert UCMDB TQL queries into a properly formatted
Service Manager web services messages. Out-of-the-box, each integration query has a
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corresponding XSL transformation file. In addition, each attribute you enable for synchronization
from Advanced layout settings requires its own entry in the XSL transformation file.

If you want to add a Cl type to the integration, you must create a matching XSL transformation file
that defines how the Service Manager Adapter transforms each CI type into a Service Manager web
service object. See "Integration TQL Queries" on page 105 for information about which CI types
each query manages. In order to create a proper XSL mapping, you must be familiar with the
service and object names Service Manager publishes as Web services. See the Service Manager
help for information on publishing tables and columns as Web service objects.

The following steps illustrate creating an XSL transformation file for the rdbmsData TQL query
described in previous sections.

Tomap a Cl type’s attributes to web service fields:

1.

2.

10.

Log in to UCMDB with an administrator account.

Navigate to Data Flow Management > Adapter Management.

Click the Create New Resource button

Select New Configuration File.
Select the ServiceManagerAdapter9-x package.

Enter the full file name: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms push.xslt

Copy the content of an existing XSL transformation file (for example, runningsoftware_
push.xs1t)to the new XSL transformation file.

Find the ClI type definition element in the new file. The CI type definition element uses the
following format:

<xsl:template match="/CI_type name">

CI type name is the name of Cl type in the UCMDB system.

The following is an example from the runningsoftware_push.xslt file:

<xsl:template match="/running_software">

Update the CI type name to match the Cl type you want to add to the integration. For example,
create the following CI type definition element to add the database Cl type to the integration.

<xsl:template match="/sm_rdbms">

Add or update table naming elements as needed. By default, UCMDB sends Cl attribute data
to the Service Manager device table. If you want to send Cl attributes to one of the join tables
of device, you must add an element to specify the table name using the format <file.table
name>. For example, you do not need to specify an additional jointable to define a database CI
type since Service Manager does not use a separate jointable to manage database ClI types.
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11. Find the elements that transform UCMDB CI attributes into Service Manager web service
fields. The Cl attribute transformation elements use the following format:

<xsl:for-each select="@CI_attribute_name">
<WSFieldName><xsl:value-of select="."/></WSFieldName>

</xsl:for-each>

@ClI_attribute_name is the name of attribute in the UCMDB system.
WSFieldName is the name of a web service field published by the Service Manager system.

The following figures show an example. Cl attributes in runningsoftware_push.xslt shows one
Cl attribute named product_name is mapped to a web service field with a caption of
ApplicationName; Mapping ClI attributes in the ucmdbRunningSoftware web service object
shows the web service field name and caption defined in the ucmdbRunningSoftware web
service object; Mapping CI attributes in the UCMDB RunningSoftware Cl type shows how the
product_name attribute is mapped in the RunningSoftware CI type in UCMDB.

See the following screenshot for Cl attributes in runningsoftware_push.xslt:

{t--import:cmdb_root_attributes.xslt-->
<Typerrunning_software{/Type>
<xsl:variable name="CIT" select="@bdmType'"/>
<{Subtype><xsl:value—of select="5CIT"/><{/Subtype>
<{xsl:For—-each select="5$CIlists/list[@name="CIType runningsoftware']">
{Subtype><xsl:value—of select="entry[Rucmdb=5CIT]/@sm"/><{/Subtype>
{/%sl:for-each>
<xs5l:variable name="fullDHSHame" select="nodes/node/@primary dns_name' />
{xs5l:for-each select="@display label">
{CIldentifier><{xsl:value-of select="5fullDHSHame"/> <{xsl:value—of sele
ct=""."/></CIldentifier>
{/%sl:for-each>
{xsl:For—each select="0Eproduct name'>
LapplicationHame>{xs] zvalue—of select="_"/>{/fpplicationMame>
{/%sl:for-each>
<xs5l:for-each select="Rapplication_version">
{ProductVersion><{xsl:value-of select=""_"/><{/ProductVersion>
{/%sl:for-each>
{#sl:for-each select="Euendor">
{Uendor><xsl:value—of select="."/>{/Vendor>
{/%sl:for-each>
<{¥sl:for-each select="GOversion">
{Version><{xsl:value—of select="_"/>{fUersion>
{/%sl:for-each>
<{/instance>
</modelf
</f#sl:template>

Refer to the following screenshot to map Cl attributes in the ucmdbRunningSoftware web
service object:
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External Access Definition

Service Mame:
Mame:

Object Name:

|'un:mdb1ntegration |

|HE'u'iCE | - |

|uu'nde‘.unning5c:ftu\'are |

i Allowed Actions | & Expressions | % Fields |

[ released
[ ceprecated

Field | Caption | Type
ucmdb.id LUICMDBId

type Type

subtype Subtype
company CustomerId
logical.name ClIdentifier
product.version | ProductVersion
vendor Vendor

wersion Version

id CIMame
description Description

Refer to the following screenshot to map Cl attributes in the UCMDBRunningSoftware ClI

type:
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Metworl Ertity (2) Store KPI History Fo... | is_save_persistency boolean Store KPI hist
% Mode (2) System root_system string
Nnde.EIernent i) Test Corr State data_testcorrstate teststates_enum Test State
Nl I:r!t.:nnlngsmware © Test Iz New data_testisnew boolean Test State
w0 Agent (0)
"y o Test State data_teststate teststates_enum Test State =
S8 ApplicationServer =
{;-‘. Cluster Software | Track Configuration ... | track_changes boolean Track configu
{73 Communication S Updsated By data_updated_by string
= Q Databaze (0) Uzer Label uszer_label string Uzed as user v]
! g €3 pBz M) b 1 il [l

12. Add or update ClI attribute transformation elements for each CI attribute you want to add to the
integration. For example, create the following XSL transformation elements for the database Cl

type.

Sample XSL transformation elements for database Cls

UCMDBattribute

port

Sample transformation elements

<xsl:for-each select="@port">

<Port><xsl:value-of select="."/></Port>

database_dbsid

description

</xsl:for-each>

<xsl:for-each select="@database_dbsid">

<DBInstance><xsl:value-of select="."/></DBInstance>
</xsl:for-each>
<xsl:for-each select="@description">
<Description><xsl:value-of select="."/>

</Description>

</xsl:for-each>

New attribute mappings in rdbms_push.xs1t are illustrated in the following screenshot:
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{xs5l:stylesheet version="1.0" xmlns:xs1=""http:/ uwuww. w3 _ org/1999/85L/Transform >
<xsl:template match=""/sm_rdbms''>
<model>
<keys/>
{instance>

{t—-import:cmdb_root_attributes_xslt-->

{Type>rdbms<{/Type:

{xsl:variable name="CIT" select="BbdmType"/>

{5l :for-each select="RBhdmnType">
<Subtype><{xslvalue—of select="_"/><{/Subtype>

<fxsl:for-each?

{xsl:for-each select="Rdisplay label>
{CIIdentifier><{xsl:value—of select=""_"/>{/CIIdentifier>

<fxsl:for-each?

{xsl:for-each select="G@product_name™>
<ApplicationHame><{xs5l:value—of select="_"/><{/ApplicationHame>

{fxsl:For—-each

{xsl:for-each select="Eapplication_wersion">
{ProductVersion><{xsl:value—of select="_"/><{/ProductUersion’

{fxsl:For—each

{xsl:for-each select="Guendor">
<Uendor><xslivalue—of select=""."/>{/Vendor>

<fHsl:for—each>

{xs5l:for-each select="@version">
<Uersion><xsl:value—of select="_"/><{/Uersion>

{fHsl:for—each>

<xsl:for-each select="'@port">
<Port><{xsl:value-of select="_"/><{/Port>

£fRsl:zfor-each>

{xs5l:for-each select="Edatabase dbsid">
<DBInstance><{xsl:value-of select=""_"/><{/DBInstance>

<fRsl:zfor-each>

{xs5l:for-each select="Edescription">

{Description><xsl:value-of select=""_"/><{/Description’
</xsl:for-eachy]|
{finstance>
</model’
</f¥sl:template:
</fxsl:istylesheet?
—— SELECT — 9 35,32

13. Save the new XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a Cl Type’s Relationship Types to the
Integration for Data Push
Once you have added a new ClI type to the integration and have created relationships between it

and other Cl types in UCMDB, for each of these relationship types you need to perform the
following tasks so that UCMDB can push the relationships to Service Manager.
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As an example, the following steps illustrate how you add a relationship type named Ownership
(between the Cost and CostCategory Cl types) to the integration for data push. These steps
assume that you have already added the Cost and CostCategory Cl types to the integration and
have created an Ownership relationship between them in UCMDB.

1. Add a mapping entry for each relationship type in the push relationship mapping definition file.
See "How to Add a Push Mapping Entry for Each Relationship Type of the CI Type" below.

2. Create a TQL query to push relationships of the Cl type.
See "How to Create a TQL Query to Push Each Relationship Type of the Cl Type" on the next

page.

3. Map the relationship TQL to an XSL transformation file in the push configuration file.
See "How to Map Each Relationship Type TQL to an XSL Transformation File" on page 168.

How to Add a Push Mapping Entry for Each Relationship
Type of the CI Type

For data push, the SM_CIT Subtype_ list.xml file defines how UCMDB relationship types are
mapped to SM ones.

Note: This XML file can be found from Adapter Management > ServiceManagerAdapter9-x
> Configuration Files.

If this file does not contain a mapping entry for a new relationship type, you need to add an entry for
it.

To add a push mapping entry for the Ownership relationship type:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Double-click the SM_CIT Subtype list.xml file.

4. Go tothe RelationshipType list section, and add a mapping entry for Ownership.
<list name="RelationshipType">

<!--ucmdb is link display lable, ucmdbType is link type, sm is the relations
hip type.
compound link will use root_* as the lable -->

<entry ucmdb="Aggregation" ucmdbType="aggregation" sm="Aggregation" />

<entry ucmdb="Ownership” ucmdbType="ownership” sm="Ownership" />
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</list>
Where:

ucmdb: the display name of the UCMDB relationship type (see Name and Display Name of
Ownership).

ucmdbType: the name of the UCMDB relationship type (see Name and Display Name of
Ownership).

sm: the name of the relationship type in Service Manager.

Name and Display Name of Ownership are illustrated in the following screenshot:

Cl Types
>
Relationships || -+ P4 @ 5.:}' Eﬁ H
General Details
E Managed Relationship (5) Mame:
lf—]— Aggregation (1)
Membership (0) Display Mame: | Ownership|
l— TimeBoundMembership (0) Scope:
Pesponsibility (0) '
I:—]— Buzinezz Links (0) Created By:
(@] Provider of (0) Description:
— Composition (1)
I:—]— Connection (0)
Cwnership (0)
- Time Bound Connection (0) 4

5. Click OK to save thefile.

How to Create a TQL Query to Push Each Relationship
Type of the CI Type

Once you have created Cl Relationship types for the new CI type, you must create a TQL query for
each relationship type to push it to Service Manager.

Note: Any TQL query you create must conform to the "TQL Query Requirements" on page 109.

To create a new TQL query called cost_costcategory _ownership_relation_push for Ownership
relationships between the Cost and CostCategory Cl types:

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.

3. Click New > Query. The Query Definition pane displays.
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4. From the Cl Type Selector, drag the Cost and CostCategory Cl types to the query pane.
5 Query 1* x

Query Defintion

N EENEIE
=
W 2 (=
- Cost
- CostCategory
Q

bl
W

5. Create an Ownership relationship from Cost to CostCategory.
a. Click the Create Relationship button.

b. Click the Cost node, and drag the arrow from it to the CostCategory node.
c. Select Regular Relationship, and click OK.

d. Select Connection > Ownership, and click OK. An Ownership relationship is created
between the Cl types.
'Eﬂ Query 1* x]

Query Definition

=l E & %]

P
@' Crwnership Tlm

Cost

CostCategory

« p ] @

6. Right-click the relationship arrow, and select Relationship Properties.

7. Change the element name from Ownership to Root (or a name starting with “Root_"), and then
click OK.
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|£:| Relationship Properties u
l—d_‘;l Relationship Properties
= Enables you to add attributes, cardinality, qualifiers and Cl specific conditions
Element name: Element type:
| Rm:tl | | Cwnership V‘ Show element in query results '@m
[Attribute || Element Type || Element Lavout
]
NOT { Criteria ) And/Or

8. Click the Save button, and save the query as described in the following.

a. Enteraquery name. Forexample, cost costcategory ownership relation

push.

b. Select the Integration > SM Sync > 9.xx folder.

c. Click OK.

E:jl Save Query

Enter the query name and select a folder in which to save i,

Cluery Mame | cost_costcategory _ownership_relation_push |

¥ oo
ELJ—E Integration
Atriurn
CACMDB
Diata In
Service-Mow
SM Cuery
SM Sync

8.xx

CRAT T

The TQL query is now created. You are ready to map this TQL to an XSL transformation file.

How to Map Each Relationship Type TQL to an XSL
Transformation File

Once you have created a TQL query for a relationship type, you need to map the TQL to an XSL
transformation file as described in the following steps.

Tip: Out-of-the-box, there is a common XSL transformation file (common_relations.xslt),
which is used for pushing all types of Cl relationships. For this reason, you do not need to
create a new XSL transformation file; instead, you only need to map the new relationship TQL
query to this existing XSLT file.
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1. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

2. Click the smSyncConfFile.xml file

3. Add an TQL mapping entry by copying an existing one for relationship push. For example, copy
the following TQL mapping entry.

<tql name="SM Layer2 Topology Relations Push*" xslFile="common_relations.xsl

L
<request type="Create" name="CreateRelationship"/>
<request type="Update" name="UpdateRelationship"/>
<request type="Delete" name="DeleteRelationship"/>
</tql>

4. Change the TQL name to the name of the query you created for the relationship type. For
example, cost_costcategory_ownership_relation_push.

<tgql name="cost_costcategory_ownership_relation_push" xslFile="common_relati
ons.xslt">

<request type="Create" name="CreateRelationship"/>
<request type="Update" name="UpdateRelationship"/>
<request type="Delete" name="DeleteRelationship"/>

</tql>
5. Click OK to save the configuration file.

Now, you have added the new relationship type to the integration. Next, you need to add the new
relationship TQL query to a data push job (see the following figure and "How to Add Custom TQL
Queries to Data Push Jobs" on the next page).

Refer to the following screenshot to add a new relationship TQL query to a data push job:

| £ Edit Integration Job * L —— - e = u

f Edit Integration Job
Cefine the Integration Job details and scheduling informstion

Mame

Job Definition
+ K

Query Name | Allow Deletion

SM Sterage Push

SM Switch Push

SM Met Printer Push

SM Cluster Push

SM Mobile Device Push

SM CRG Relations Push

SM Local Prirter Push

SM Mode Pelations Push

cost_costoategory_ownership_relation_push |

EEEEEEEEE

4 I}
[ = ———
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How to Add Custom TQL Queries to Data Push Jobs

In order for the integration to send your custom CI types and attributes to your Service Manager
system, you must add your custom TQL queries to the data push job between your Changes data
store and your Service Manager data store. The following steps illustrate how to add an custom
TQL query named rdbmsData, which is described in the previous sections.

To add custom TQL queries to a data push job:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Click the name of your Service Manager integration point. For example, SM Integration.
4. Click the Data Push tab.

5. Click the name of your data push job. For example, SM Configuration Item Push job.

6. Click the Editbutton < .
7. Click the Add button. ¥
8. Click Integration > SM Sync > rdbmsData.
9. Click OK to add the custom query.
10. Enable the Allow Integration Job to delete removed data option for the query.

11. Click OK to close the Update Job Definition window.

How to Add a Cl Attribute to the Integration for
Population
To add a Cl attribute to the integration for population, perform the following tasks:

1. Create aweb service field to support the CI attribute.
See "Create a Web Service Field to Support the CI Attribute" below.

2. Map the ClI attribute to the web service field.
See "How to Map the CI Attribute to the Web Service Field" on the next page.

Create a Web Service Field to Support the CI Attribute

UCMDB uses the Service Manager ucmdblntegration web service to retrieve Cl data from Service
Manager. This web service publishes the objects that match the out-of-the-box Cl types and ClI
attributes provided by the UCMDB integration.
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If you want to populate an additional Cl attribute from Service Manager to your Universal CMDB
system, you must create a corresponding web service field on your Service Manager system to
provide the Cl data from Service Manager. Each web service field must map to a valid Service
Manager table and column.

For the steps of creating a web service field, see "How to Create a Web Service Field to Support
the CI Attribute" on page 134.

How to Map the CI Attribute to the Web Service Field

The integration uses an adapter to transform Service Manager web service fields to Universal
CMDB ClI attributes. The adapter in turn specifies what XSL transformation files the integration
should use to convert Service Manager web services messages into a properly formatted Universal
CMDB CI and/or relationship.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular Cl type in Universal CMDB. Without an XSL transformation entry, Universal CMDB
cannot receive any Cl attribute updates from your Service Manager system.

Unlike for the Push feature, you do not need to create real Topology Query Language (TQL) queries
for Population on the UCMDB server.

If you want to add a new attribute to the integration, you must edit the XSL transformation file for the
parent Cl type and add an entry for the Cl attribute. For information about which Cl types each
population query manages, see "Integration TQL Queries" on page 105. In order to create a proper
XSL mapping, you must be familiar with the service and object names that Service Manager
publishes as Web services. For information on publishing tables and columns as Web service
fields, see the Service Manager help.

The following steps illustrate how to map a UCMDB CI attribute called host_vendor to a Service
Manager web service field called OSVendor.

To map a Cl attribute to a web service field:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Adapter Management.

3. Navigate to the Service Manager Adapter configuration files path: ServiceManagerAdapter9-
x > Configuration Files.

4. Click the XSL transformation file that manages the parent Cl type of your Cl attribute. For
example, open computer_population.xslt to add an attribute to the SM Computer Population
TQL query.

5. Find the element that defines the name of the Universal CMDB CI Type where the integration
will store Cl attribute values. For example, the element <ci class="node" > will store CI
attributes in the Universal CMDB Node CI Type.

6. Within the ci naming element (<ci class="node">), you will see an element of the following

format that defines how to transform each web service field into an Universal CMDB CI
attribute:
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<attribute name="UCMDB_CI_ attribute_name" type="UCMDB_CI attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of attribute in the Universal CMDB system.

UCMDB_CI_attribute_type is the type of attribute of the Universal CMDB system which this
integration supports. Currently the following types are supported: String, StringList, Integer,
Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the Cl during
population if this attribute has an empty value (true: ignore; false: not ignore).

Note:
= A StringlList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.

An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.
= Forinformation about time zone and date format configuration of the Date type, see

"How to Update the Time Zone and Date Format for the Integration Adapter" on page
32.

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

Cl attributes in the computer_population.xslt file are illustrated in the following screenshot:

1<xsl:styleshest versi "1.0™ xmlns:xsl="http://wWwwwW.w3.org,/1999/X5L/Transform™>
2 <x=1:template m " /RetrieveucmdbNodelistResponse™>
3 <topology>
4 <xsl:for-each select="instance">
5 <xsl:variable n
[
7
g
]
10 t
11 ring"»<xsl:value-of select="file.device/INSHame"/></attribute>
12 <attribute re="5tring"><xsl value-of select="concat('Building:"', $building,
13 <attribute "String"F<xslivalue-of select="file.device/053"/></attribute>
14 <attribute "default_gateway_ ip address”™ type="String"»<xsl:value-of =3 ="file.device/DefaultGatew:
15 <attribute . " type="String"»<xsl:value-of zelect= "< fattril
1a
17
18 <!
19 </eix
20 </xs]l: for-each>
21 </topology>
22 </xsl:template>
23 </x=sl:stylesheet>
24

Refer to the following screenshot to match Cl attributes in the ucmdbNode web service object:
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External Access Definition

Service Name: |'u.;mdb1ntegraﬁgn | [ released
Mame: ﬁoinngde |v| [ ceprecated
Object Mame: |un:mdec-de |
< Allowed Actions | i Expressions | < Fields |

Field I Caption I Type I:I

location Location

addlIPAddr [addIIP Address] AddlIPAddress

addlIPAddr [addISubnet] AddiSubnet

addiMacAddress AddMacAddress

bios.id BIOSId

operating.system as

05, VEersion OSVersion

physical.mem. total PhysicalMemory

serial.no. Serialo

wendor Vendor

cpulcpu.id] CpulD

cpulcpu.name] CpuName

cpulcpu. dock.speed] CpuClockSpeed

file. system[maount. point] MaountPoint |

file. system[disk. type] DiskType

file.system[file. system. type] FilesystemType

file. system[disk. size] DiskSize

asset.tag AssetTag

7. Copy an existing XSL transformation element to use it as a template to create a new

transformation entry.

8. Paste the new XSL transformation element within the proper table naming element. For

example, <ci class="node">.

9. Update the CI attribute name and web service field name within the new element to match the
attribute you want to add to the integration. For example, create the following XSL

transformation element to add the os_vendor attribute to the integration.

<attribute name="os_vendor" type="String"><xsl:value-of select="file.node/0S

Vendor"/></attribute>

New attribute in the computer_population.xslt fileis illustrated in the following screenshot:
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1 <xsl:stylesheet wversion="1.0" xmlns:xsl="http://www.w3.org/1999/X5L/Transform">
2 <xsl:template match="/RetrieveucmdbNodelistResponse™>

3 <topology>

4 <xsl:for-each ssl=ct="instance">
5

&

a

<x=l:variable n=z building” szelect="file.device/Building"/>
c i vice/Floor" />

10 < root attribute n.xslt-->

11 "priﬁ.ery_dns_n String"s<xslivalue-of zelect="file.device/ONSName"/></attribute>
12 <attribute name="calculated location™ type="3tring"><xsl:value-of select="concat('Building:"', sbuilding,
13 <attribute name="discovered 05 _name" type="3tring"><xsl:value-of select="Ifile.device/053"/>/attribute>

14 <attribute name="defzult_gateway ip address™ type="String"»<xsl:value-of ==l "file.device/DefaultGatew:
15 <attribute n "discovered ersion” type="3String"»<xsl:value-of select="file.node/05Version"/></attril
1la pe="Integer"><xsl :value-of select="file.nocde/PhysicalMemory"”/></attribute:
17 tring"»<xsl:value-of zslect="711 jef0SVendor” f><fattribute>

18

19 xslt--x

20 </fci»

21 </xsl:[or-each>

22 </topology>

23 </xsl:template>

24 </x=l:stylesheet>

2

[

10. Save the XSL transformation file.

When you create/edit and then save a configuration file in Adapter Management, UCMDB
automatically restarts the adapter with the new configuration file.

How to Add a Cl Type to the Integration for Population
You can use the following steps to add a Cl type to the integration for population.

1. Create a TQL query to populate the Cl type.
See "Create a TQL Query to Populate the Cl Type" below.

2. Map the Cl type's TQL query to an XSL transformation file.
See "How to Map the Cl type's TQL Query to an XSL Transformation File" on the next page.

3. Map the Cl type's attributes to web service fields.
See "How to Map the CI Type's Attributes to Web Service Fields" on page 179.

Create a TQL Query to Populate the Cl Type

Unlike for push, for population the integration does not require you to create custom Topology Query
Language (TQL) queries in Universal CMDB to save Cl attribute values.

The population feature only needs the smPopConfFile.xml file and population XSL transformation
files to synchronize CI/CI Relationship types and attributes; however for each CI/Cl Relationship
type you still need to define a TQL mapping in the smPopConfFile.xml file, and the TQL query does
not necessarily have to existin UCMDB. It is simply a query name, which will appear in the query
list when you add queries to a population job.

HP still recommends you to create TQL queries to help you better understand what Cl types or
attributes are part of population. For information on how to create a TQL query in UCMDB, see
"How to Create a TQL Query to Synchronize the Cl Type" on page 145.
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How to Map the Cl type's TQL Query to an XSL
Transformation File

The integration uses a configuration file called smPopConfFile.xml to map each Universal CMDB
TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, you must add a mapping entry for each TQL query in the configuration file.

To map the TQL query rdbmsData described in previous sections to the Service
ManagerucmdbRDBMS web service:

To map a TQL query to an XSL transformation file:
1. Loginto UCMDB with an administrator account.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. Add a TQL mapping element by copying an existing one. A TQL mapping element uses the
following format:

<tql name="TQL_query" xslFile="XSL_ File">
<request type="Retrieve"
dataType="Data_Type"

retrieveFileList="Retrieve SM Tables"
retrieveKeysQueryName="Retrieve_keys_web_service"
retrievelListQueryName="Retrieve_Objects_web_service"
ballQueryCondition="Full_Query_Condition"
changedUpdateQueryCondition="Changed_Update_Condition"
changedDeletionQueryCondition="Changed_Deletion_Condition"/>

</tql>

TQL_query is a TQL query name. The TQL query does not have to exist in UCMDB.

XSL_Fileis the name of the XSL transformation file that the integration will use to map Service
Manager web service fields to Universal CMDB attributes.

Data_Type is the type of the object retrieved from Service Manager. The possible values are

ci” and “relationship”.

Retrieve_SM_Tables is the table name list in the Service Manager web service configuration;
if you define the WSDL on a join definition, you need to list all the table names of the join
definition to which the fields of XSLT mapping belongs; if you define the WSDL on a simple
table, simply leave Retrieve_SM_Tables empty. You can also check this by opening the
WSDL URL: http://<SM server>:<port>/SM/7/<object name>.wsdl. For example, out-
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of-the-box, the instance type of ucmdbNode is as shown in the following figure, so the
Retrieve_SM_Tables value is file.device, file.node.

SM tables of the ucmdbNode instance type in the ucmdbNode WSDL are illustrated in the
following screenshot:

- <xs:complexType name="

- <¥5.5equencez

- «xs:element name="{il

e.aevice >

- <xs:complexType=
- =xs:complexContent=
- «<xs:extension base="cmn:StructureType">
- <¥sisequencex

<HS:
<XS:
<XS:
<XS:
<XS:
<XS:
<XS:
<XS:
<XS:
<XS:
<XS:
relement minOccurs="0"
<XS:
relement minOccurs="0"
<XS:
relement minOccurs="0"

<XS5

<XS5

<XS

element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"

element minOccurs="0"

element minOccurs="0"

</xs:sequence>
</xs:extension=
</xs:complexContent =
</xs:complexType =
</x5:elements
- «<xs:element name="fl= noda">
- <xs:complexType=
- <xs:complexContent=
- <xs:extension base="cmn:StructureType"=
- <¥SISequence

- =xs:element minOccurs="0" name

- <xs:complexType=

name="CIIdentifier" nillable="true" type="cmn:StringType" />
name="Vendor" nillable="true" type="cmn:StringType" /=
name="DNSName" nillable="true" type="cmn:StringType" /=
name="SerialNo" nillable="true" type—"cmn'stringType“ =
name="Location" nillable="true" type="cmn:StringType" /=
name="Type" nillable="true" type="cmn:StringType" /=
name="CIName" nillable="true" type—"cmn'stringType" =
name="Subtype" nillable="true" type="cmn:StringType" /=
name="Building" nillable="true" type="cmn:StringType" />
name="Floor" nillable="true" type="cmn:StringType" /=
name="Room" nillable="true" type="cmn: StrlngType"’
name="AssetTag" nillable="true" type="cmn:StringType" />
name="08" nillable="true" type="cmn:StringType" />
name="CustomerId" nillable="true" type="cmn: StrlngType" =
name="DefaultGateway" nillable="true" type="cmn: StrlngType” [
name="UCMDBId" nillable="true" type="cmn:StringType" />

="addlIPAddr":

- =xs:complexContent=
- =xs:extension base="cmn:ArrayType":>

Retrieve_keys_web_service is the name of the Service Manager web service that you want
the integration to use to retrieve a Cl Key list from Service Manager.

Retrieve_Objects_web_service is the name of the Service Manager web service that you
want the integration to use to retrieve a Cl Object list from Service Manager.

Basic_Query_Conditionis aninternal Query Condition of Service Manager that you want the
integration to use to retrieve a Cl list from Service Manager for a Cl type; it is used as the basic
condition for a full or changes population.
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Full_Query_Condition is an additional internal Query Condition of Service Manager. Along
with the Basic_Query_Condition, it is used to retrieve a list of all Cls from Service Manager for
a full population.

Changed_Update_Condition is an additional internal Query Condition of Service Manager;
along with the Basic_Query_Condition, it is used to retrieve a list of updated Cls from Service
Manager since the last job execution; it includes both updated Cls and newly created Cls. It is
used for a changes population.

Changed_Deletion_Condition is an additional internal Query Condition of Service Manager;
along with the Basic_Query_Condition, it is used to retrieve a list of deleted Cls from Service

Manager since the last job execution. It is used for a changes population.

The following figure shows an excerpt of the smPopConfFile.xml:

Resourcedizcovery ConfigFiles/Service Manager AdapterS-xizmPop Conf File xml

Q@ E &

1T <oom Figs

2 <global-config>

3 <request type="Retrieve" cmdb-id-cnly="false"/>

4 </global-config>

] <mapping>

[ <tgl neme="5M Business Service Population™ xslFile="business_service population.xslt™>
7 <request type="Retriewve" dataTlype="ci™

g ieveFilelizt="file.device™”

g .

0

eysfuerylame="RetrieveucmdbBusinessServicekeyslistRequest™
1 lame="RetrieveucmdbBusinessServicelistRequest™

type=squot;bizservicesquot; ™

11 Lk c{
12 £ cue "istatus~=szquot;Retired/Consumedsquot; ™
13 c god ondition="crcatcd.by.datcegt; " {fromDate} ' and istatua-—sguo
14 c ge on="created.by.datezlt;="[fromDate]"' and devicemcdtimes
15 changedDeletionfueryCondition="devicemocdtimesgt; ' [fromDate}l " and istatus=squot:R
16 </tgl>
17 <tgl neme="5M Computer Fopulation” xslFile="computer population.xslt™>

4 i 3

L3

4. Add or update TQL mapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates a mapping between the rdbmsData TQL query and the
rdbms_population.xslt file.
<tql name="rdbmsData" xslFile="rdbms_population.xslt">

<request type="Retrieve" dataType="ci"
retrieveFilelList="file.device,file.rdbms"
retrieveKeysQueryName="RetrieveucmdbRDBMSKeysListRequest"
retrievelListQueryName="RetrieveucmdbRDBMSListRequest"
basicQueryCondition="type#&quot;rdbms&quot;"

fullQueryCondition="istatus~=&quot;Disposed/Retired&quot;
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changedUpdateQueryCondition="(devicemodtime>'{fromDate}"' or (devicem
odtime=NULL and created.by.date>'{fromDate}')) and istatus~=&quot;Disposed/R
etired&quot;"

changedDeletionQueryCondition="devicemodtime>'{fromDate}' and istatu
s=&quot;Disposed/Retired&quot;"/>

</tql>

The following figure shows the above-mentioned TQL mapping elements in the
smPopConfFile.xml file:

<tgl name="rdbmsData™ XslFile="rdbm= population. xalt™>
<request type="Retrieve™ datalvps="ci"

retrieveFileList="file.device,file.rdbms"
retrievekeys_uerylame="RetrieveucmdbRIEMSKeysListRequest™
retrievelistCueryvlame="RetrieveucmdbEIPM5T.i stRequest™
basicfuerylondition="type#sequot; rdbmazquot ;™
fullfueryCondition="istatus-=gquot;Disposed/Eetiredsquot =™
changediipdatefuerylondition="(devicemodtime>" {fromDate}" or (devicemodtime=NULI
changedDeletionguerylondition="devicemodtime>" {fromDate]l ™ and istatus=squot;Di:

</l

</mapping>

The following figure shows an excerpt of the ucmdbRDBMS WSDL for your reference:
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- =xs:complexType name="
- <xs:isequence:
<xs:element minQccurs="0" name="CTT aniiMar" nillable="true" type="cmn:StringType" />
</¥s:sequence:
<xs:attribute name="query" type="xs:string" use="optional" /=
<xs:attribute name="updatecounter" type="xs:long" use="optional" /=
</xs:complexType>
- <xs:complexType name="
- <xs:sequence:x
- <xs:element name="{lle.device">
- <xs:complexType:
- <¥s:complexContent>
- <xs:extension base="cmn:StructureType"=
- <xs:sequencex
<xs:element minQccurs="0" name="CIIdentifier" nillable="true" type 'cmn:StringType" /=
<xs5:element minQccurs="0" name="Vendor" nillable="true" type '‘cmn:StringType" />
<xs:element minCccurs="0" name="Type" nillable="true" type="cmn:StringType" /=
<xs:element minQccurs="0" name="CIName" nillable="true" type="cmn:StringType" />
<xs:element minCccurs="0" name="Description" nillable="true" type 'cmn: StrlngType" =
<xs:element minQccurs="0" name="Version" nilable="true" type="cmn:StringType" /=
<xs:element minCccurs="0" name="SubType" nillable="true" type="cmn:StringType" />
<xs:element minCccurs="0" name="CustomerId" nillable="true" type—"cmn'stringType" =
<xs:element minQccurs="0" name="ApplicationName" nillable="true" type="cmn:StringType" /=
<xs:element minCccurs="0" name="UCMDBId" nillable="true" type="cmn: StrlngType" =
<xs:element minQccurs="0" name="ProductVersion" nilable="true" type="cmn:StringType" /=
= ¥s:sequence:
= xs:extension:
</¥s:complexContent>
</x¥s:complexType>
=/xs:element>
- <xs:element name="llle.rdl =
- «<xs:complexType:
- «<xs:complexContent>
- «<xs5:extension base="cmn:StructureType":>
- <xXs:sequencex
<Xt element mmOccurs-"U" name—"DBInstance nlllable "true type="cmn:StringType" />

5. Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the Cl Type's Attributes to Web Service
Fields

The integration uses the Service Manager Adapter to transform Service Manager web services
objects to Universal CMDB CI attributes. The Service Manager Adapter uses XSL transformation
files to convert a properly formatted Service Manager web services messages into Universal
CMDB CI. Out-of-the-box, each integration query has a corresponding XSL transformation file. In
addition, each attribute you want to populate to Universal CMDB requires its own entry in the XSL
transformation file.

If you want to add a Cl type to the integration, you must create a matching XSL transformation file
that defines how the Service Manager Adapter transforms each Service Manager web service field
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into a Cl type. In order to create a proper XSL mapping, you must be familiar with the service and
object names that Service Manager publishes as Web services. For information on publishing
tables and columns as Web service fields, see the Service Manager 9.33 Web Services Guide.

To create an XSL transformation file for the SM RDBMS CI type, which is described in previous
sections:

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management.

3. Click the Create new resource button

4. Select New Configuration File.
5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name using this format: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms_population.xslt.

7. Copy the content of an existing XSL transformation file to use it as a template to create the
new transformation file. For example, copy the content of business_service
population.xslt tothe new file.

8. Find the web service response name definition element, which uses the following format:

<xsl:template match="/SM_WEBSERVICE_RESPONSE_NAME">
SM_WEBSERVICE_RESPONSE_NAME is the name of web service response in the Service Manager
system.

The following figure shows an example of Web Service response definition in business_
service_population.xslt:

<xsl:stylesheet version="1.0" xmlns:xsl="http://uwuww.w3.org/1999/XSL/Transf &
orm>
{¥sl:template match="/7c701 ibBusi S icelListRes| s
{topology>
{¥sl:for-each select="instance'>
<cl class="business_service">
{*——import:cmdb_root_attributes_population.xslt-->
{attribute mame="provider" type="String"><{xsl:value-of
select="file.device/ServiceProvider”/></attribute>
<fcir
<fusl:for-each>
{/topology>
</xs1:templatef]
</usl:stylesheet> x|
11,16-19 All

9. Update the web service response name to match the response name that you want to add to
the integration. For example, you can create the following Cl type definition element to add the
database response of retrieve object list to the integration.
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10.

11.

12.

<xsl:template match="/RetrieveucmdbRDBMSListResponse">
Find the Universal CMDB ClI type definition element, which uses the following format:
<ci class="UCMDB_CI_TYPE_NAME">

UCMDB_CI_TYPE_NAME is the Cl type name in the Universal CMDB System.

The following figure shows an example Cl type definition in business_service
population.xslt:

Kxsl:stylesheet version=""1.8" xmlns:xs1="http://wuww.w3 . org/1999/8SL/Transfor &
m* >
<¥sl:template match="/RetrieveucmdbBusinessServicelListResponse'>
{topology>
<¥sl:for—-each select="instance">
<ci class="hus! i ice">
{*——import:cmdb_root_attributes_population.xslt-->
{attribute name="provider" type="String"><zsl:value—of 5
elect="file.device/ServiceProvider"/></fattribute>
<fci>
/x5l i Ffor—each>
</topology>
</fisl:template>
</xs1:stylesheetf =|
12,17 All

Update the Universal CMDB CI type definition name to match the name you want to add to the
integration. For example, create the following CI type definition element to add the database
response of retrieve object list to the integration.

<ci class="sm_rdbms">

Note: Do not use any variables in the CI type definition name. The CI type definition name
must be a fixed value.

Find the elements that transform Service Manager web service fields into Universal CMDB CI
attributes. The CI attribute transformation elements use the following format:

<attribute name="UCMDB_CI_ attribute_name" type="UCMDB_CI attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of the CI attribute in the Universal CMDB system.
UCMDB_CI_attribute_type is the type of the Cl attribute in the Universal CMDB system that

this integration supports. Currently the following types are supported: String, StringList,
Integer, Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the CI during
population if this attribute has an empty value (true: ignore; false: not ignore).
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Note:
= A StringList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.

An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.

= Forinformation about setting a time zone and date format for the Date type, see "How
to Update the Time Zone and Date Format for the Integration Adapter" on page 32.

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

See the following figure for an example of Cl attributes in business_service_

population.xslt:
{xsl:stylesheet version=""1.08" xmlns:xsl="http://uwww.uw3.org/1999/5SL/Transf =]
orm'>
{xsl:template match="/RetrieveucmdbBusinessServicelListResponse™>
<topology>
{xsl:for-each select="instance”>
{ci class="husi i ice">
{t--import:cmdb_root_attributes population.xslt-->
{attribute name=""| Tder™ type="String"><{xsl:value-of
select="file._device/ServiceProvider”/><{/attribute>
<fcir
{f¥sl:for-each>
<ftopology>
</xs1:templatef]
<fxsl:stylesheet> x|
11,16-19 All

Refer to the following screenshot to match Cl attributes in the Universal CMDB
BusinessService Cl type:

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 182 of 248



Cl Types

Dependencies | Details || Aftributes | Guslfiers lcon | Aft:

= Managed Ohbject (9)
—[®] ActivityLog (0)
@] Asset ()
— Atachment (0)
(@] Budaet )
—[®] BudgetLine @)

Cl Types || % 3

o

50

B3]
E-[g]
—(
BF]
(]

4

— Business Objective (0)
() Corfigurationtsm (9)

BusinessElement (4)
O Business Service Viev
Businessactivity (0)
@ Businessapplication (1
BusineszFunction (1)
Ij BusineszProcess (D)
@ BusineszTranzsaction
O Datacernter (0)
85 Service (2)
@J Business Service |
& Infrastructure Sery
CiCollection (D)
InfrastructureElement ()
Location (0)
Ionitor (0}

Farty {0}
] 3

b3

-

Thiz page enables you to edit the attributes of the Cliype.

+ & K I

= Display Mame | Marme Type | Description | Default WValue
Last Access Time root_|astaccesstime date When was ...
Last Modified Time last_modified_time date When was ...
layer layer layer_enum business_..
MENU MENU ®ml <MEMU=<...
Mote data_note string
Operation Corr State | data_operationcorrs...  operstionst...  Operation ... Normal
Operation |z New data_operationisnew boolean Operation ...  false
Operation State data_operationstate operationst...  Operation ...  MNormal
Owner Tenant Tenart Owner string The Tenan...
Provider string Service Pr...
Provizion pravision string Service Pr...
Store KPI History Fo... | is_save_persistency | boolean Store KPLh...  true
System root_system string

4

Refer to the following screenshot to match Cl attributes in the Service Manager
ucmdbBusinessService web service:

External Access Definition

Service Name: | O released

|'un:mdentegration

Mame: Foinbizservice |v| O peprecated
Object Mame: |uu‘ndeusinessService |
& Allowed Actions | & Expressions | & Fields |

Field | Caption | Type

ucmdb.id UCMDBEId

d.name ServiceMame

type Type

subtype Subtype

company CustomerId

logical.name Clldentifier

vendor ServiceProvider

id CIMame

13.

In the SM RDBMS population example, there are no sub items of a Cl. If you want to populate

the sub items of a Cl, for example, to populate the IP addresses of a computer together with
the computer Cl, you need to add a “link” element under the “ci” element. A link transformation
element uses the following format:
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<link direction="Link_Direction" 1linkType="UCMDB_Link_Type">
<ci class="UCMDB_SUB_CI_TYPE_NAME">

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_ attribute_typ
e">
<xsl:value-of select="SMAttributeName "/></attribute>

<attribute name="UCMDB_CI_attribute_name2" type="UCMDB_CI_attribute_ty
pe2">
<xsl:value-of select="SMAttributeName 2"/></attribute>

</ci>
</xsl:for-each>

</link>

Link_Direction is the direction between a parent Cl and sub CIl. The supported directions
are:

= outgoing: The link direction is from an upstream CI to the current downstream CI (for
example, from node to ip_address).

= incoming: The link direction is from a downstream CI to the current upstream CI.

UCMDB_Link_type is the relationship type in the Universal CMDB system.

The following figures show the out-of-the-box configurations for populating the Computer ClI
together with its IP addresses:
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<{¥sl:template match="/RetrieveucmdbHodeListResponse">
{topology>
<®sl:for—each select="instance">
{xsl:variable name="building” select="file.device/Building”/>
<¥sl:variable name="'floor" select="file.device/Floor"/>
<xsl:variable name="roon" select="file.device/Room"/>

<ci class=""node">

{*——import:cmdb_root_attributes_population.xslt-->

<attribute name="primary_ dns_name" type="String"><{xsl:value—
of select="file.device/DHSHame"/><{/fattribute>

<attribute name="calculated location" type="String"><xsl:wal
ue-of select="concat({'Building:', %building, 'Floor:', $floor, 'Room:', Sroom)"/
»<{fattribute>

{attribute name=""discovered_os_name" type="String"><{xsl:valu
e-of select="file.device/05"/><{/attribute>

{attribute name="default gateway ip_ address" type="String"><
xsl:value—of select="file.device/DefaultGateway”/></attribute>

{attribute name="discovered os version" type="String"><{xsl:w
alue—of select="file.node/0SVersion”/><{/attribute>

<attribute name="memory size" tEpe="Integer"><xsl:ualue—nF 5
elect="file.node/PhysicalMemory"/><{fattribute>

{t--import:cpu_mapping population.xslt-->

{*——import:disk_device_mapping_population.xslt-->

<t--import:filesystem_mapping_population.xslt-->

-1 =

{*——import:interfaces_mapping_population.xslt-->

<fci>
{/xsl:for—each>
</topology>
{fxsl:template>
</fusl:stylesheet>
16,52 All

{xsl:stylesheet version="1.0" xmlns:xsl="http://uvww. w3 . org/1999/XSL/Transform"> 4|

FY

[

Link definition in the import xslt file (ips_mapping_population.xslt)is illustrated in the
following screenshot:

<1link direction="gutgaing”’ linkType=""mmmiad nit> =
{xsl:for-each select="717 le/addlIPAddr/addlIPAddr'>
{ci class="ip_add S
{attribute mame="'namnz" type="String"><{xsl:value—of select

="AddlIPAddress”/><fattribute>

{attribute name="data_externalid" type="3tring”><{xsl:valu
e—of select="AddlIPAddress"/><{/attribute>

{attribute mame="1ip_ netmask" type="String"><{xsl:value-of
select="Add1lSubnet"/>{/attribute>

{fcix
</#sl:for-each>
</link> j
2.7 All

Refer to the following screenshot to match Cl attributes and links in the Service Manager
WSDL(http://<SM server>:<port>/SM/7/ucmdbNode.wsdl):
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- <xs:complexType name="ucmdbNodeInstanceType"=
- <xsiseguence:
- «xs:element name="file.device"=
- <xs:complexType >
- «xs:complexContent=
+ <xs:extension base="cmn:StructureType">
</xs:complexContent=
<fxs:complexType=
</xs:element=
- =xs:element name=
- <xs:complexType>
- «xs:complexContent>
- <xs:extension base="cmn:StructureType">
- <xsiseguence:
- <xs:element minOccurs="0" name="addTDAAd".
- <xs:complexTypex
- «xs:complexContent=
- =xs:extension base="cmn:ArrayType">
- <¥sisequence:
- =xs:element maxOccurs="unbounded" minOccurs="0" name="addITDAdAr"
- <xs:complexType>
- «xs:complexContent=
- «xs:extension base="cmn:StructureType">
- <x5:sequence:>
zxs:element minOccurs="0" name="AddlIPAddress" nillable="true" type="cmn:StringType" />
<xs:element minOccurs="0" name="AddISubnet" nillable="true" type="cmn:StringType" />
</¥s:sequencex
</xs:extension=
</xs:complexContent=
</xs:complexType:=
~fvaralamant

1T =T P

=

Refer to the following screenshot to match Cl links in UCMDB at the TQL level:

.i.t Compositio
B

Interface

IpAddress

Note: The Matching ClI links in UCMDB at the TQL level figure is provided here only to
give you a graphic view of how relevant Cls are stored in UCMDB. You do not need to
create the TQL query, since the population feature does not require it.

Refer to the following screenshot to match ClI type and attributes in the UCMDB CI Type
(IpAddress):
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14. Add or update the CI attribute transformation elements for each CI attribute you want to add to
the integration. For example, you can use the following XSL transformation elements for the
database Cl type.

Sample XSL transformation elements for database Cls

UCMDB
attribute

discovere
d_product_
name

product_
name

Sample transformation elements

<attribute name="discovered_product_name" type="String">
<xsl:value-of select="file.device/CIIdentifier"/></attribute>

<attribute name="product_name" type="String">
<xsl:value-of select="file.device/ApplicationName"/></attribut
e>

application_  <attribute name="application_version" type="String">

version

vendor

HP Service Manager

<xsl:value-of select="file.device/ProductVersion"/></attribute>

<attribute name="vendor" type="String">
<xsl:value-of select="file.device/Vendor"/></attribute>
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Sample XSL transformation elements for database Cls, continued

UCMDB
attribute Sample transformation elements
version <attribute name="version" type="String">

<xsl:value-of select="file.device/Version"/></attribute>

dbinstance  <attribute name="dbinstance" type="String">
<xsl:value-of select="file.rdbms/DBInstance"/></attribute>

port <attribute name="port" type="String">
<xsl:value-of select="file.rdbms/Port"/></attribute>

description | <attribute name="description" type="String">
<xsl:value-of select="file.rdbms/Description"/></attribute>

Attribute mappings in rdbms_population.xslt are illustrated in the following screenshot:

<xsl:stylesheet version=""1.0" xmlns:xsl="http://wwu. w3 . org/1999/XSL/Transform"> &
{xsl:template match="/RetrieveucmdbRDBMSListResponse™>
{topology>
{xsl:Ffor-each select="instance’>
<ci class="sm_rdbms">

<t--import:cmdb_root_attributes population.xslt-->

<attribute name=""discovered_product_name" type="String"><{xsl
:value-of select="file.device/CIIdentifier"/></attribute>

{attribute name="product_name" type="String"><xsl:value-of s
elect="file.device/ApplicationHame"/></attribute>

<attribute name="application_wversion" type="String"><xsl:val
ue-of select="file._device/ProductUersion"/><{fattribute>

<attribute name="vendor" type="String"><{xsl:value-of select=
"file.device/Uendor"/><{/fattribute’

<attribute name="version" type="String"><{xsl:value-of select
="file.device/Version”/><{/attribute>

{attribute name="dbinstance" type="String"><xsl:value-of sel_|
ect="Ffile.rdbms/DBInstance”/><fattribute’

<{attribute name="port" type="String"><{xsl:value-of select="'f
ile.rdbms/Port”/><{/attribute>

{attribute name=""description” type="String ><{xsl:value-of se
lect="file.rdbms/Description”/></attribute>

<feci>
<f#sl:for—each>
{/topology>
<fusl:template

</xslistylesheet>

I

—— SELECT — 8 14,189-124 All

15. Save the XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.
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How to Add a Cl Type’s Relationship Types to the
Integration for Population

Once you have added a new ClI type to the integration for population, you need to add the new CI
type’s relationship types to the integration. For each relationship type, perform the following tasks.

As an example, the following steps describe how to add the Ownership relationship type to the
integration; these steps assume that you have already added the Cost and CostCategory Cl types
to the integration for population.

1. Create an XSL transformation file to map each relationship type’s attributes to web service
objects.
See "How to Map Each Relationship Type's Attributes to Web Service Objects" below.

2. Add a TQL mapping for each relationship type to the population configuration file.
See "How to Define a TQL Mapping for Each Relationship Type" on page 191.

How to Map Each Relationship Type's Attributes to Web
Service Objects

This example illustrates how to create an XSL transformation file to map the attributes of the
Ownership relationship type to web service objects.

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management.

3. Click the Create new resource button
4. Select New Configuration File.
5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name using this format: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/cost_to_costcategory_population.xslt.

7. Click Yes toignore the file extension warning. The file is added to the Configuration Files
folder.

8. Copy the content of an existing relationship population XSLT file (for example, computer_to_
computer_connects_population.xslt)tothe new XSLT file.

Note: In the next step, you will update the <ci class> names and link Type value.
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m">

<xsl:template match="/RetrievecirelationshipltolListResponse">
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<topology>
<xsl:for-each select="instance">
<ci class="node">

<attribute name="name" type="String"><xsl:value-of selec
t:
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="tcp">
<ci class="node">

<attribute name="name" type="String"><xsl:value-
of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-
of select=
"downstreamci.id"/></attribute>

</ci>
</1link>
</ci>
</xsl:for-each>
</topology>
</xsl:template>

</xsl:stylesheet>

Change the <ci class> names to cost and cost_category, and linkType to ownership.

<ci class="cost">

<attribute name="name" type="String"><xsl:value-of selec
t:
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="ownership">

<ci class="cost_category">
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ci class: the name (not display name) of the each CI type involved in the relationship. It
should be the Name field value on the General Details tab of the Cl type definition.

1linkType: the name of the relationship type. It should be the Name field value on the General
Details tab of the relationship type definition.

Note: In this example, you do not need to change the link direction (outgoing). This is
because the relationship (Ownership) direction is from cost to cost_category, that is, from
a <ci class> outside of the <link> element to a <ci class> inside it).

10. Save the XSL transformation file.

How to Define a TQL Mapping for Each Relationship Type

For each relationship type of the new CI type, you need to define a TQL mapping in the
smPopConfFile.xml file.

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. Inthe smPopConfFile.xml file, add a TQL mapping for the relationship type, by copying an
existing TQL mapping element.

Note: In the next step, you will update the highlighted values with values of the new
relationship type.

<tgl name="SM Biz To Biz With Usage"
xslFile="businessservice_to_businessservice_usage_population.xslt">

<request type="Retrieve" dataType="relationship"
retrieveKeysQueryName="RetrievecirelationshipltolKeysListRequest"
retrievelListQueryName="RetrievecirelationshipltollListRequest"

basicQueryCondition="upstreamci.type=&quot;bizservice&quot; and
downstreamci.type=&quot;bizservice&quot; and
relationship.subtype=&quot;Usage&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt;"'{fromDate}"' and
status~=&quot;Removed&quot;"

changedUpdateQueryCondition="created.datetime&lt;="{fromDate}"' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt;'{fromDate}"' and
status=&quot;Removed&quot;"/>
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</tql>
4. Update the TQP mapping element with the values of the new relationship type.

Note: For the TQL name, you can enter any descriptive name as you like (for example, SM
Cost to CostCategory with Ownership). This TQL query does not really exist,
since population does not require it.

The upstreamci.type, downstreamci.type, and relationship.subtype values are defined in
the cirelationship1to1 table in Service Manager.

<tgl name="SM Cost to CostCategory with Ownership"
xslFile="cost_to_costcategory_population.xslt">

<request type="Retrieve" dataType="relationship"
retrieveKeysQueryName="RetrievecirelationshipltolKeysListRequest"
retrievelListQueryName="RetrievecirelationshipltollListRequest"

basicQueryCondition="upstreamci.type=&quot;cost&quot; and
downstreamci.type=&quot;costcategory&quot; and
relationship.subtype=&quot;Ownership&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt; "' {fromDate}"' and
status~=&quot;Removed&quot;"

changedUpdateQueryCondition="created.datetime&lt;="{fromDate}"' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt;'{fromDate}"' and
status=&quot;Removed&quot;"/>

</tql>

5. Save the population configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Now the relationship type is added to the integration for population. Next, you need to add the
relationship TQL name you specified in the population configuration file (in this example, SM Cost
to CostCategory with Ownership) to a relationship population job, so that the integration can
populate this type of relationships to UCMDB. See the following figure and also "How to Add
Custom TQL Queries to Integration Population Jobs" on page 195.

Refer to the following screenshot to add a new relationship TQL name to a relationship population
job:
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How to Customize UCMDB ID Pushback for a Cl Type

Out-of-the-box, UCMDB pushes the UCMDB ID of each CI type back to Service Manager during
population, by calling a Service Manager web service (ucmdbIDPushBack) based on the

ucmdbid.pushback.request and ucmdbid.pushback.xs1t settings in the sm.properties file in
UCMDB (see "How to Update the Integration Adapter Configuration File (sm.properties)" on page

119).

To better suit your business needs, you can make the following tailorings to the ucmdb id pushback
feature, using the <idPushbackConfigurations> element in the ServiceDeskConfiguration.xml

file:

e "How to Disable the UCMDB ID Pushback Feature for a Specific Cl Type" on the next page

e "How to Define a Custom Pushback Web Service and xslt File for a Specific Cl Type" on the

next page

Note: For a specific UCMDB class (Cl type), its definitions in the
ServiceDeskConfiguration.xml file supercede the following global settings in the

sm.properties file:

¢ idPushbackEnable: Inthe sm.properties file, this setting is not present; however, out-of-

the-box, it is set to true for all Cl types.
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¢ idPushbackRequest: In the sm.properties file, its out-of-the-box value is
UpdateucmdblDPushBackRequest.

e idPushbackXSLT: Inthe sm.properties file, the out-of-the-box value is ucmdbid_

pushback.xslt.

How to Disable the UCMDB ID Pushback Feature for a

Specific Cl Type

You may want to disable the pushback feature for certain UCMDB ClI types, for example, UCMDB
classes that are mapped to a sub-item type (IP Address, CPU, etc.) in Service Manager. Doing so
can aviod unnecessary system overload.

To disable the pushback feature fora UCMDB CI type (class), use this format:

<idPushbackConfiguration ucmdbClassName="<ucmdbClassName>" idPushbackEnable="fal

se"/>

Where, <ucmdbClassName> is the name of the UCMDB CI type.

Here are the out-of-the-box settings in the ServiceDeskConfiguration.xml file:

<idPushbackConfigurations>
<idPushbackConfiguration
<idPushbackConfiguration

<idPushbackConfiguration
e"/>

<idPushbackConfiguration
e"/>

<idPushbackConfiguration

</idPushbackConfigurations>

ucmdbClassName="interface" idPushbackEnable="false"/>
ucmdbClassName="cpu" idPushbackEnable="false"/>

ucmdbClassName="disk_device" idPushbackEnable="fals

ucmdbClassName="file_ system" idPushbackEnable="fals

ucmdbClassName="ip_address" idPushbackEnable="false"/>

To enable the pushback feature for a Cl type, set idPushbackEnable="true" forit.

How to Define a Custom Pushback Web Service and xslt
File for a Specific Cl Type

There are occasions when you need to define a custom pushback web service and XSLT for a
specific Cl type (class), for example, when a Cl type you want to populate is not stored in the
device table in Service Manager. This is because the out-of-the-box ucmdbIDPushBack web

service is based on the device table.

For example, you have tailored the integration in order to populate the Functional Group from
Service Manager to UCMDB. If the Functional Group in Service Manager is not stored in the device
table, you can define a custom web service and XSLT like the following:

<idPushbackConfigurations>
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<idPushbackConfiguration ucmdbClassName="functional_group"
idPushbackEnable="true"
idPushbackRequest="UpdateucmdbIDPushBackForFunctionalGroupRequest"
idPushbackXSLT="ucmdbid_pushback_functionalgroup.xslt"/>

......

</idPushbackConfigurations>

Note: To support your pushback customizations, you need to create the specified custom web
service record in Service Manager and XSLT filein UCMDB.

How to Add Custom TQL Queries to Integration
Population Jobs

In order for the integration to send your custom Service Manager web service object and fields to
your UCMDB system, you must add your custom TQL queries to the population job between your
Service Manager data store and your UCMDB data store. The following steps illustrate how to add
the custom rdbmsData TQL query described in previous sections.

To add custom TQL queries to population job definitions:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.

3. Double-click the name of your Service Manager integration point. For example, SM
Integration.

4. Click the Population tab.

5. Select a population job. For example, SM Configuration Item Population job.

6. Click the Edit Integration Job button & .

7. Click the Add button ¥ .
The TQL names configured in the smPopConfFile.xml file are listed.

8. Click Root > rdbmsData.
9. Click OK to add a custom query.

10. Click OK to close the Update Job Definition window.
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How to Add an Attribute of a Supported Cl Type for
Federation

Out-of-the-box, the integration supports federation for three external Cl types in UCMDB: Incident,
Problem, and RequestForChange.

For each of the supported Cl types, there is alist of attributes in UCMDB that you can map to
Service Manager web service objects for federation. The following figure shows the out-of-the-box
UCMDB CI attributes available for the Incident CI type.

Incident Cl attributes supported for federation are illustrated in the following screenshot:

Sm_integration Population || Federation || Data Push

Federation retrieves Cl Types and attributes when a query is run or a view is displayed
Integration of type Federation defines a Data Source with the Integration Point's name

Supported and Selected Cl Types Cl Type Retrieval Mode

il ja I —
E{'J & e () Retrieve Cls of selected Cl Type

= P :
(®) Retrieve selected attributes
= (2]

[ .
|I§£| Selected attributes will be retrieved from the Integration. The Cls must already exist in the
%] Problem

) PequestFor Change Select Aftributes

[activeProcess

[[]Actual Deletion Period
[Canow CI Update

O Category

[ closedTime

O CompletionCode

D Consumer Tenants

D Container

D Create Time

D Crested By

[[]peletion Candidate Period
O Ceszcription

[IDisplay Label =
e P

3

For example, to add an SM Incident attribute for federation, you need to expose the field in the SM
Ucmdblncident web service object and then map it to an appropriate UCMDB attribute (if one does
not already exist, you need to create it in UCMDB first).

The following figure shows the fields that are exposed in the UcmdbIncident web service object in
Service Manager:
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External Access Definition

Service Name: [Lcmdb[ntegratinn | [T Released
Marne: [prgbsummar}r | il | [7] Deprecated
Object Name: [Uemdeincident |

< Allowed Actions | < Expressions | ¢ Fields

Field Caption Type
lzgical.name Configurationltem

number IncidentID

brief.description BriefDescription

subcategory Category

severity Urgency

opentime OpenTime DateTimeType
update.time UpdatedTime DateTimeType
closetime ClosedTime DateTimeType
problem.status IMTicketStatus

affected.item Service

priority.code PriorityCode

initial.impact ImpactScope

You can expose more fields so that more Incident attributes can be federated to UCMDB. As an
example, the following describes how to add the “action” field in the Service Manager probsummary
(Incident) file for federation, by mapping it to a new UCMDB attribute named “details”.

Note: On the Incident form in Service Manager, the “action” field is labeled “Description”, which
describes the incident ticket in more detail. See the following figure.

Title | Systern crashes with message "not enough memery” while opening multiple applications

( Description [Heteoss ceach swith casccans nat ananak seesany while opening multiple applications

A description of the incident in more detail

file=probsummary
form=IM update.incident

("' field=action p)

To add an attribute of a supported CI type for federation:

1. Add the SM attribute to its web service object.
The following example describes how to expose the SM “action” field of Incident in the

Ucmdblncident web service object.
a. Loginto Service Manager as a system administrator.

b. Navigate to Tailoring > Web Services > WSDL Configuration.
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c. Enterthe following field values, and then click Search.
o Service Name: ucmdbIntegration

o Name: probsummary

The Ucmdblncident web service object displays.

d. Onthe Fields tab, add the following row:
© Field: action.

o Caption: Description

External Access Definition

Service Mame: [ucmdblntegration | [] Released
Marme: |prgb§ummar}r | i | [7] Deprecated
Object Name: [Ucmdbincident |
< Allowed Actions | < Expressions | < Fields

Field Capticn Type

logical.name Configurationltem

number IncidentID

brief.description BriefDescription

subcategory Category

severity Urgency

open.time OpenTime DateTimeType

update.time UpdatedTime DateTimeType

closetime ClosedTime DateTimeType

problem.status IMTicketStatus

affected.item Service

priority.code PriorityCode

initial.impact ImpactScope

action [ Deseription |

e. Save the web service object.

2. Map the SM attribute to a UCMDB attribute.
The following example describes how to map the SM “action” attribute to a new UCMDB

attribute named “details”.
a. Loginto UCMDB as an administrator.
b. Navigate to Modeling > Cl Type Manager.

c. BrowsetoltProcessRecord > Incident, and open its properties pane.
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d. Click the Add button to add a new attribute named “details” to the Incident Cl type.

| %] Edit Attribute S

Adtribute Name:
Display Mame: Dietailz
Scope:
Description: Incident details
Aftribute Type:
Primitive EnumerationsList
Value Size:

Drefault Value

4

© name: details

o

Display Name: Details

o Description: Incident details

o

Attribute Type: Primitive > List of strings (this is because the “action” field in SM is an
array)

e. Save the Incident Cl type record.

f. Navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files.

g. Click the ServiceDeskConfiguration.xml file.

h. Add a mapping entry for the “details” attribute in the Incident attributeMappings section, as
shown in the following.

<ucmdbClassConfiguration ucmdbClassName="incident">

<attributeMappings>
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<attributeMapping ucmdbAttributeName="reference_number"
serviceDeskAttributeName="IncidentID"/>

<attributeMapping ucmdbAttributeName="name"
serviceDeskAttributeName="BriefDescription"/>

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace"
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore"/>

<attributeMapping ucmdbAttributeName="urgency" serviceDeskAttribut
eName="Urgency"/>

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeName="
Description"/>

</attributeMappings>
Tip: The attribute mapping entry uses the following format:

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeNam
e="Description"/>

Where:

ucmdbAttributeName is the UCMDB attribute name in the Incident CI type definition
to which you want to map the SM attribute;

serviceDeskAttributeName is the field caption you defined in the SM web service
object.

For an SM attribute (for example, problem.status) that is a drop-down list, the attribute
mapping uses the following format (you only need to change the attribute names):

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace"
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore" />

i. Click OK to save thefile.
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Now the Description (field name: action) attribute of SM Incident has been added to the
integration for federation. You can run an Incident federation query in the UCMDB Modeling
Studio to see if the SM Description data is properly federated. For details, see "Examples of

Using Federation" on page 43.

The following figure shows an example where the Description of an SM incident ticket has

been federated to UCMDB as Details:

| %] Configuration [tem Properties ﬂ ]

I—g%l Configuration Item Properties

MName: IM10003 1D: =m_integration%:04incident %041 %0AINcidentID %30 STRING % 3D M1 0003 %04 Cl Type: Incident

% i a Export * | Quick fitter: | Cl= Type here to fiter properties
ActiveProcess =
Actual Deletion Period 40
Allow Cl Updste True
Category performance
ClosedTime
Completion Code
Conzumer Tenants L
Container I
Create Time Men Sep 3 2007 11:49 AM CST
Created By sm_integration
Deletion Candidate Period 20
Cescription

CDetaiIs [System crash with message not enough memory while openi.D_
Display Label IM10003 i
Enable Aging Falze
Escalated False
ExternalProcessReference
Glabal Id
Impact Scope user
Incidert Status work_in_progress
Incidert Type
Iz Candidate For Deletion False v]
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Chapter 6: Troubleshooting

When data push and population errors occur, you can check the error messages and the integration
log files to identify the root causes and fix the errors. This chapter describes the general

troubleshooting steps, as well as typical errors and solutions.

This section includes:

e "Troubleshooting Data Push Issues" below

e "Troubleshooting Population Issues" on page 227

Troubleshooting Data Push Issues

When data push errors or problems occur, you can check the error messages and the log file to

figure out the root causes and then fix the errors.

This integration uses the following error codes for data push.

Data push error codes

Error
code Description

-1 Unspecified error.

0 Success.

3 Resource unavailable.

28 Not authorized.

51 Record modified since last retrieved.

70 Invalid SOAP action / unrecognized application action.

71 Validation failed.

881 Cl does not exist in Service Manager.

882 Unable to remove the relationship because at least one of Cls involved in the

relationship does not exist in Service Manager.

When a data push job has failed, the job status becomes Failed. Troubleshoot the failed job as

follows:

e Check the error messages of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Push Job" on the next page.

e Check the log file for more details.
See "How to Check the Push Log File" on page 208.
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When a data push job was completed, but with partial records failed, the job status becomes
Passed with failures. Troubleshoot the failed records as follows:

e Check the error messages of failed Cls in the Universal CMDB studio.
See "How to Check the Error Messages of Failed Cls/Cl Relationships in a Push Job" on the

next page.

e Check the log file for more details.
See "How to Check the Push Log File" on page 208.

Once you have fixed the issues with the failed records, you can re-push them one by one or in
batches. For details, see "How to Re-push Failed CI/CI Relationship Records" on page 213.

How to Check the Error Message of a Failed Push Job

To check the error message of a failed job:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Select the integration point for this integration from Integration Point list.
4. Click the Data Push tab.
5. Select the job from Integration Jobs.

6. Click the Job Errors sub-tab, and double-click the Severity of a message from the list.
A popup window displays the detailed error message of this failed job. Following is an excerpt
of a sample error message indicating that an XSLT file was not found.

java.io.FilaNotFoundException: Resource:
business service push file not exist.xslt, was not found
at

com. mercury.topaz.cmdb. server. fecmdb . adapterstate.AdapterstateBesourceServerFacade
-openResocurceForReading (AdapterStateResourceServerFacade. java: 51}

at
com.mercury.topaz.cmdb. server, fcmdb. spl.adapter.environment.DatakdapterEnvironmen
tImpl .openResourceForReading (DataRdapterEnvironmentImpl . java: 119)

at
cofm. mercury. topaz . fomdb . adapters. serviceDeskbdapter . TransformUtils . readPrombile (T

rangformUtils.java:11l3)

at
com.mercury.topaz. fomdb. adapters. serviceDeskAdapter.push.XsltTransformer . createTe

mplates (XsltTransformer.java: 33)
«: . 36 mMOEre

& &
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How to Check the Error Messages of Failed Cis/Cl
Relationships in a Push Job

When a data push job is completed with partial records failed, in the Universal CMDB studio, you
can check the source Cl XML of Universal CMDB, the XSLT-transformed XML and the response
XML from Service Manager to see if the failure is caused by data issues.

To check the error messages of failed records in a data push job:

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio.

3. Select the integration point for this integration from Integration Point list.
4. Click the Data Push tab.

5. Select the job from Integration Jobs.

6. Click the Query Status sub-tab.

7. Double-click a query with failures. The Error Message and CI Count for each failed Cl Type
display.

s

Statistics || Guery Status || Job Errors

o

SM Push iob > SM Business Service Push

Error Message | Cl Type Cl Count
aliclation Check Fails Error from S @ BusineszApplication 3
Valiclstion Check Fails Error from SM LEI_J BuzineszService 1
‘Valiclation Check Fails Error from S t_b Infrastructure Service 2

8. Double-click an error message. A list of failed records displays.

9. Double-click a failed record.
The detailed error message of the record displays.
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|£: Error message for 2s1329226187110313

Q@G

Validation Check Failz Error from SM, return code 71, the error message i= "Validation failed”

C1 Push Details:

Source tree XML:

<7xml version="1.0" encoding="UTF-16"?=>

=businesz_elemert bdm Type="BusinessApplication" customer_id="1"
dizplay_label="as1329226187110313"
friendly Type="BusinessApplication"
dlobal_id="4de030e5ab82e02acceifcd7h57 adkhes”
id="4de030e5abi2el2accclfcd7he7a%es" name="azs1329226187110313">

Transformed XML:
=7uml verzion="1.0" encoding="UTF-15"7=
<Createucmdb Business Service Reguest>
=model>
<keysl>
=instance=
<UCMDEId=4del30e5abi2e02acccifcd7heTa%hee</UCMDEId=>
=Customerld>1=/Customer d=
=Type=hizzervice=/Type:=
<Subtype=Application Service</Subtypes
=ServiceName=as1329226187110313</ServiceName>
<Clldertifier>as132922618711031 3</Cllcentfier=
4 1}

The following is a sample error message that indicates a validation failure, and the root cause
is that a not-null key (key definition #18 of the device table) contains an empty value.
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Validation Check Fails Error from S5M, return code 71, the error message is
"Validation failed",

CI Push Detanls:

Source tree XML:

<ncde bdmType="Node" customer id="1"

display label="X¥MAlG.asiapacific.hpgcorp.net" friendly-Type="Windows"
global id="fd21b94ddf26dcteelSdelladcaiddc0”
id="fd21b84ddi26dcY%e054e2ladcaidd4cl” os_vendor="Microsoft"

primary dns name="XMAl6.asiapacific.hpgcorp.net">

<ip addresss direction="outgoing" linkLabel="Containment" linkName="32"
linkTyvpe="Containment™>

<ip address bdmType="Iphddress" customer_ id="1"
friendl yType="IpAddress” id="bd03e3418%cT13898712dcac500730ba"™
name="16.158.154.152" realRelationType="Containment" />

<fip addresss>

<interfaces direction="outgoing" linkLabel="Composition™ linkName="33"
linkType="Composition™>

<interface bdmType="Interface" customer id="1" friendlyType="Interface"
id="5857567531c55aTbdl 96bd2d5acaadB5" mac address="B439BAESACTA"
realRelationType="Composition™
root_container="UCHMDB%0Ant20A1%0Rinternal id%3DSTRINGH3DEd21b94ddi26dceal54el
ladca3dd4c0%0A" />

</interfaces>

</node>

Transformed XML:
<CreateucmdbNodeRequegt>
<model>
<keys/>
<instance>
<file.device>
<UCMDBId>fd21b9%4ddf26dcSeelSde?ladea3ddel< /UCMDBIA>
<Customerld>1l</Customerld>
<Type>computer</Type>
<Subtype>Server</Subtype>

<add] IPAddr>
<Add1IPAddress>16.158.154.152</Add] IPAddress>
<AddlSubnet/>
</addlIFAddr>
</addlIPAddr>
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<CITdentifier>XMAl6.asiapacific.hpgcorp.net</CITdentifiar>
<DNSHame>XMAl6.asiapacific.hpgcorp.net</DNSHame>
</file.device>
<file.node>
<0sVendor>Microscft</0SVendor>
<addl IPAddr>
<AddlMacAddress>
<hddlMachddress>B439BAESACTA /AddIMachddress>
</AddlMachddress>
<ffile.node>
</instance:
</model>
< /CreateucmdbNodeRequest>

Response message from SM:

<CreateucmdblodeResponse messagem"Validation failed" returnCodes"T1"
schemaRevision-Date="2011-09-18" schemaRevisicnLevel="5" status="FAILURE"
xmlns="http://servicecenter.peregrine . com/PHs"
¥mlns:cmn="http: //servicecenter.peregrine.com/FWs/Common™
xmlns:xsd="http:// www.w3.org/2001/¥ML5chema”
¥mlns:xsi="http: /fwww.w3.org/2001/XMLSchema-instance™
xsi:schemalocaticn="http://servicecenter.peregrine.com/FWs
http: //¥MRl6.asiapacific.hpgoorp.net: 13080/ scé2server /ucmdbNode . xsd™>

<model>
<keys>

<CIIdentifier
type="String">xXMAlé.asiapacific.hpgoorp.net</ClIdentifier>

</ keys>

<instance
uniquequery="file.device, logical .name=5squot; XMAl 6. asiapacific. hpgocorp . netaquot
i
<file.device type="Structure">

<CITdentifier
type="String">xXMAlé6.asjiapacific.hpgcorp.net</ClIdentifier>

<DNSHame type="String">¥MR16.asiapacific.hpgcorp.net</DNSName:>

<Type type="String">computer</Type>

<CIName type="String">CI10869</CIName:>

<Subtype type="String">Server</Subtype>

<UCMDBId type="String®>fd21b94ddf2édcieelSdelladoaiddcl</UCMDBIC>
<ffile.device>
<file.node type="Structure">

<addlIPAddr type="Array":>

<addlIPAddr type="StructureType">
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</add]l TPRdAdr >
</addl TPRddAr>
<AddlMachddress type="Array">
<AddlMachddress type="String">B499BAESACTA</AddlMachddress:>
</RddlMachddrass>
</file.node>
</instance>
</model>
<messages>
<cmn:message type="String">T=====add</cmn:message>

<omnimessage type="String">Key #18 is ampty.
(se.base.method, add. record. radd) </cmn:message>

<cmn:message type="String“>file: (device)
key: (logical .name=XMR16.asiapacific.hpgoorp.net)
(se.base.method, add. record. radd) </cmn:message>

<Chn:message types"String”>The record being added contains a NULL key
(se.base.method, add. record. radd) </cmn:message>

<cmn:message type="String">file: (joinnode)
key: (file.device, logical . name=XMAl6.asiapacific. hpgcorp. net)
(ze.base.method, add. record. radd) </cmn :message>

<cmn:message type="String">The record being added contains a NULL key
(se.base.method, add. record. radd) </cmn :message>

<emn imessage type="String">This record contains an invalid null
key.</cmn:message>

</messages>

</CreateucmdblodeResponse

How to Check the Push Log File

You need to set the Development adapter log level to DEBUG so that you can check the source
tree XML file of UCMDB, the XSLT-transformed XML file, and the response XML file from Service
Manager.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned three XML files are in a good format. See the following for the steps.

To set the Development adapter log level to DEBUG:
1. Logintothe UCMDB server host as an administrator.
2. Navigate to the <UCMDB installation
folder>\UCMDBServer\conf\log\fcmdb.properties file. For example:
C:\HP\UCMDB\UCMDBServer\conf\log\fcmdb.properties.

3. Openthe fcmdb. properties file in a text editor.
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4.

5.

Update the 1og4j.category.fcmdb.adapters log level to DEBUG.

loghj.cateqory.con.mercury.topaz .cmdb.server . Ffemdb.datafccess=5{1oglevel},femdh.
dataAccess.appender
log4j.category.com.mercury.topaz.cndb.shared.fondb.datafdccess=5{1loglevel},fcndb.
datafAccess.appender
loghj.cateqory.fendb.ftgl.calc=5{loglevel?,fcndb.ftql.calc.appender
log4j.cateqory.femdb.config.audit=info,fcmdb.config.audit.appender
log4j.category.foemdb.lifecycle=info,fcmdb.lifecycle.appender
log4j.category._fcndb _mapping.engine=%{loglevel},fcmdb.mapping.engine .appender

ttevery change in fcmdb.adapters will affect fomdb.adapters.<integration_point_na
me> .1log

loghj-category . focmdb.adapters=DEBUG, fcmdb _adapters
1log4j.cateqgory.fendb.statistics=3{1loglevel?,fcndb.statistics.appender
log4j.category.com.hp.ucmdb.dataacquisition=${loglevel?,datafAcquisition.appender
,dallithaApi.appender
loghj.cateqory.con.hp.ucmdb.api.server . datastoremgmt=%{loglevel} , daWithApi.appen
der

log4j.category.population=%{loglevel},population.appender

Save thefile.

To enable the Development Mode for the integration point:

1.

2.

3.

4.

5.

6.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio.
Select the integration point for this integration.

Click the Edit Integration Point button.

For Development Mode, select True from the list.

Click the OK button to save the integration point.

To check the push log file:

1.

2.

Login to the UCMDB server host as an administrator.

Navigate to the <UCMDB installation
folder>\UCMDBServer\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C: \HP\UCMDB\UCMDBServer\runtime\log\fcmdb.adapters.SM

Integration.log

Open the log file in a text editor.

Search for text strings Source tree XML:, Transformed XML:, and Response message from
SM:.
The following is a sample log file.
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2011-11-30 14:22:03,325 [1751920131@Default-7] DEBUG - SM Integration >> Scurce
tree XML:

<node bdmType="Node" customer id="1"
display label="XMAl6.asiapacific.hpgcorp.net” friendlyType="Windows"
global id="fd21b9%4ddf26dcY9eel54e2ladcalidicl”
id="£d21b94ddfIedcYeal5delladcaiddcl" os vendor="Microscft"
primary dns name="XMAl6.asiapacific.hpgcorp.net">
<ip addresss directicn="outgoing" linkLabel="Containment" linkName="32"

linkType="Containment">

<ip address bdmType="IpAddress" customer id="1"
friendlyType="Ipaddress" id="bd03e34189cT13858712dcac500730ba"
name="16.153.154.152" realRelationType="Containment”/>

</ip addresss>

<interfaces direction="eoutgeing" linkLabel="Composition" linkNama="33"
linkTypes"Composition™>

<interface bdmType="Interface" customer id="1" friendlyType="Interface"

id="5897567531c55a7bdl96b42d5a6aa485" mac_address="B499BAESACTA"
realRelationType="Composition"
root container="UCMDBE0ANnt®0Al%0AiInternal id%3DSTRING:3Dfd21b9d4ddf2edcOealsdez
ladca3d4cO%0A™ />

<finterfaces>
</node>
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2011-11-30 14:22:07,615 [17519201318Default-7] DEBUG - 5M Integration >>
Response message from SM:

<CreateucmdbNodeResponse message="Success" returnCode="0"
schemaRevisionDate="2011-09-18" schemaRevisionLewel="5" status="SUCCESS"
xmlns="http://servicecenter.peregrine.com/PWs"
xmlns:cmn="http://servicecenter.peragrine.com/PWS/Common"™
xmlns:xsd="http://www.w3.org/2001/MLSchema"
xmlns:xsi="http://www.w3.org/2001/MLSchema-instance™
xsi:schemalocation="http://servicecenter.pearegrine.com/FHs
http://¥MAl6.asiapacific.hpgoorp.net: 13080/ scé2server /ucmdbiode . xsd">

<model>
<keys>

<CIIdentifier
type="5tring">XMRl16.asiapacific.hpgcorp.net</CIIdentifier>

</keys>

<instance
unique-query="file.device, logical .name=&quot ; XMAl16. asiapacific.hpgcorp.netiquo
s

<file.device typem"Structure">

<CIIdentifier
type="String">¥MAl6.asiapacific.hpgoorp.net</CIIdentifier>

<DNSHame type="String®>XMAlé6.asiapacific.hpgcorp.net</DNSName>
<Type type="S5tring">computer</Type>
<Subtype type="String">Server</Subtype>
<UCMDBId type="String">fd21b94ddfZedcleelSde?ladcaiddcl</UCHMDBIA>
<ffile.device>
<file.node type="Structure">
<addlTIPAddr type="Array">
<addlIPAddr type="StructureType">
<AddlTPAddress type="String">16.158.154.152</Add1IPAddress>
</add]l IPAdQdr>
<faddl IPAddr>
<AddlMachddress type="Array">
<hddlMaciddress type=s"String">E499BAESACTA</AddlMachddress>
</hddlMachddress>
</file.node>
</instance>
</model>
<messages>
<cmn:message type="String">0=====update</cmn:message>

</messages>
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How to Re-push Failed CI/Cl Relationship Records

The push error handling mechanism allows you to re-push failed CI/CI Relationship records either

one by one or in batches.

To re-push failed data in a query of a data push job:

1. Select the data push job.

2. Onthe Query Status tab, double-click the failed query.

Integration Jobs

* ¢ RGP E
Job Name | Status Last Synchronization Type
SM Configuration tems Push job @ Succeeded Changes
SM Push job V. Passed with failures Changes
SM Relations Push job A Pazsed with failures Changes
ST

Statistice | | Query Status || Job Errors

B

SM Push job

Query Name | Status

| Start Time

Finish Time

SM Metwork Componert Push @ succeedsd

Mon Feb 6 201210117 AM CST

SM MNode Relations Push | ,i, Pazzed with failures

| Maon Feb 6 2012 03:47 PM CST

@ Succesded
@ Succesded

SM Bunning Scftware Push
SM Storage Push

Mon Feb 6 201210117 AM CST
Mon Feb 6 2012 10:17 AM CST

The query failure details (Error Message, Cl Type, and CI Count) display.

Statistics || Query Status [|Job Errors

Mon Feb 6 2012 1017 AM CST
Mon Feb 6 2012 03:47 PM CST
Mon Feb 6 20121017 AM CST
Mon Feb 6 20121017 AM CST

o

Sk Push job = SM Node Relations Push

Error WMessage |

Cl Type

Cl Count

Invalid Data Error from SM

Composition

3. Double-click the Error Message, to see more details of the failed records.

Statistics | | Query Status || Job Errors

(%}

SM Pushiob = S5SM Mode Relations Push > Invalid Data Error from SM [ composition )

Error Message |

Display Label

Occurrence Date

133—>12312312
Cl14449—=cracle_rac
CHM1476—>12312312
CH4449—>12312312

Invalid Data Error from SM, return code 881, the erro...
Invalid Data Error from SM, return code 881, the erro...
Invalid Data Error from SM, return code 881, the erro...

Invalid Data Error from SM, return code 881, the erro...

Sun Feb 05 19:40:02 C5T 2012
Sun Feb 05 19:40:02 C5T 2012
Sun Feb 05 19:40:02 C5T 2012
Sun Feb 0519:40:02 C5T 2012

3
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6. Select afailed record, and then click the Push selected failed data button to re-synchronize
the record.
Statistics | [Query Status | [Job Errors
e®

SM Pushjob = SM Mode Relations Push = |nvalid Data Error from SM ( composition )

Error Message | Display Label Occurrence Date
: nvalid Data Error from SM, return co:E 881, the erro... | 133—=12312312 Sun Feb 05 19:40:0_2 CST 2012 ) =
Invalid Data Error from SM, return code 881, the erro.. Cl14449—=oracle_rac Sun Feb 05 19:40:02 C5T 2012
Invalid Data Error from SM, return code 881, the erro.. CH1476—=12312312 Sun Feb 05 19:40:02 C5T 2012 =
Invalid Data Error from SM, return code 881, the erro.. Cl114449—=12312312 Sun Feb 05 19:40:02 C5T 2012

Alternatively, click the query name link (in this example, “SM Node Relations Push”), select the
error message of the query, and then click the Push selected failed data button to re-push all
failed records in the query.

Statistics || Gluery Status || Job Errors

)

SM Push job = SM Mede Relations Push

Error Message | Cl Type Cl Coumnt
Invalicd Data Error from SM | Composition 5 "I-

Typical Push Errors and Solutions

This section describes typical error messages that may occur during data push, as well as their
solutions.

This section includes:

e "TQL not Configured in smSyncConfFile.xml" on the next page

¢ "Non-Existing XSLT File Name Defined for a TQL in smSyncConfFile.xml" on page 216

e "Request Name not Found fora TQL in smSyncConfFile.xml " on page 217

e "Wrong Service Manager WS Request Name Defined in smSyncConfFile.xml" on page 218
e "XSLT file not Well Formed" on page 220

e "Wrong UCMDB Attribute Name in XSLT File" on page 221

e "Wrong Service Manager Field Name in XSLT File" on page 222

o "Empty Value for No Nulls Key in Service Manager" on page 223

e "Cl Logical Name Truncated or Cl not Pushed due to Logical Name Truncation" on page 226
e "Service Manager Database Case-Sensitivity Issue" on page 226

e "Global ID and Customer ID Missing in XSLT" on page 227
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TQL not Configured in smSyncConfFile.xml

Sample configuration

The TQL query used for populating business service Cls is named SM Business Service Push,
however you have not configured it (or have commented it out) in the smSyncConfFile.xml file:

Resourcediscovery ConfigFiles/Service ManagerAdapterS-xism Sync ConfFile xml

e ¢

g «<!-- nev enhancement -->

9 <f--

10 Wildcard i1s supported £

11 the '+#' at

12 W the wildcard fbr m

13 vou could still push it t

14 For I

15 the

18 int

17 How xact TOL nam 5 st1ll supported.
1s -—>
19 <tgl name="3M Bunning Software Push*" xslFile="runningsoftware push.xslt">
20 <l-- this 15 logical application tgl --=
21 <request ty e="Create"” name="CreateucndbRunningSoftwareRequest" />
22 <request type="Update" name="UpdateucmdbRunningSoftwareRequest”/ >
23 <request type="Delete” name="DeleteucmdbRunningSoftwareRequest”™ />
24 </tgl=
25 C<!--tgl name="SM Business Service Push*" %51F1le="bUs1Nes5 SErvice push.xslt’s =3
26 Tr=="thr1s 15 "business service ror catalog tgl ==
27 <request t=$ﬂ—""reate" nsn=—""reateucmﬂbBu51nessServ1ceRequest"f}
28 {request type="Update" nsn=—"UpdateucmﬂbBu51nessServ1ceRequest"f}
T + e TTm T m s 1T e e e T T e mrn e A T D s e Do v mim T e =T

Error message

The push job fails with a “Failed” status. From both the log file and the detail error message of the
failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed Push
Job" on page 203), you receive an error like the following:

java.lang.RuntimeException: Heo mapping is found for TQL: "SM Business Service Push",
please configure in smSyncConfFile.xml

at

com.mercury.topaz . focmdb. adapters. serviceDeskAdapter .push. SmPusher . pushObjects (SmPush
er.java:273)

at
com.mercury.topaz . fomdb . adapters . sarviceDeskidapter.push. SmPusher. push [SmPusher . java
:93)

vos 31 more

Solution

Search for text No mapping is found for TQL to find the TQL name that is not yet configured,
and then configure the TQL name in the smSyncConfFile.xml file.

For instructions on how to add a mapping for a TQL, see "How to Map the Cl Type’s TQL Query to
an XSL Transformation File" on page 157.
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Non-Existing XSLT File Name Defined for a TQL in
smSyncConfFile.xml

Sample configuration

The XSLT file for populating business service Cls is named business_service push.xslt,
however you have configured a wrong name business_service push_wrong name.xsltin
smSyncConfFile.xml.

Resourcediscovery ConfigFiles/Service Manager Adapter 9-xizm Sync ConfFile.xml

Q®GC e 2
13
14
15
14
17
18
139 <tgl name="5M Running Software Push*" xslFile="runningsoftware push.xslt">
20 <l-- this 15 logical application tgl -->
21 <recquest type="Create"” name="CreateucmdbRunningSoftwareRequest™/>
22 <request type="Update"” name="UpdateucmdbRunningScftwareRequest"/>
23 <request type="Delete” name="DeleteucmdbPRunningScftwareRegquest™/>
24 </tgl>
25 (:?{tql name="5M Business Service Push*"™ xleilE=“business_service_push_wrnng_name.xslt“}':)
26 + £ S s e R A S Pt S T
27 <request Ty e="Create” name=“§reé€eucmﬂbBusineSSServiceRequest"f}
28 <request type="Update" "UpdateucmdbBusinessServiceRequest™ />
29 <recuest type="Delete” name="DeleteucmdbBusiness3erviceRequest™/>
30 </tgl>
31 <tgl name="5M Computer Push*" xslFile="computer_ push.xslt">
32 <I-- this 15 host-rip,interface,sm server tgl --»
33 <request type="Create” name="CreateucmdbNodeRegquest™/>
a4 LT + i remTTTmAs A" e mrrm e T A s s s e AR A A s T s s e T s

4

Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 203), you receive an error like the following:

java.io.FileNotFoundException: Resource: business service push wrong name.xslt, was
not found

at

com.mercury.topaz.cndb. server. femdb. adapterstate . AdapterStateResourceServerFacade . op
enResourceForReading (AdapterStateResourceServerFacade. java:5l)

at
com.mercury.topaz.cmdb. server. femdb, spi . adapter. environment. DatafdapterEnvironmentIm
pl.cpenRescurceForReading (DatafhdapterEnvironmentImpl.java:119)

at
com.mercury.topaz. fomdb. adapters.serviceDeskhdapter. TransformUtils. readFromFile (Tran
sformUtils. java:113)

at

com.mercury.topaz. fomdb. adapters. serviceDeakhdapter.push.XsltTransformer. createTempl
ates (XsltTransformer.java:393)

.2 36 more
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Solution

Search for text java.io.FileNotFoundException: Resource: to find the wrong XSLT file name,
and then correct the XSLT file name in the smSyncConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How to Map the Cl Type’s
TQL Query to an XSL Transformation File" on page 157.

Request Name not Found for a TQL in
smSyncConfFile.xml

Sample configuration

The Service Manager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have not configured it (or have commented
it out) in the smSyncConfFile.xml file.

Resourcediszcovery Config FilesiService Manager AdapterS-x/sm Sync ConfFile xml

Q @ e

13
14
15
1a
17
18
13
20
21
22
23
24
25
28
27
28
239
30
31
32
33

24

1 could st1l1l push it to SM w

<tgl name="3M Running Software Push*" xslFile="runningsoftware push.xslt">
<!-- this 15 logical application tgl --=
<request type=":reat€" name="CreateucndbRunningScftwareRequest™ />
<request type="Update" name="UpdateucmdbRunning3ocftwareRequest”/>
<request type="Delete" name="DeleteucmdbBunningSoftwareRequest”/>

</tgl>

<tgl name="3M Business Service Push*" xlellﬂ—"bu31ness _3ervice_push.x3lt™>

-

<!-- this 15 business service for cat g bgl -->
¢ <!--request type="Crezte" e="CreatencmdbBusinessServi ceRequest ™/ —=»
<request type="Update" name="UpdateucmdbBusinessServiceRequest” />

<request type="Delete" name="DeleteucmdbBusinessServiceRequest” />
</ Egl>
<tgl name="3H Computer PFush*" xslFile="computer push.xslt">

<!-- this 1s tcs:— ip,lnterface,sm server tgl —-»
<request type="Create"” ncmn—""reateucmdecdeRequest"f>
e e = v T TTm A e T e m v e T T Tam el == o s Al I BT ol = T ey o e 10 0

Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 203), you receive an error like the following:
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java.lang.RuntimeException: No request name was found for operation "Create"™ of TOL
name "SM Business Service Push", please check in smSyncConfFile.xml file.

at
com.mercury.topaz.fomdb.adapters. serviceDeskRdapter .push.Mapping.createTransformer (M
apping.java:B9)

at
com.mercury.topaz. fomdb. adapters. serviceDeskRAdapter.push. SmPusher.pushObjects (SmPush
er.java:276)

At
com.mercury.topaz. femdb. adapters. serviceDeskAdapter.push.SmPusher.push (SmPusher.java
$85)

= 31 MOre & &

Solution

In the error message find the TQL name for which a request name was not found, and then in the
smSyncConfFile.xml file add the request name for the TQL name.

For instructions on how to configure a request fora TQL, see "How to Map the Cl Type’s TQL
Query to an XSL Transformation File" on page 157.

Wrong Service Manager WS Request Name Defined in
smSyncConfFile.xml

Sample configuration

The Service Manager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have configured a wrong request name
CreateucmdbBusinessServiceRequest_wrongname in the smSyncConfFile.xml file.

Reszourcediscovery ConfigFiles/Service Manager Adapter-xismSyne ConfFile.xml

QXD E| &
1& integration will automatically use this mapping entry on all of the thres TQLs.
17 However, using the exact TOL name to configure the mapping 1s sti1ll supporbted.
18 -—>
139 <tgl name="5M Bunning Software Push*" xslFile="runningscftware_ push.xslt">
20 <!l-- this 15 logical application kgl --=
21 <request type="3reat€" name="CreateucmidbRunningSoftwareRequest™ />
22 <request type="Update” name="UpdateucmdbRunningScftwareRequest™/>
23 <request type="Delete” name="DeleteucmdbRunningScftwareRequest™/ >
24 </ tgl=
25 <tgl name="3M Buainess Service Push*™ x3lFile="business_service_ push.xslc">
28 «l-- this 1s business service for cataleg tgql -->
27 <request type="Lreate’ name="LreateucmdbbusinessserviceRequest wrongname /> 3
28 <reques usinessierviceRequest” />
29 <request type="Delete” name="DeleteucmdbBusinessServiceRequest™/>
30 </tgl>
31 <tgl name="5M Computer Push*" xslFile="computer_ push.xslt">
32 «l-- this 15 host-»ip,interface,sm server btgl --»
33 <request type="Create"” name="CreaﬁEucmdecdeRequest"!b
34 <request type="Update” name="UpdateucmdbNcdeRequest™/>
35 <request type="Delete™ name="DeleteucmdbNodeReguest™/>»
38 </ gl
a7 P R | oM OU Cesd e mle Thamd d T e T TG T mee M mn a5 = mle amaamds aem T =Wy
4
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Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed Cls in the Universal CMDB studio (see "How to Check the
Error Messages of Failed Cls/Cl Relationships in a Push Job" on page 204), you receive an error
like the following:

Other exception while sending message to 5M, the exception message is "SOAP fault
received: A C¥mlApiException was raised in native code : error 16 : scumlapi(lé) -
Invalid or missing file name in XML reguest"”

L &

Scurce tree XML:

<?aml version="1.0" enceding="UTF-16"7%>

<business_element bdmType="BusinessService" customer id="1"
display label="test bizservice push 1"
friendlyType="BusinessService" id="dc37d623182d759df82cTboccd2448630"

name="test_hizservice_Push_l" provider="

providerl" />
Transformed XML:
<?xml version="1.0" encoding="UTF-16"7>
<CreateucmdbBusinessServiceRequest wrongname>
<model>
<keys/ >
<instance>
<UCMDBId>dc57d623182d759df82cTbeed2448630</UCHMDBIA>
<CustomerIds>l</CustomerId>
<Type>bizservice</Type>
<SubtyperBusiness Service</Subtype>
<SarviceProvider>providerl</ServiceProvidars>
<ServiceName>test bizservice push_l</ServiceName:>
<CIIdentifier>test bizservice push l</CIIdentifier>
<finstance>
</model >

</CreateucmdbBusinessServiceRequest wrongname:>

Solution

Inthe Transformed XML section of the error message, check the Request name (which is
configured as CreateucmdbBusinessServiceRequest_wrongname in this sample), and make sure
that the request name specified in smSyncConfFile.xml is the exact name defined in the WSDL.

For instructions on how to configure a Service Manager web service request fora TQL, see "How to
Map the Cl type's TQL Query to an XSL Transformation File" on page 175.
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XSLT file not Well Formed

Sample configuration

The end tag of “instance” should be </instance>, however you have configured a wrong end tag
</instance_wrong_end_tag>.

RFeszource discovery ConfigFiles/Service Manager AdapterS-xhbusiness_service_push.xsit
QW &
1 <xsgl:stylesheet verzion="1.0" xmlnz:xsl="http://wWww.w3.org/1999/¥5L/Transform™>
2 <xsl:variable name="CIlists™ select="document('SM CIT Subtype list.xml")/lists™/>
3 <xsl:template match="/business element">
4 <model>
] <keys/ >
[ Linztanra™
7 <l--i1mport:cmdb root attributes.xslt--»
] <Typerbizservice</Type>
g <xsl:variable name="CIT" select="FEbdmIype"/>
10 <Subtyper<xsl:ivalue-of select="zCIT"/></Subtype>
11 <xszl:for-each select="$CIlists/list[fname="CIType bizservice']"»>
12 <fubtyper<xsl:value-of select="entry[fucmdb=:CIT]/Eam"/></Subtype>
13 </xs1l: for-each>
14 <xsl:for-each select="fprovider">
15 <ServiceProvider><xsl:value-of =zelect="."/></5erviceProvider>
1a </xs1l: for-each>
17 <x=l:for-each sslect="Fdisplay label™>
g <ServiceNamer<x=l:value-of zslect="."/></5ervicelame>
15 <CITdentifier>x=l:ivalue-of select="."/>/CIIdentifier>
20 </x=1l: for-each>
21 <finztance wrong end tags>
22 </model>
23 </xzl:template>
24 </xsl:stylesheet>
4

Error message

The data push job fails with a “Failed” status. From both the log file and the detailed error message
of the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 203), you receive an error like the following:

javax.xml.transform.TransformerConfiqurationException: Failed to compile styleshest

at
COm. Sun.org.apache.xalan.internal.xsltc.trax.TransformerFactoryImpl . newTemplates (Unk
nown Scurce)

at
com.mercury.topaz. femdb . adapters. serviceDeskAdapter.push.XsltTransformer. createTempl
ates (XsltTransformer.java:100)

«xa S0 MOre

In addition, you can find more detailed error message in the log file to see which XSLT file is not well
formed. You should see something like following:
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2011-12-12 14:54:58,108 [170025072@Dafault-10] ERROR - SM Integration >> Got
DatahccessException while updateData

com. hp.ucmdb. federationspi.exception.DatafccessGeneralException: Hot wvalid XSLT £ile
"busi-ness service push.xslt", please check this X3LT file

at
com.mercury.topaz.femdb. adapters. serviceDeskAdapter.push.XsltTransformer. createTempl
ates (XsltTransformer.java:1l03)

atc
com.mercury.topaz. fomdb . adapters. serviceDeskAdapter.push.Mapping.parseConfig(Mapping
-java:54)

Solution

Search fortext Not valid XSLT file tofindthe XSLT file name, and then validate the XSLT file in
an XML editor (for example, XMLSpy). You can easily find and fix any validation issues.

& % BB o | #h O # | [3[EcE |V |50 6 [T G

gl shylesheet version="1.0" xmins xsl="htm==5 - 999/ X5/ Transfom " =
<xsl-vanable name="Cllists" zelect="doc P ] btype_list xml ) dists" =
<zl template match="/business_element">

=3 | = LY =

<model =
heysss
= <instance’
<l-impart :cmdb_root_attributes xsh—s
< [ype=hizservice </ Type:
<zl varable name="CIT" select="2bdm Type"/=
“5ubtype sl valueof select="8CIT" />« Subtype:
L= «xsl foreach select="8Cllists list[@name="ClType_bizservice]"=
i «Subtypexaslvalue-of select="entny[@ucmdb=8CIT]/@sm" =</ Subtype =
</uslforeach >
] <xsl foreach select="provider" >
i <ServiceProviders<xslvalue-of select="_"/></ServiceProvider:
«/wslforeach >
= «xsl foreach select="2display_label">

i «SemrviceMame x<xslvalueof select="."/></ ServiceName >
i «Clldertifiers<xs|value-of select="."/=</Clldentfier:

B <zl for-each=

- Binstance_wrong end tagk

B </model =

- <fsltemplates:

— < /sl stleshest >

This file is not wellformed:
Q instance closing element name expected. @" Recheck |

Wrong UCMDB Attribute Name in XSLT File

P (] L S Y

Sample configuration

The Universal CMCB attribute name is provider, however you have configured a wrong attribute
named provider_wrong.
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Rezource discovery ConfigFiles/Service Manager Adapter8-xbusiness _service_push.xsh

QEDE| 2

1 <xsl:stylesheet wersicn="1.0" zmlns:xsl="http://www.w3.o0rg/1999/X5L/Transform">
<xsl:variable name="CIlist3" sslect="document('SM CIT Subtype list.xml')/lists"/>
<xsl:template match="/business_element">
<model>
<Eeys/>
<instance>

import:cmdb root attributes.xslt 5

-:'I‘gpebbizservic_e{f'l‘gﬁeb
<xsl:variable name="CIT" select="{FbdmType"/>
<Subtyper<xsl:value-of select="zCIT"/></Subtype>
<xzl:for-each sslect=":CIlists/list[Bname="CIType bizservice']™s
<Subtyper<xsl:value-of sslect="entry[fucmdb=$CIT] /Qam"/></Subtype>
</xsl:for-each>
<xs1:for-each select="fprovider wrong™s»
<ServiceProvider><xsl:value-of select="."/></ServiceProvider:>
</xs1l:for-each>

e e e el el
e T R S R = R I T R TR R

17 <xsl:for-each zelect="{Fdisplay label™>
g <ServiceNamer<xsl:value-of select="."/></3ervicellame>
13 <CIIdentifier><xsl:value-cf select="."/></CIIdentifier>
20 </xs31:for-each>
21 </instance>
22 </model>
23 </xs]l:template>
24 </xsl:stylesheet>

4

Goone

Error message

You will NOT get any error messages either in the log file or in the Universal CMDB studio, however
the Universal CMDB attribute value will not be pushed to Service Manager.

Solution

If you find a UCMDB attribute value that cannot be pushed to Service Manager, double-check the
UCDMB attribute name and Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 137.

Wrong Service Manager Field Name in XSLT File

Sample configuration

The Service Manager field name is ServiceProvider, however you have configured a wrong
attribute named ServiceProvider_wrongin the XSLT file. This error also commonly occurs since
the attribute is case-sensitive.
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Beszource dizscovery ConfigFilesiService Manager Adapterd-xbusiness_service_push.xsh
QRD G| &
1 <xzsl:stylesheet version="1.0" xmlns:xsl="http:// wwWw.W3.o0rg,/1999/¥5L/Transform™>
2 <xs]l:variable n= "CIliata™ zelect="document ('5M CIT_Subtype_list.xml')/liata™/ />
3 <xsl:template match="/business_element">
4 <model>
5 <kKeys/>
[ <instance’>
T <l--1mport: L attributes.xslt-->
g <Typerblzservice</Type
2] <xsl:variable name="CIT" zelect="({bdmIype"/>
10 <Subtype><xsl:value-of select="sCIT"/>/Subtype>
11 <xsl:for-each select="¢CIliats/liat[@name="CIType bizservice']™>
1z <Subtypes<xsl:value-of select="entry[fucmdb=5CIT]/Eam"/></Subtype>
13 </xsl: for-each>
14 <xsl:for-each select="(@provider">
15 «Rewricalrorider wronme<xs] :value-of sslect="."/>=/SerriceProvrider wronas>
la </xs1l: for-each>
17 <xsl:for-each select="Fdiaplay_lakel™>
& <ServiceName><xsl:value-of sslect="."/></Servicelame>
13 <CIIdentifier><xsl:value-of sslect="."/></CIlIdentifier>
20 </xs31: for-each>
21 </instance>
22 </model>
23 </xsl:template>
24 </xsl:stylesheel>
4

Error message

You will NOT get any error messages either in the log file or in the Universal CMDB studio,
however, the Universal CMDB attribute value will not be pushed to Service Manager.

Solution

If you find a Universal CMDB attribute value that cannot be pushed to Service Manager, check both
the Universal CDMB attribute name and Service Manager field name of the mapping in the XSLT
file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 137.

Empty Value for No Nulls Key in Service Manager

Sample configuration

In Service Manager you have configured a No Nulls key for field “testnotnullfield” of the device
table, however you have not mapped this field in the XSLT file.
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Mame: |dE'u'i|::e Status:

Caze Mode:  Casze [nzensitive

G Fields | < KE};'S| & SOL Tables

| Mo Mulls | - |
testnotnullfield

| Unigue |v|
logical.name

| Mulls & Duplicates | - |
vendor

fl Mulle & Munlircatee [=1

Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed Cls in the Universal CMDB studio (see "How to Check the
Error Messages of Failed Cls/Cl Relationships in a Push Job" on page 204), you receive an error
like the following.
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</model>

“messages>
<cmn:message type="String">f=====add</cmn:message>
<omn imassage type="String">Key #1 is empty.

({se.base.method, add. record. radd) </cmn :message>

<cmn:message type="String">file: (device)
key: (logical .name=test bizservice push 1)
{se.base.method, add. record. radd) </cmn:message>

<cmn:message typem"String">The record being added o
{se.base.method, add. record. radd) </cmn :message>

o

ntains a NULL key

&
< /messagess

</CreateucmdbBusinessServiceResponge>

Solution

Find the key number in the <messages> section to see which No Nulls key has a NULL value. For
example, if you find a message “Key #1 is empty”, check the first key definition of the device table
to see which field(s) this key is for, and then make sure that a non-NULL value has been mapped to
the field(s) in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 137.

Cl Logical Name Truncated or Cl not Pushed due to
Logical Name Truncation

Sample configuration

The length of a UCMDB CI name exceeds 200 characters, which is the maximum allowed field
length for logical.name (Cl Identifier) in Service Manager. When this Cl is pushed to Service
Manager, the Cl name is truncated.

Two UCMDB Cls have the same CI name that is 200 characters in length. When the second Cl is
pushed, it is supposed to be renamed if the DEM Duplication Rule is configured so; however, the
renamed logical name will be truncated to be same as the first CI's logical name. As a result, the
second Cl will not be able to be pushed to Service Manager due to an invalid duplicate key error.

Error message

You receive an error message that contains this string: This record contains an invalid
duplicate key.

Solution

Update the Cl type’s XSL transformation file so that, before running a push, the integration can
make sure that all Cl names are significantly less than 200 characters in length.

Service Manager Database Case-Sensitivity Issue

Sample configuration
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Your Service Manager database is case-insensitive. You have two UCMDB Cls with a name of
CINAME1 and ciname, respectively.

When running a push job to push these Cls, the integration considers the second Cl a duplicate of
the first one, and therefore either renames it or returns an error according to the Duplication Rule
setting of the relevant DEM Rule record.

Solution

HP recommends using a case-sensitive Service Manager database to avoid this issue.

Global ID and Customer ID Missing in XSLT

Sample configuration
You create an XSL transformation file for push without the following element:

<!--import:cmdb_root_attributes.xslt-->

The cmdb_root_attributes.xslt file contains Global ID and Customer ID, which are required for
data push:

<UCMDBId><xsl:value-of select="@id"/></UCMDBId>
<CustomerId><xsl:value-of select="@customer_id"/></CustomerId>

Error message

No error message occurs, however when you update or delete a Cl record in UCMDB, the update or
deletion will not be pushed to Service Manager.

Solution

In the XSL transformation file, include the missing element:

<!--import:cmdb_root_attributes.xslt-->

Troubleshooting Population Issues

When population errors or problems occur, you can check the error messages and the population
log file to identify the root causes and then solve the problems.

When a population job has failed, the job status becomes Failed. Troubleshoot the failed job as
follows:

e Check the error message of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Population Job" on the next page and "Typical
Error Messages and Solutions" on page 234.

e Check the log file for more details.
See "How to Check the Population Log File" on page 229.
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How to Check the Error Message of a Failed Population
Job

While a population job fails, you can check the detailed error messages in the Universal CMDB
studio.

To check the error message of a failed population job:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Select the integration point for this integration.
4. Click the Population tab.
5. Select the failed job from Integration Jobs, and click the Job Errors sub-tab.
6. Double-click an error message from the list.

A pop-up window opens to display the error details. The following is a sample error message
about a non-existing XSLT file:
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Failed initializing the datastore. adapterlID:ServiceManagerBdapter9-x destID:SM
Integration
ER=ROR:com.mercury.topaz.cmdb.shared. femdb. dataAccess. exception.AdapterAccessFaile
dToStartAidapterException: [ErrorCode [8530] Integration Point cannot start{sM
Integraticn}]

Failed to start adapter [5M Integration].java.lang.RuntimeException: Mo XSLT file
ig found "busi-ness service population wrong.xslt", please configure the right XSLT
file in smPopConfFile.xml

com. hp.ucmdb . federationspl.exception. DataAccessCommunicationException:
java.lang.RuntimeException: No XSLT file is found
"business service population wrong.xslt", please configure the right XSLT file in

smPopConf=File.xml

at

com.mercury.topaz. fomdb. adapters.serviceDeskAdapter.ServiceDeskhdapter.start (Servil
ceDeskhdapter.java:841)

at

com.mercury.topaz.cmdb. server. fomdb. datafccess.manager. impl . AbstractDataAccessCont
ainerManagerImpl.startadapter (AbstractDatadccessContainerManagerImpl.java:244)

at

com.mercury. topaz. cmdb. server. femdb. dataRccess.manager. impl . AbstractDataAccassCont
ainerManagerImpl.addStartAndReturnBasicDatafdapterWrapper (AbstractDatahccessContal
nerManagerImpl.java:162)

at
com.mercury.topaz.cmdb. server. fomdb. dataRccess.manager. impl.AbstractDataAccessCont
ainerManagerImpl . getStartediasicDatafdapterWrapper (AbstractDatadecassContainerMana
gerImpl.java:187)

at
com. hp . ucmdb . discovery.probe.agents. probemgr . adapters.DatafccessAdaptersFacade. get
StartedBasicDatahdapterWrapper (DatahccesshdaptersFacade. java:139)

at
com. hp.ucmdb.discovery. probe. services.dynamic.core. AdapterService . runDi scovery (Ada
pterService.java:l72)

at
com. hp .. ucmdb . discovery. probe . services . dynamic. core .. AdapterService . discover (Adapter
Service.java:140)& &

How to Check the Population Log File

You can set the Development adapter log level to DEBUG to check the incoming Cl XML file of
Service Manager, and the XSLT-transformed XML file.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned two XML files are in a good format.

To set the adapter log level to DEBUG:
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1. Logintothe UCMDB server host as an administrator.

2. Navigate tothe <UCMDB installation folder>\DataFlowProbe\conf\log
\fcmdb.properties file. For example:

C:\HP\UCMDB\DataFlowProbe\conf\log\fcmdb.properties

3. Openthe fcmdb. properties configuration file in a text editor.

4. Update the 1log4j.category.fcmdb.adapters loglevel to DEBUG:

loghj.cateqgory.focmdb.ftgql.calc=%{loglevel},fcmdb.ftql.calc.appender |
log4j.category.fecmdb.config.audit=info,fcmdb.config.audit.appender
log4j.category.fecmdb.lifecycle=info,fcndb.lifecycle.appender
luguj.categury.chdh.mapping.Engine=${lugleuel},chdh.mapping.engine.append—J
er

fievery change in fcmdb.adapters will affect fcmdb.adapters.{integration_poi
nt_name>.log

lughj.categury.chdh.adapter5=DEBUGLchdh.adapter5

loghj.cateqory.fecmdh _statistics=%{loglevel},fcmdb.statistics.appender
loghj.cateqory.com.hp.ucmdb.dataacquisition=${loglevel},datafcquisition.app
ender ,daWithApi .appender

loghj.category.com.hp.ucmdb.api.server _datastoremgnt=%{loglevel?,daWithApi.
appender

loghj.category.population=%{loglevel},population.appender

—— SELECT — & 36,36 19%

5. Save thefile.

6. Wait a while for the change to take effect.
To enable the Development Mode of the integration point:

For detailed steps, see "How to Check the Push Log File" on page 208.
To check the population log file:

1. Logintothe UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\DataFlowProbe\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C: \HP\UCMDB\DataFlowProbe\runtime\log\fcmdb.adapters.SM

Integration.log

3. Openthelogfile in a text editor.

4. Search fortext strings Source SM CI XML, Transformed XML, Source tree XML for ID
Pushback, Transformed XML for ID Pushback and Response message from SM For ID
Pushback. The log looks like the following:
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2011-12-13 11:01:18,062 [JobExecuterWorker-0:D5 SM Integration bizservice
population]) DEBUG - SM Integra-tion >> Source SM CI XML:

<?xml version="1.0" encoding="UTF-16"7>
<S0AP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlscap.org/scapfenvelope/">
<SOAP-ENV:Body>
<RetrieveucmdbBusinessServicelistResponse

xmlns="http://servicecenter.peregrine.com/PWs"
message="Success"™ returnCode="Q"
schemaRevisionDate="2011-09-18" schemaRevisicnLevel="5"
status="SUCCESS"
xmlns:cmn="http://servicecenter.peregrine. com/EWs/Common™
xmlns:xsd="http:/  www.w3.org/2001/XML5chema®

¥mlns:xsi="http://www.w3.org/2001/¥MLSchema~-instance™
x=i:schemalocation="http://servicecenter.peregrine.com/PHS
http: //¥MAl6.asiapacific.hpgoorp.net: 13080/ sc62server/ucmdbBusinesssService . xsd"™>

<instance query=""
uniquequery="file.device, logical.name=&quot;test_biz servcie l&quot;">

<file.device type="Structure”>
<CIIdentifier type="String">test biz servcie 1</CIIdentifier>
<ServiceProvider type="String">VENDOR1</ServiceProvider>
<Type type="String">bizservice</Type>
<CIName type="S5tring">CI10873</CIName>
<Subtype type="String">Business Service</Subtype>

</file.device>

</instance>

<instance guery=""
uniquequary="file.davice, logical .name=gquot;test biz serveie Zicquot:">

<file.device type="Structure”>
<CIIdentifier type="String">test biz servcie 2</CIIdentifier>
<ServiceProvider type="sString">VENDORZ</ServiceProvider>
<Type type="String">bizservice</Type>
<CIName type="String">CI10872</CIName:>
<Subtype type="String">Business Serviced/Subtype>

<ffile.device>

<finstance>
</RetrieveucmdbBusinessServicelListResponse>
</SOAP-ENV:Body=
=/S0OAP-ENV:Envelope=
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2011-12-13 11:01:18,414 [JobExecuterWorker-0:DS SM Integration bizservice
population] DEBUG - SM Integra-tion >»> Transformed XML:

<?xml version="1.0" encoding="UTF=-16"7>
<topology>
<ci class="business service">
<attribute name="name" type="String">test biz servcie l</attribute>
<attribute name="sm id" type="String">CIl0873</attribute>
<attribute name="glcbal id" type="String"/>
<attribute name="provider" type="String">VENDORl</attribute>
<feciz
<ci class="business service">
<attribute name="name" type="String">test biz servcie 2</attribute>
<attribute name="sm id" type="String">CIl10872</attribute>
<attribute name="glcbal id" type="String"/>
<attribute name="provider" type="String">VENDORZ</attribute>
<fei»
</topology>
& &

2011-12-13 11:01:32,061 [JobExecuterWorker-0:DS SM Integration bizservice
population] DEBUG - S5M Integra-tion >» Source tree XML for ID Pushback to update S5M
CI "CI10873" with uCMDB ID "50fccdeaecd9bld8lalfSdca’9942b27";

<?xml wersion="1.0" encoding="UTF-16"%>
<ucmdbIDPushBack>

<ci id="CI10873" ucmdbid="50fccdeaec4%b1d8lalf54ca®9942p27" />
</ucndbIDPushBack:>

2011-12-13 11:01:32,084 [JobExecuterWorker-0:D5 SM Integration bizserwvice
population] DEBUG - SM Integra-tion >> Transformed XML for ID Pushback:

<?xml version="1.0" encoding="UTF-16"7>
<UpdateucmdbIDPushBackRequest>
<model xmlns:ns="http://schemas.hp.com/SM/T">
<keys/>
<instance>
<Configurationltem>CI10873</Configurationltem>
<UemdbID>50fccdeaecd 9bld81al £540a9994 2027 < /UemdbI D
<finstance>
</model>
</UpdateucmdbIDPushBackRegquest>
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2011-12-13 11:01:32,240 [JobBExecuterWorker-0:D5 sM Integration bizservice
population] DEBUG - SM Integra-tion >> Response message from SM For ID Pushback:

<7?xml version="1.0" encoding="UTF-1&6"7>
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlscap.orq/scap/envelope/ ">
<SOAP-ENV :Body>
<UpdateucmdbIDPushBackResponse

xmlns="http://servicecenter.peregrine.com/PWs"
message="Success" returnCode="0"
schemaRevisionDate="2011-0%-18" schemaRevisionLevel="5"
status="SUCCESS"
xmlns:cmn="http://servicecenter.peregrine.com/FW5/Common"™
xmlns:xsd="http://www.w3.orqg/2001/¥ML5chema™

xmlns:xsi="http:/www.w3.org/2001/¥MLSchema-instance™
xsi:schemalocation="http://servicecenter.peregrine.com/FWs
http: //XMAl6.asiapacific.hpgcorp.net: 13080/ sce2server fucmdbIDPushBack . xsd">

<madel >
<keys>
<Configurationltem typem"String">CI10873</ConfigurationlItem>
</ keys>

<instance recordid="CcI10873 - =~
unigquequery="logical.name=&quot;CI1087T38quot; ">

<ConfigurationItem type="S5tring">CI10873</Configurationltem:>

<UemdbID
type="String">50fccdeaec4 Sbld8lal£54ca99942h2 7</UcmdoI D>

<f/instance>

</modal>

<messages>
<cmn:message type="String">==Foundabcdefg</cmn:message>
<omnimessage type="String">Found<s/chnimessage

<cmn:message type="String">going to update ucmdb id to
abedefg</cmn :message>

<cmn:message type="S5tring">Update done!</cmn:messages>
<cmn:message type="String">Foundabcdefg</cmn:message>
</messages>
</UpdateucndbIDPushBackResponse>
</ SOAP-ENV: Body>
</SOAP-ENV:Envelope>
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Typical Error Messages and Solutions

The following describes typical error messages that may occur during population, and their
solutions.

This section includes:

¢ "No TQL Configured in smPopConfFile.xml " below
o "Non-Existing XSLT File Name Defined for a TQL in smPopConfFile.xml" on the next page
¢ "No “Retrieve” Type Request Defined for a TQL in smPopConfFile.xml" on page 236

o "Wrong Request Name of retrieveKeysQueryName Configured fora TQL in
smPopConfFile.xml" on page 237

¢ "Wrong Request Name of retrieveListQueryName Configured for a TQL in smPopConfFile.xml"
on page 238

e "XSLT File not Well Formed" on page 240

e "Wrong UCMDB Attribute Name in XSLT File" on page 241

e "Wrong Service Manager Field Name in XSLT File" on page 242

e "Wrong Universal CMDB Attribute Data Type in XSLT File" on page 243

e "UCMDB CI Attribute sm_id not Mapped to the Right Service Manager Field in XSLT" on page
244

No TQL Configured in smPopConfFile.xml

Error message

If you have not yet added a TQL to your job, you cannot select this TQL from the list while you
create/update your job.

If you have already added this TQL to your job before removing this TQL from smPopConfFile.xml,
you will get a “Failed” status while you run this population job. In addition, in the Universal CMDB
studio, you will get an error message like the following (see "How to Check the Error Message of a
Failed Population Job" on page 228):
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Failed running population. destID:S5M Integration, Failed during query: , all
queries: [SM Business Service Popula-tion]), finished queries:[]

ERROR; com. hp.ucmdk. federationspi.exception.DataAccessGeneralException: Query [SM
Business Service Population] is not supported by this adapter.

at
com.mercury.topaz. focmdb.adapters. serviceDeskRAdapter.ServiceDeskBdapter.getQueryByN
ame (ServiceDeskidapter.java: 990)

at
com.hp.ucmdb.discovery.probe.services.dynamic.core.AdapterService. retrieveQuerybef
initionByRootType (AdapterService.java:247)

at
com. hp.ucmdb.discovery.probe. services.dynamic. core.AdapterService. runDiscovery (Ada
pterService.java:183)

at
com. hp.ucmdb.di scovery. probe. services. . dynamic. core. AdapterService . discover (Adapter
Service.java:140)

at
com. hp . ucmdb. discovery.probe.agents.probemgr. taskexecuter. JobExecuter. launchTask (J
obExecuter.java:1194)

at
com. hp.ucmdb.discovery.probe.agents.probemgr . taskexecuter. JobExecutersJobExecuterd
orker.launch (JobExecuter.java: 963}

at
com. hp.ucmdb.discovery. probe. agents . probemgr . taskexecuter. JobExecutersJobExecuteri
orker.executeTask (JobExecuter.java: 908)

at
com.hp.ucmdb .discovery.probe.agents.probemgr . taskexecuter. JobExecuterSJobExecuteri
orker.run(JobExecuter.java:813)

Solution

Search fortext is not supported by this adapter tofind the TQL name that has not yet been
configured, and then configure it in the smPopConfFile.xml file.

For instructions on how to add a mapping to a TQL, see "How to Map the Cl type's TQL Query to an
XSL Transformation File" on page 175.

Non-Existing XSLT File Name Defined for a TQL in
smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message like the following:
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java.lang.RuntimeException: Mo XSLT file is found
"business service population wrong.xslt", please configure the right XSLT file in
smPopConfFile. xml

comm. hp.ucmde . federationspl . exception. DataAccessCommunicationException:
java.lang.RuntimeException: Wo X5LT file is found

"business service population wrong.xslt", please configqure the right XSLT file in
smPopConf=-File. xml

at
coim.mercury.topaz. fomdb . adapters. servicebDeskhdapter.ServiceDeskAdapter. start (Servi
ceDeskAdapter.java:841)

at
com.mercury.topaz.cmdb.server. fecmdb.datalccess.manager. impl . AbstractDatafccessCont
ainerManagerImpl.starthdapter (AbstractDataAccessContainerManagerImpl.java:244) & &

Solution

Searchfortext No XSLT file is found to find the wrong XSLT file name, and then correct the
name in the smPopConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How to Map the Cl type's
TQL Query to an XSL Transformation File" on page 175.

No “Retrieve” Type Request Defined for a TQL in
smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message like the following:

java.lang.RuntimeException: NHo regquest was configured for cperation "Retrieve" of

TOL name "SM Business Ser=vice Population”, please check in smPopConfFile.xml file.
at
com.mercury.topaz.fcmdb. adapters. serviceDeskhdapter.population. PopChunkGetter. init (
PopChunkGetter.java:134)

at

com.mercury.topaz. fomde. adapters.servicebDeskAdapter.population. PopChunkGetter. <init
> (PopChunkGetter. java:104)

at

com.mercury.topaz. femdh. adapters. serviceDeskidapter.ServiceDeskidapter . getChanges (S
erviceDeskhAdapter.java:1108)

at

com.mercury.topaz.cmdb. server. femdb. datakccess. operation. query. impl . DatakccessAdapt
erQueryBetrieveChanges.getChangesResult (DatafccessAdapterQueryRetrieveChanges. java:
48)

Solution

Search fortext No request was configured for operation to find the TQL name for which a
retrieve type request is missing, and then add the missing request name in the smPopConfFile.xml
file.
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For instructions on how to configure a request for a TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 175.

Wrong Request Name of retrieveKeysQueryName
Configured for a TQL in smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message like the following:

2011-12-13 17:18:04,394 [JobExecuterWorker-0:DS 5M Integration bizservice
population] ERROR - S5M Integra-tion >> Populate ci data failed for element

com. hp.ucmdb. federationspi.exception.DatafAccessGeneralException: S0AP fault received
for retrieving SM CI Keys: A C¥mlApiException was raised in native code : error 16 :
scumlapi (16) - Invalid or missing file name in ¥ML request

at

com.mercury.topaz. fomdb, adapters. serviceDeskRdapter .population. SmPopulater . response
ExceptionHandle (SmPopulater.java:322)

at

com.mercury.topaz. femdb. adapters. serviceDeskAdapter.population. SmPopulater . queryiey
List (SmPopulater.java:11l6)

at
com.mercury.topaz.fecmdb. adapters.serviceDeskAdapter.population. PopChunkGetter.init (
PopChunkGetter.java:139)

at
com.mercury.topaz. focmdb. adapters.serviceDeskAdapter.population. PopChunkGetter.<init
> [PopChunkGetter. java: 104)

at
com.mercury.topaz.fecmdb. adapters. serviceDeskAdapter.ServiceDeskRdapter.getChanges (S
erviceDeskhdapter.java:1111)

& &

Further more, you can find more detailed error message in the log file that indicates which request of
retrieving Cl keys is wrong. The following is an example:
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2011-12-13 17:18:02,832 [JobExecutarWorker-0:DS SM Integration bizservice
population]) DEBUG - SM Integra-tion >> Web Service Request XMl For getting SM CI
keys:

<?xml wersion="1.0" encoding="UTF-16"%>

<ssapenv:Envelope xmlns:enc="http://schemas.xmlscap.ory/scap/encoding/"
¥mlns:env="http://schemas.xmlscap.org/soap/envelop/"
xmlns:scapenv="http://schemas. xmlscap.org/scap/envelope/"

xmlng:xsd="hettp: / /www.w3.org/2001 / XMLSchema™
xmlns:xsi="http: /fwww.w3.org/2001/MLEchema-instance™>

<scapenv:Body>
<axisZnsl :RetrieveucmdbBusinessServiceKeysListRequest wrong>
<axisinsi:model>
<axisZns3:keys query="type#siquot;bizserviceiquot;"/>
<axis?nsd:instance>
<axisZnsS:file.device/>
<faxisZnsd:instance>
<axisPnsb:messacges/>
</axisZnsZ:model>
<faxisZnsl:RetrieveucmdbBusinessServicekeysListRequest wrong>
</ soapeny : Bodys

</scapenv:Envelope>

Solution

Search for text Web Service Request XM1 For getting SM CI keys to find the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request fora TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 175.

Wrong Request Name of retrieveListQueryName
Configured for a TQL in smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message like the following:
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com. hp . ucmdb . faderationspi . exception.DataAccessGeneralException: SORAP fault received
for retrieving SM CI List: A CXmlApiException was raised in native code : error 16 :
gcxmlapi (16) = Invalid or missing file name in XML request

at
com.mercury.topaz.fomdb.adapters.serviceDeskAdapter.population.SmPopulater.response
ExceptionHandle (SmPopulater. java:324)

at
com.marcury.topaz. fomdb. adapters. serviceDeskAdapter.population. SmFopulater.queryRec
ordList (SmPopulater.java:l188)

at
com.mercury.topaz. femdb. adapters. servicelDeskAdapter.population. PopChunkGetter . addOr
DelCIsToTopology (PopChunkGetter. java:177)

at
com.mercury.topaz. fomdb . adapters. serviceDeskAdapter.population. PopChunkGetter. getNe
#HtRezultChunk (PopChunkGetter.java:164)

at
com.mercury.topaz. fomdb. adapters. serviceDeskAdapter. ServiceDeskhdapter.getChanges (S
erviceDeskhdapter.java: 1143)

& &

Further more, you can find more detailed error message in the log file that indicates which request of
retrieving Cl list is wrong. The following is an example.

2011-12-13 17:30:23,424 [JobExecuterWorker-0:DS sM Integration bizservice
population] DEBUG - SM Integra-tion >> Web Service Request XMl For getting SM CI
List:

<?um]l version="1.0" encoding="UTF-16"72>

<spapenv:Envelope xmlns:enc="http://schemas.mlsoap.orqg/socap/encoding/"
xmlns:env="http://schemas.xmlscap.org/scap/envelop/"
xmlns: soapenv="http://schemas.xmlscap.org/scap/envelope/"

x¥mlns: xsd="http: // www.w3.org/ 2001/ MLSchema”
xmlng:xsi="http://wew.w3.org/2001/XMLSchema-instance™>

<soapenv:Body>
<axisZnsl3:RetrieveucmdbBusinessServicelListRequest wrongs
<axlisinzsld: keys>
<axisZnsl5:CITdentifier>test bhiz serveie 1</axis?nsl5:CITdentifier>
<faxisZnsld:keys>
<axlsinsle: keys>
<axisZnsl7:CiTdentifier>test biz serveie 2</axis?nsl7:CIldentifier>
<faxisZnsl6:keys>
</axis2nsll;:RetrieveucmdbBusinessServicelistRequest wrong>
</ acapeny:Body>
</scapenv:Envelope>

Solution
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Search fortext Web Service Request XM1 For getting SM CI List tofind the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request for a TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 175.

XSLT File not Well Formed

Sample configuration

The end tag of “ci” should be </ci>, however you configured a wrong end tag </ci_wrong>.

Resource dizcovery ConfigFiles/Service Manager Adapter9-x/business_service_population.xsh
QEBODE| 2
1 <xzl:stylesheet wverzion="1.0" xmlns:xsl="http:// www.w3.org/l1999/X5L/Transform™>
2 <xsl:template match="/RetrieveucmdbBusinessServicelistResponse™>
3 <topology>
4 <xzgl:for-each select="instance">
5 <ci class="business s-=rviu:-=">
a <xsl:for-each select="file.device™s
7 <!--import:cmdb root atbribultes population.xsli-->
g <attribute 15T=—"pr“"1:i=r" "1:-=—"Str:|.|:1g >
] <xsl:value-of zelect="ServiceProvider"/>
10 </attribute>
11 <fxsl: for-each>
2 < foi wreoaners
13 </xsl: for-each>
14 </topology>
15 <fxsl:template>
la</xzl:3tylesheet>
17
4

Error message

If you have not yet created your integration point, when you create it an error message similar to the
following example will occur in the Universal CMDB studio or the log file, causing the creation to
fail.

If you have already created your integration point, but not yet activated it, you can no longer activate
it, because when you attempt to activate it you will get a detailed error message in the probe error
log file (probe-error. log), similar to the following example.

If you have created and activated your integration point, you will get a “Failed” status when you run
the population job. In addition, from both the population log file (see "How to Check the Population
Log File" on page 229) and the Universal CMDB studio (see "How to Check the Error Message of a
Failed Population Job" on page 228), you will get an error message similar to the following example.
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java.lang.RuntimeException: Got SAXException while parsing the XSLT file
"business service population.xslt"!

com. hp.ucmdb . federationspi.exception.DataRccessCommunicationException:
java.lang.RuntimeException: Got SAXException while parsing the XSLT file
"business_service_yepulation‘xslt“!

at
com.mercury.topaz.fomdb. adapters. serviceDeskAdapter. ServiceDeskhdapter. start (Servic
eDeskidapter.java:B41)

at

com.mercury. topaz.cmdb. server. fomdb . datafccess . manager. impl . AbstractDatadccessConta
inerManagerImpl.startAdapter (AbstractDataAccessContainerManagerImpl.java:244)

at

com.mercury.topaz.cmdb.server. femdb .datakccess.manager . impl . AbstractDataAccessConta
inerManagerImpl.addStartAndReturnBasicDatafdapterWrapper (AbstractDataRccessContaine
rManagerImpl.java:le2)

& &

Caused by: org.xml.sax.SAXParseException: The end-tag for element type "ci" must end
with a ">' delimiter.

at org.apache.xerces.parsers.DOMParser.parse (Unknown Source)

at org.apache.xerces.jaxp.DocumentBuilderImpl.parse (Unknown Source)& &

Solution

Search for text Got SAXException while parsing the XSLT file to find the name of the
problematic XSLT file, and then validate the file in an XML editor (for example, XMLSpy). You can
easily find and fix any validation issues.

1 -1 =xslstylesheet version="1.0" xmins xsl="http ./ Awww w3.org 1 9595,X5 L."'Tlan
2 = zusltemplate match="/RetieveucmdbBusiness Service List Response " =

3 = opology

4 = wzlforeach select="instance" >

5 = ! «ri class="business_service">

6 i i «xslforeach select="file device" >

7 | ¢l-mport:cmdb_root_attributes_population xsht—>

] <attribute name="provider” type="5tring" > <xslvalue-of select="5erviceProvider" /=<
9 = i i sl foreach:

10 - Pz

11 = «/usl foreach =

12 = <topology =

13 ~  </Asltemplate:

14 = < fusl=hleshest =

This file is not wellformed:
Q ci closing element name expected. [&¥ Recheck |

Wrong UCMDB Attribute Name in XSLT File

Sample configuration
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The UCMDB attribute name is provider, however you configured a wrong attribute provider
wrong. This error also commonly occurs since the attribute name is case-sensitive.

Rezource dizcovery ConfigFilesiService Manager Adapterf-x/buziness_service_population. xsh

Q@D &

1<xzl:stylesheet verzicn="1.0" xmlns:xsl="http://www.w3.org/1993/X5L/Transform">
2 <xzl:template match="/RetrieveucmdbBusinessServicelistResponse™=
3 <topology>
4 <xz]l:for-each sslect="instance">
3 <cl class="business_service"»
a <xz]l:for-each select="file.device">
7 <l--import:cmdbh root attributes population.xsli--»
g <attribute name="provider wrong™ type="String”>
9 <xzl:value-of select="3srviceProvider"/>
10 <fattribute>
11 </x=l: for-each>
12 <fcix
13 </x=]l: for-each>
14 </topology>
13 </xzl:tenplate>
la=/xzl:3tylesheet>
17
4 3

Error message

You will NOT get any error messages either in the log file or the Universal CMDB studio, however
the Service Manager field value will not be populated to Universal CMDB.

Solution

If you find that a Service Manager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 171.

Wrong Service Manager Field Name in XSLT File

Sample configuration

The Service Manager field name is ServiceProvider, however you configured a wrong attribute
ServiceProvider_wrong:
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Rezource dizcovery ConfigFiles/Service Manager Adapter9-x/husiness_service_population. xsh
QRBDE| &
1<xzl:stylesheet verzicn="1.0" xmlns:xsl="http://www.w3.org/1993/X5L/Transform">
2 <xzl:template match="/FEetrieveucmdbBusinessServicelistResponse™>
3 <topology>
4 <xsz]l:for-each sslect="instance">
3 <cl clasz="business_service">
a <xz]l:for-each select="file.device">
7 <l--import:cmdb root attributes population.xslt--»
g <attribute name="provider" type="3tring">
9 <xzl:value-of select="ServiceProvider wrong"/>
10 <fattribute>
11 </x=1l: for-each>
12 <fcix
13 </x=l: for-each>
14 </topology>
15 </xzl:tenplate>
15 </x=l:styleshest> |
17
4 3

Error message

You will NOT get any error messages either in the log file or the Universal CMDB studio, however
the Service Manager field value will not be populated to Universal CMDB.

Solution

If you find that a Service Manager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 171.

Wrong Universal CMDB Attribute Data Type in XSLT File

Sample configuration

The data type of Universal CMCB attribute “provider” is String, however you configured a wrong
type Integer:
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Reszource dizcovery ConfigFiles!Service Manager AdapterS-xibusiness_service_population. xsh
Q®CE| &
2 <x=z]l:template mztch="/RetrieveucmdbBusinessServicelistEesponse™>
3 <topology>
4 <x=zl:for-each select="instance">
3 <ci clazz="business_ service"»
[ <x=l:For-each select="file.device™s
7 <!l--1mport:cmdb roob abtbtributes popunlabion.xsli--»>
g <attribute JiTn_"er"ldnr" "1=—"T“*“"“"">
] <x=zl:value-of select="3erviceFrovider"/>
10 </attribute> =
11 </x3l: for-eachs> I
12 <fcix
13 </xz]l:for-each>
14 </topology>
15 </xzl:templatex
la</xsl:3tylesheet>
17 |
4

Error message

The Cls will be populated to Universal CMDB, but the field value with a wrong data type
configuration will not be populated to Universal CMDB.

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message similar to the following:

General datastore error: SM Integration >> The walue "VENDOR1" of field "provider"
is not a integer number, ig-nore this field walue!

java.lang.NumberFormatException: For input string: "VENDORL"
at java.lang.MumberFormatExcepticon. forInputString (NumberFormatException.java:48)

at java.lang.Integer.parselnt (Integer.java:449)

Solution

Search fortext The value "xxx" of field "yyy" is not to find the name of the attribute with a
wrong data type, and then specify the right data type in the XSLT file.

For instructions on how to configure an attribute data type, see "How to Map the CI Attribute to the
Web Service Field" on page 171.

UCMDB CI Attribute sm_id not Mapped to the Right
Service Manager Field in XSLT

The Service Manager CI ID must be mapped to Universal CMDB CI attribute sm_id, sinceitis
used to push the Universal CMDB CI ID back to Service Manager.
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Out-of-the-box, this attribute mapping is configured in XSLT file cmdb_root_attributes_
population.xslt, whichis imported by the other XSLT files as a common field mapping, and the
Service Manager CI ID field is exposed as the caption CIName.

Sample configuration

If you configured the mapping for sm_id in one of the following ways:

¢ You did not configure the mapping for sm_id;
e You did not expose the Service Manager CI ID field in the Service Manager web service;
¢ You exposed the Service Manager CI ID field with a caption other than CIName;

e The Service Manager CI ID field was exposed in the web service as the caption CIName, but you
configured a wrong name (for example, CIName_wrong) in the XSLT file (see the following
figure).

<attribute name="name" type="String"><xsl:value-of
select="CIIdentifier"/></attribute>

<attribute name="sm id" type="String"><xsl:value-of
select="CIName wrong"™/></attribute>

<attribute name="glcbal id" type="String"><xsl:value-of
select="UCMDBI4" /></attribute>

Error message

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 229) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 228), you will get an
error message similar to the following:

java.lang.RuntimeException: The Universal CMDE attribute "sm id" of CI type
"business service" is mapped to an empty value, please check this mapping in XSLT

£1 1

ac
com.mercury.topaz. fcemdb, adapters. serviceDeskRdapter . population. PopChunkGetter. addOr
DelCIToTopology (PopChunkGetter . javas: 198)

at
com.mercury.topaz. femdb, adapters. serviceDeskRdapter.population. PopChunkGetter.addOr
DelCIsToTopology (PopChunkGetter. java: 184)

at

Com.mercury.topaz. femdb. adapters. serviceleskAdapter.population. PopChunkGetter . gete
xtResultChunk (PopChunkGetter. java:164)

at
com.mercury.topaz. fcmdb. adapters. serviceDeskAdapter.ServiceDeskRdapter.getChanges (S
erviceDeskhdapter.java: 1149)

at

L5 &

Solution

HP Service Manager (Service Manager 9.33; Universal CMDB 10.01 or later) Page 245 of 248



Search for text The Universal CMDB attribute "sm _id" of CI type tofind the Cl type, and
then configure the attribute mapping for this Cl Type in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 171.
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We appreciate your feedback!

If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Universal CMDB Integration Guide (Service Manager Service Manager 9.33;
Universal CMDB 10.01 or later)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to ovdoc-itsm@hp.com.
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